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1 Company Set-up
1.1 Overview

In order to utilize the Polish functionality, the company must be set up as using the Poland
localization. This is defined in the page Company.

1.2 Define localization

o Open the page, Company.

e Search for the company.

o Select “Poland” in the drop-down list in the Localization field and save. Note that this cannot
be changed once transactions are created for the company.

Search asvencea

Company: AMKA-PLN * @  CreationDate ¥ CreatedBy ¥ Name ¥ More ¥ © Favorites  Clear Q i

Settings
sothy -

Company AMKA-PLN - AMKAPLN ¥ 1of1
AMKA-PLN

« P 7 B~ Update Company Update Company Translation New Company [v]
Name: AMKA-PLN
Address
Communication Method company Name aciation No Created By
Messase sewn AMKA-PLN AMKA-PLN v AMKALK
Emplayees X X X

General Information Miscellaneous Information
Accounting Rules

Default Language Country Dotument Logatype Document Recipient Address Positioning
Tax Contral ~

English ~ POLAND - Right -
Ivoice

Localization Form of Business rint Dacument Senders Address Autherization 1D
Payment

Poland -
Fixed Assets

Classification of Business Authorization ID Expiration Date dentifier Reference
Periodical Cost Allocation therization ID Expiration D dentifier Referenc
Supply Cnain Information &
Localization Control Center pate b feference validarion

= -

Show less 8 None

urce Template ID

STD-PL 0
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1.3 Select Localization functionality.

Specify which functionality to use.

¢ Open Localization Control Center sub menu under Company.

e The localization selected in previous step is displayed in the Localization Control Center field
and cannot be changed.

¢ All functionality available for Poland is presented in the list. Enable/Disable the functionality

based on the requirements for the company by enabling the radio buttons. Note that some
functionality is mandatory and cannot be disabled.

Localization Control Center waeerouano-poiish company = 30r6

> # 0

Access Control for Inventory Rese

Access Control for Inventory Tran

Cash Account Currency Rate Mett

Currency Rate Date and Voucher

Discounted Price Rounded

Polish E-dnvoice

Polish Spiit Payment

Repasting of Currency Difference

Round Tax Amount for Suppler Ir

Specific Data for Customer Invoic)

Standard Audit File-Tax for Polant

Tax Reliability Control on Supplier

Descriptian

Enables amore specific access control for making inventory reservation, instead of using the user-allowed:sites control as in core.

Enables a more specific user Acess Control Tor performing inventory ransactions instead of using the user-allowed-sites control as in core.

Enables to use FIFD or AVG method in mixed payment and cash box

Enables to use delivery date as voucher date and tax currency rate date in customer order invaice, instant invoice and project invoice. Ennancement of OULEOINg invoice currency rate date

Enables the rounding of the sales price after applying the discounts on the custamer order ines and customer order invoice ines

Enables the generation of the e-inwoice XML file, including Polish legally required data, used for sending invoices 1o tax authorities.

Enables handing of transactions when using p: transactions are created accordi

to Polish specific regulations.

Enables to handie currency difference related to tax separately from currency difference related to net amount by introduction of additional postings. The additional postings make it possi

Enables rounding of tax

for supplier inv g currancy when tax code is of type Calculated Taxx. I Poland this is used in order ta register customs docur
Enables to include specific additional data in Polish customer invoices, including tax amaunt and gross amount on the invoice lines, 0% tax rate printed in characters and Company Tax D.

Enables to generate reports in XML format for VAT declaration and records of VAT on sales/purchase, customer invaices, inventary, mixed payments and accounting Books.

Enables the control of the supplier's tax reliability status when entering purchase arders, manual suppher invoices and payment proposals.

Enatied

o
o
o
o
o
(-]
o
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2 Cash Account Currency Rate Method
2.1 Overview Legal Requirement

This requirement covers the different currency rate methods for bank and cash account movements
in Poland. In Poland, at the outgoing payment moment it is not needed to account for the differences
between the invoice currency rate and payment currency rate.

The rate for the outgoing transaction is calculated based on the incoming transactions.

The different methods for calculating currency rates are weighted average (AVG) and FIFO.

2.2 Process Overview

Create Currency rate Create
Incoming updated in the Outgoing
Transactions cash account Transactions

Define basic
data

View Postings

Postings are created for the currency difference when the outgoing payment is approved.

2.3 Solution Overview
Cash Account

Two-step
Currency Rate Currency
Short Name Calculation Method Handling of Negative Balance Profiv/Loss
AVG-GBP Weighted Average Currency Profit/Loss after each Inflow m
AVG-USD Weighted Average Currency Profit/Loss after each Inflow Yes

The column Currency Rate Calculation Method in the Cash Accounts page defines the method of
currency rate calculation for outflow. It can have following values:

e Weighted average
e First in, First Out

Country Solution POLAND 4
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The column Handling of Negative Balance on the Cash Accounts page defines how the calculation
is carried out in case the cash account has a negative balance. It can have the following values:

Il‘ ! u\\\

e Currency Profit/Loss after each inflow
e Aggregate Currency Profit/Loss

The Two-steps Currency Profit/Loss check box in the Cash Account page is enabled for editing. It
controls how currency differences are posted. The details are explained below.

If Two-steps Currency Profit/Loss check box is checked —

e Currency rate which is in the cash account queue will not be fetched to postings, instead the
currency rate which is given when approving the outgoing payment is fetched to the postings.

If Two-steps Currency Profit/Loss check box is Unchecked —

e Currency rate which is in the cash account queue is fetched to the postings when the outgoing
payment is approved.

New currency rate calculation methods are introduced when approving,

e Mixed Payments
e Cash Box Payments

2.4 Prerequisites

1. The company must be set-up to use Poland localization, see the Company Set-up chapter
and the “Cash Account Currency Rate Method” parameter must be enabled.

2. Cash accounts should be created.
- In the Cash Accounts page, you can define the calculation method of currency rate for
cash account in foreign currency.
- These columns are editable only when Cash Account is not in accounting currency.

3. Cash Accounts should be linked to posting control PP1.

4. Posting controls PP80 (currency Gain) and PP79 (Currency loss) should be created. (This is
only needed when Two-steps Currency Profit/Loss check box is checked.

5. Customers and Suppliers should be created.

2.5 Weighted Average Method

In the AVG method the average currency rate is calculated for the cash account using incoming
transactions. The current balance of the cash account in transaction currency and accounting
currency is calculated after each incoming transaction. It is used when calculating currency rate for
outgoing transactions.

Balance in accounting currency divided by balance in transactions currency calculates currency rate
for outgoing transaction. The currency rate of an outflow is updated with the historical average
currency rate in the mixed payment line after the mixed payment is approved.

Country Solution POLAND 5



EXAMPLE:

Currency Rate Calculation Method -
Handling of Negative balances -

Two step

Weighted Average
Currency Profit/loss
Checked

D,
I

IFS

Inflow Amount In Infl Amountin Average
. nflow .
Transaction Accounting Currency
Currency Rate
Currency Currency Rate
150 4.3 645
100 4.2 420
200 4 800
450 1865 4.14
1. Create 3 manual customer invoices as below,
Manual Customer Invoices
= Y | B v New Manual Customer Invoice = v
Invoice Gross
v g (4 Customer Series ID Invoice No Invoice Type Date Currency Amount Net Amount Tax Amount
2 ° PL_CUS-PL_CUS FS Al FS 5/12/2021 usb 150.00 150.00 0.00
2 ° PL_CUS-PL_CUS FS A2 FS 5/12/2021 usD 200.00 200.00 0.00
2 ° PL_CUS-PL_CUS FS A3 FS 5/12/2021 usb 100.00 100.00 0.00

2. Create a mixed payment, connect the previously created invoices with respective currency rates

and approve.

Debit

450.00

Credit

0.00

Credit Amountin Acc Curr

0.00

Transaction Details

Y | B v R v View Transactions
(l) Amount Currency Rate Inv/Prepaym No
U : 200.00 4 AR
100.00 42 A3
150.00 43 Al

Debit Amount in Acc Curr

1865.00

Notes Cancel Matching

Lump Sum
Trans Number

Payment Transaction Type
3  Enter Customer Paymen
2 Enter Customer Paymen

1 Enter Customer Paymen

Cash Account User Group Bank Transactig

* *

Country Solution POLAND 6
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3. Cash account should be updated.

Cash Account Queue - PL WA

= | Y | R~

Currency ~ Amountin Acc
Vol Amount Curr  Currency Rate

450.00 1865.00 4.1444

4. Create a manual supplier invoice for 200.

H H Posted
Manual Supplier Invoice rz-an v o —
& 2 /7 R v New Manual Supplier Invoice More Information Pre Posting : Q
PO Reference Receipt Reference Sub Contract Reference Invoice Advice Reference Project ID
= -
Supplier Invoice Type Series ID Invoice No
° PL_SUP - PL_SUP Fz Fz Al
Currency Currency Rate Invoice Date Arrival Date Pay Term Base Date
usb 5 5/12/2021 5/12/2021 5/12/2021
Payment Terms Due Date Plan Pay Date Payment Reference Voucher Type Reference
0 - Due Immediately v 5/12/2021 5/12/2021 I
Voucher No Reference Authorizer ID Notes Advance Invoice Period Allocation Pre-posting
2021000001 . - 0 [ o] [ o] [ ol
Received Attachments On Hold Installment Posung Proposa\ Gross Amount Net Amount Tax Amount
[ o [ no) [ no} 200.00 200.00 0.00
Line Information
Gross Amount Net Amount Tax Amount Non-deductible Tax Am Cost Amount
200.00 200.00 0.00 0.00 200.00

5. Create a mixed payment with the currency rate 5 and connect the previously created invoice and
approve.

Country Solution POLAND 7
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Transaction Balances

Cash Account Statement No Remaining Amount
AJTEST1 3 200.00

Debit Credit Debit Amount in Acc Curr
0.00 200.00 0.00

Credit Amountin Acc Curr

1000.00

Transaction Details

Y BV /7 of R v Edit Transactions Open Supplier Bills Open Issued Checks : H v
Lump Sum
(l) : Amount Currency Rate  Inv/Prepaym No Trans Number ~ Payment Transaction Type ~ Cash Account User Group Bank Transacti
: -200.00 5 Al 1 Enter Supplier Payment  * *

6. View the postings for the mixed payment,

Mixed Payment Vouchers rin.com-2021000003-5122021 1081
4 M v
Company Voucher Type Voucher No Voucher Date
PLN-COM N 2021000003 5/12/2021
Accounting Year Accounting Period
2021 5
Voucher Rows
Y B v B~ ;g
Debit Amount  Credit Amount Amountin DebitAmount  Credit Amount Amountin - Debit Al
in Transaction in Transaction Transaction in Accou ﬂflﬁg in Accounti ng AECOUHUHg in P,
{l) Account Curren(y Curren(y Curren[y (urren[y (LJUEH[y CUUEH[y Cul
13010 - Current banking account 200.00 -200.00 1000.00 -1000.00
21015 - Short-term domest.pa ﬁjl.t 200.00 200.00 1000.00 1000.00 2
13010 - Current banking account 0.00 0.00 171.12 171.12 2
3] | 3960 - Exch gain on receivables and ... ‘ 0.00 0.00 17112 = lTakibs 2
75030 - Positive currency differences 0.00 0.00 0.00 0.00
Calculation for the exchange gain is calculated as below,
Amount in Transaction Currency Amount in Accounting Currency
*
200 4.14 828.8
*
200 5 1000

Note - This is a positive currency difference (Currency Gain), posted with PP80. If in case there is a
currency loss, then postings are posted with PP79 (Currency Loss)

In this scenario Two-steps Currency Profit/Loss check box is checked —

e Currency rate which is in the cash account queue will not be fetched to postings, instead the
currency rate which is given when approving the outgoing payment is fetched to the postings.

Country Solution POLAND 8



Cancelling mixed payment

- For AVG method, cancelling the mixed payment is allowed.

S\
SVIFS

- The warning message “There is an existing approved mixed payment with later payment
date. The wrong order of approval creates wrong average currency rate. Do you want to
proceed” will be presented to the user when there is any approved mixed payment which has
later payment date.

2.6 Weighted Average Method — Handling of Negative Balance using Currency
Profit/Loss after each inflow

Currency Profit/Loss after each inflow is one of the calculation methods of Handling of Negative
Balance in the Cash Accounts page, it defines how the calculation is carried out in case the cash

account has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - when there is a negative amount in the cash account — Creating an

outflow

1. Make the balance of cash account negative.

5 &

Currency
v 2 Amount

-290.00

Amountin Acc
Curr

-1450.00

Cash Account Queue-PL WA-P

Currency Rate

5

2. Create a Manual supplier invoice for an amount of 200, create a mixed payment and connect the

created manual supplier invoice with the currency rate 3 and approve.

Country Solution POLAND 9
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Mixed Payment PL_WA-525-5/17/2021 ¥

< @ | 4 B v Cancel

GENERAL TRANSACTIONS

Transaction Balances

Print Mixed Payment

Cash Account ‘Statement No
PL_WA 525

Debit Credit
0.00 200.00

Credit Amountin Acc Curr

600.00

Transaction Details

Y | B2 v
v 3 Amount Currency Rate  Inw/Prepaym No
-200.00 3|59

30f3
View Vouchers Notes
Remaining Amount
0.00
Lump Sum

Trans Mumber Payment Transaction Type

1 | Enter Supplier Payment

Check Collection Level i Q

Debit Amount in Acc Curr

Cash Account User Group Bank Transactio

Approved

3. Cash account will get updated as below,

= Y B v

=

Currency Amountin Acc

Cash Account Queue - PL WA

v Amount Curr Currency Rate

: -490.00 -2050.00 4.18

Calculation is done as below,

Currency Amount| Amout in Accounting Currency [ Currency Rate

-290 -1450 5
-200 -600 3
-490 -2050 4.18

Postings are as below,

Country Solution POLAND 10
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Voucher Date

5/17/2021

Conversion

Currency Rate

3

Mixed Payment Vouchers rin.com-2021000013 - 511772021 +
R~
Company Voucher Type Voucher No
PLN-COM N 2021000013
Accounting Year Accounting Period
2021 5
Voucher Rows
Y B v
Transaction
v 3 Code Account Currency
PP1 13010 - Current banking account ush
IP1 21015 - Short-term domest.payabl.c... | USD

3

Factor

1

1

Debit Amount
in Transaction
Currency

200.00

Credit Amount
in Transaction
Currency

200.00

Note — Even though cash account shows a currency rate of 4.18 this will not be fetched to postings
as the cash account balance is negative. Here currency rates are posted based on the currency rate

entered in the mixed payment.

How the functionality works - When there is a negative amount in the cash account — Creating an

inflow

1. Cash account is already negative.

Cash Account Queue - PL WA

= | W (B v

Currency  Amountin Acc
v S Amount Curr  Currency Rate
-490.00 -2050.00 4.18

2. Create a manual customer invoice for an amount of 100, Create a mixed payment and connect
the same invoice with the currency rate 3.5 and approve.

Country Solution POLAND 11
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Transaction Balances

Cash Account Statement No Remaining Amount
PL_WA 526 0.00

Debit Credit Debit Amount in Acc Curr
100.00 0.00 350.00

Credit Amount in Acc Curr

0.00

Transaction Details

¥ | B B v
Lump Sum
v Amount Currency Rate Inv/Prepaym No Trans Number Payment Transaction Type Cash Account User Group Bank Transactio
100.00 3.5 9874 1 Enter Customer Paymen *

3. View the cash account.

Cash Account Queue - PL WA

B v

Currency Amountin Acc
7 $ Amount Curr Currency Rate

-390.00 -1632.00 4.18

Note — Cash account currency rate will not get updated, instead it will remain the same currency
rate. This is because the cash account has a negative balance. when this balance is changed to
positive, currency rates will be used proportionally.

2.7 Weighted Average Method - Handling of Negative Balance using
Aggregate Currency Profit/Loss

Aggregate Currency Profit/Loss is one of the calculation methods of Handling of Negative Balance
in the Cash Accounts page, it defines how the calculation is carried out in case the cash account
has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - When there is a negative amount in the cash account — Making an
outflow.

1. Make the balance of cash account negative.

Country Solution POLAND 12



Currency
4 & Amount

-1000.00

Cash Account Queue - PL_A(

Amountin Acc
Curr

-5000.00

Currency Rate

5

D,
7N
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2. Create a Manual supplier invoice for an amount of 3000, create a mixed payment and connect
the created manual supplier invoice with the currency rate 3 and approve.

Transaction Balances

Cash Account

PL_AGGREGRATE 3

Debit

0.00

Credit Amount in Acc Curr

9000.00

Transaction Details

M : Amount

: -3000.00

Statement No

Currency Rate

Credit

3000.00

Inv/Prepaym No

3 6220213

Edit Transactions

Remammg Amount

3000.00

Debit Amount in Acc Curr

0.00

Open Supplier Bills Open Issued Checks B/ v
Lump Sum
Trans Number  Payment Transaction Type Cash Account User Group Bank Tran
1  Enter Supplier Payment ¥ B

3. Cash account will get updated as below.

= Y B v

Currency
v 2 Amount

-4000.00

Amountin Acc
Curr

-14000.00

Cash Account Queue-PL A

Currency Rate

3:5

Calculation for currency rate is as below.

. |Amount
Inflow amountin |, Inflow curr
in Acc
Trans curr rate
curr

-1000 -5000 5
-3000 -9000 3
-4000 -14000 3.5

Country Solution POLAND 13




4. View vouchers.
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| B~
Company Voucher Type Voucher No
PLN-COM N 2021000042
Accounting Year Accounting Period
2021 6

WVoucher Rows

VY &~

Tran... Curre..
v Code Account Cu rrency Rate
PP12 75140 - Negative currency differe... | USD 3
PP13 75030 - Positive currency differen... | USD %
IP1 21015 - Short-term domest.payab... | USD 3
IP1 21015 - Short-term domest.payab... | USD 3
PP1 13010 - Current banking account usD 3

Mixed Payment Vouchers rin-com-2021000042 - 67212021 ¥

Conversion
Factor

1

1

1

1

1

10f1

Voucher Date

6/2/2021

Debit Amount
in Transaction
Currency

0.00

3000.00

=2
Credit Amount Amountin
in Transaction Transaction
Currency Currency
0.00
0.00 0.00
3000.00
0.00 0.00
3000.00 -3000.00

Note — Even though cash account shows a currency rate of 3.5 this will not be fetched to postings
as the cash account balance is negative. Here currency rates are posted based on the currency rate

entered in the mixed payment.

How the functionality works - When there is a negative amount in the cash account — Making an

inflow.

1. Make the balance of cash account negative.

Cash Account Queue - PL_A(

1
[@
<

Currency Amountin Acc
7 : Amount Curr Currency Rate

-4000.00 -14000.00 3.5

2. Create a Manual customer invoice for an amount of 1500, create a mixed payment and connect
the created manual supplier invoice with the currency rate 3 and approve.

Country Solution POLAND 14



\\\!r
75

IFS

Transaction Balances
Cash Account Statement No
PL_AGGREGRATE 4

Debit

1500.00

Credit
0.00
Credit Amount in Acc Curr

0.00

Transaction Details

Y e v B v View Transactions Notes Cancel Matching B v
Lump Sum
(1,) ) Amount Currency Rate  Inv/Prepaym No Trans Number  Payment Transaction Type Cash Account User Group Bank Tran
: 1500.00 3 6220213 1 Enter Customer Payment * *

Remaining Amount

0.00

Debit Amount in Acc Curr

4500.00

3. View cash account.

Cash Account Queue - PL_Al

= Y B v
Currency  Amountin Acc
v g Amount Curr  Currency Rate
-2500.00 -9500.00 3.8

Calculation is as below.

. |Amount
Inflow amountin |, Inflow curr
in Acc
Trans curr rate
curr

-4000 -14000 3.5
1500 4500 3
-2500 -9500 3.8

4. View vouchers.

Country Solution POLAND 15
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Mixed Payment Vouchers rin.com-2021000042-6/22021 ¥ 10f1

« &~
Company Voucher Type Voucher No Voucher Date
PLN-COM N 2021000042 6/2/2021
Accounting Year Accounting Period
2021 6

Voucher Rows

S =
Debit Amount  Credit Amount Amountin
Tran... Curre... Conversion in Transaction in Transaction Transaction
,/ i Code Account Currency Rate Factor Currency Currency Currency
PP12 75140 - Negative currency differe... | USD 3 1 0.00 0.00
PP13 | 75030 - Positive currency differen... | USD 3 1 0.00 0.00
1P1 21015 - Short-term domest.payab... | USD 3 1 3000.00 3000.00
1P1 21015 - Short-term domest.payab... | USD 3 1 0.00 0.00
PP1 13010 - Current banking account usD 3 1 3000.00 -3000.00

2.8 FIFO Method

A FIFO queue is used to keep track of incoming transactions. When cash account balance is greater
than zero, then each incoming transaction is added to the FIFO queue. For outgoing transactions,
the rows in the FIFO queue are consumed to compensate the outflow amounts.

EXAMPLE:
Currency Rate Calculation Method — FIFO
Handling of Negative balances - Currency Profit/loss
Two step - Unchecked
Inflow amount in | Inflow curr A.mount
in acc
trans curr rate
curr
100 4.3 430
150 4 600
200 4.2 840
450 1870

1. Create 3 manual customer invoices as below using 3 different voucher dates, (Example — 18th,
20th, 24th)

Country Solution POLAND 16
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Manual Customer Invoices

© New Manual Customer Invoice

v

(]

Customer ¥ Series ID ¥ Invoice No : AJIPLN;AJ2PLN v @ More v O Favorites Clear Q Settings
Invoice Gross
@ Date ustomer Series ID Invoice No Status Invoice Type Date Cu rrency Amount Net Amount
& 512412021 PL_CUS-PL_CUS FS AJ1PLN Posmimﬂl FS 5/24/2021  USD 100.00 100.00
& 512012021 PL_CUS-PL_CUS FS AJ2PLN PostedAuth FS 5/24/2021  USD 150.00 150.00
2 5/18/2021 PL_CUS-PL_CUS FS AJAPLN ‘PostedAuth FS 5/24/2021  USD 200.00 200.00

3.

. Create a mixed payment for each transaction separately, connect

the created invoice with
respective voucher date and currency rate and approve.

Note - Order of voucher dates are important when approving mixed payments. According to the
functionality which ever transaction is approved in the mixed payment will be fetched to the cash
account as the “first in” irrespective of the payment date.

Therefore, according to above example approve mixed payment according to the order 18th, 20th
and 24",

View cash account.

Note — Unlike in Weighted average method where an average currency rate was calculated, FIFO
method will keep transactions separately with the respective currency rates in the cash account.

Cash Account Queue - AJFIFO - AJFIFO

Currency

Amount

AMmount in Acc Oongina Paymemt

Curr Amount Currency Rate  Date

200.00 840.00 200.00 840.00 52072021

&
[

NotCleared

150.00 600.00 150.00 600.00  NotCleared 4 5182021

572472021

NotCleared

If a payment was made through mixed payment, the currency rate should be picked according to the
FIFO method. The first transactions entered should be picked first as the outflow.

4

. Create a manual supplier invoice for an amount of 280. Create a mixed payment and connect the

created manual supplier invoice with the currency rate 4.3 and approve.

Country Solution POLAND 17
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Transaction Balances

PL_FIF

Transaction Details

Currency Rate

View Transactions Notos

Ime'Prepaym No

Lumg Sum

Trans Number

AFOA]! 1

Cancel Matching

Payment Transaction Type Cash Accouns User Group

Enter Supplier Payment  *

Bank

Transaco

5. View the postings of the mixed payment.

)

Voucher Type

inting Perio:

Mixed Payment Vouchers rincom-2021000036- 5242021 ¥

Tran Curre Canversan
fe Acct Currency Rate Factor c
PP13 usp 413
PP13 usD 4.13
9] 115 - Shart-term da... | USD 4.13
PP1 13010 - Current bankin... | USD 413
Pt 115 - Shart-term dao... | USD 413

Jetat Amournt

in Tramsathon

10f1

a

=

Credit Amount Amaunt in Detit Amcuant

in Transaction Transaction in Accounting

urrency Curremy Currency Currency
0.00 0.00
0.00 0.00

n.0n 0.00 24360
280.00 -280.00

280.00 280.00 1156.40

Currency rate is calculated as below,

Currency Amount

Currency Rate

Amount in Accounting Currency

100

4.3

430

150

4

600

30

4.2

126

280

4.13

Cancelling mixed payment

- When FIFO method is used, only last mixed payment can be cancelled.

IFS
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- When trying to cancel other mixed payments the user will be presented with an error message
which says, “Only last mixed payment can be cancelled when First In First Out method is
used for foreign currency cash account!”

2.9 FIFO Method — Handling of Negative Balance using Currency Profit/Loss

after each inflow

Currency Profit/Loss after each inflow is one of the calculation methods of Handling of Negative
Balance in the Cash Accounts page, it defines how the calculation is carried out in case the cash

account has a negative balance.

This is when the cash account has a negative balance instead of a positive balance.

How the functionality works - When there is a negative amount in the cash account — Making an

outflow.

1. Cash account is already negative.

Cash Account Queue - FIFO_PL - 123456
= Y [ v
Original
Currency Amountin Acc Original Amount in Acc Payment
Amount Curr Amount Curr  Status Currency Rate Date
-200.00 -1000.00 -200.00 -1000.00  NotCleared 5 6/9/2021

2. Create a manual supplier invoice for an amount of 500, Create a mixed payment and connect the
created supplier invoice with the currency rate 8.

Mixed Payment FIFO_PL-11-6/9/2021 ¥
« ® + 4 ® B v New Transaction Approve Print Mixed Payment Note
Transaction Balances
Cash Account Statement No Remaining Amount
FIFO_PL 1 500.00
Credit Debit Amountin Acc Curr Credit A
500.00 0.00 4000.G4
Transaction Details
Y | B v + 4 @ B~ Edit Transactions Open Supplier Bills Open Ig
Lump Sum
1 Amount Currency Rate nv/Prepaym No Trans Number  Payment Transaction Type
H -500.00 8 89 1 | Enter Supplier Payment

Country Solution POLAND 19



3. Cash account will get updated as below,

%

S

\\

2,

Cash Account Queue - FIFO_PL - 123456
A -
Original
Currency Amountin Acc Original Amount in Acc Payment
Amount Curr Amount Curr  Status Currency Rate Date
-500.00 -4000.00 -500.00 -4000.00  NotCleared 8 6/9/2021
-200.00 -1000.00 -200.00 -1000.00  NotCleared 5 6/9/2021

- Cash account will get updated with the new transaction which will be shown in minus.

How the functionality works - When there is a negative amount in the cash account — Creating an

inflow

1. Cash account is already negative.

Cash Account Queue - FIFO_PL - 123456

orene
Currency Amountin Acc Original Amountin Acc Payment
v £ Amount Curr Amount Curr  Status Currency Rate Date
-500.00 -4000.00 -500.00 -4000.00  NotCleared 8 6/9/2021
-200.00 -1000.00 -200.00 -1000.00  NotCleared 5 6/9/2021

2. Create a customer payment for an amount of 1000 and connect the invoice using mixed payment

and approve. Use currency rate 4.

3. Cash account is updated as below,

Cash Account Queue - FIFO_PL - 123456

= ¥ B v

Original
Currency  Amountin Acc Original  Amount in Acc Payment
Amount Curr Amount Curr  Stats Currency Rate  Date
300.00 1200.00 300.00 120000  NotCleared 4 6/92021
0.00 0.00 -500.00 -400000 (CEEEY 8 6/9/2021
000 000 -200.00 -1000.00 ([ 5 6/9/2021
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2.10 Delimitations

e Functionality is only supported in the accounting currency. When PP79/PP80 postings and
corresponding PP1 postings are created as a result of differences calculated in the
accounting currency in company with parallel currency enabled, amounts in parallel currency
are set to 0.

e You can only select the value in the Currency Rate Calculation Method field if the cash
account is not in accounting currency and there are no transactions for the cash account.

o Cash accounts with a currency rate calculation method defined cannot be used in other
payment windows (i.e.. supplier payment, customer payment, netting, acknowledge
automatic supplier payment, acknowledge direct debiting etc.)

¢ In case when FIFO method is used, only the last mixed payment can be cancelled.

Additional delimitations may apply; all relevant flows should be tested to ensure completeness.
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3 Standard Audit File-Tax For Poland (JPK)
3.1 Overview Legal Requirement

Since 1st July 2016 all companies in Poland have to comply with an additional reporting requirement,
i.e., to produce a file detailing specific information about the business of the taxpayer and to provide
it electronically to the Polish tax authorities for audit purposes. In other words, this is an XML-based
procedure for the transmission of companies’ transactions to the tax authorities to enable efficient
auditing of taxable transactions.

These files should be provided in specific formats defined by the Polish tax authorities and thus they
are called Standard Audit File for Tax (SAF-T) or Jednolity Plik Kontrolny (JPK) in Polish.

Since 1st of October 2020 Polish Tax Declaration, VAT-7 Report, is also included in the JPK concept.

According to the Notice published by the Polish Tax Authority, based on the Corporate Income Tax
Act and the Personal Income Tax Act, the initial JPK_KR schema was logically divided into two new
schemas as,

. JPK_KR_PD

. JPK_ST_KR

Accordingly, all companies in Poland are obliged to create reports in XML format according to the
following rules:
Mandatory reports to be provided monthly.
¢ In case of reporting for periods starting from October 2020
o Sales & Purchase VAT Registers and Tax Declaration — JPK_V7M
= JPK_V7M (1) — from October 2020 to December 2021
» JPK_V7M (2) — from January 2022 to January 2026
= JPK V7M (3) — from February 2026
¢ In case of reporting for periods until September 2020 (including corrections for these periods)
o Sales & Purchase VAT Registers — JPK_VAT
o Tax Declaration (VAT-7) reported outside JPK concept

Mandatory reports to be provided annually.
¢ In case of reporting for periods starting from January 2025
o For Accounting Books - JPK_KR_PD
¢ In case of reporting for periods starting from January 2026
o For Fixed Assets and Intangible Assets — JPK_ST_KR

Reports to be provided on demand:
e For Inventories - JPK_MAG
e For Sales VAT Invoices - JPK_FA
e For Mixed Payments - JPK_WB
e For Accounting Books - JPK_KR

In the standard functionality, customer/supplier group is not available in the Tax Ledger. In order to
support TP indicator in JPK_V7M (connections between seller and buyer) it was requested to enable
customer/supplier group in the Tax Ledger with similar functionality as tax code and delivery type in
the standard system.
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3.2 Customer/Supplier Group Enhancement in Tax Ledger
3.2.1 SOLUTION

In order to enhance the system with customer/supplier support in the Tax Ledger, the following has
been done:

1. The Customer/Supplier Group and Original Customer/Supplier Group columns have been
added to the Tax Transactions page.

2. The Customer/Supplier Group column have been added to the Details tab on the Tax
Proposal Details page.

3. The Allow Change of Customer/Supplier Group radio button has been added to the Tax
Ledger Parameters page.

4. The Enable Change of Customer Group radio button, Customer Group field, Enable Change
of Supplier Group radio button and Supplier Group field have been added to the Modify
Tax Transactions page under the new Customer/Supplier Group section.

3.2.2 PREREQUISITIES

The company must be set-up to use Polish localization, see the Company Set up chapter. The
“Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and enabled by
default.

3.2.3 ENABLE CHANGE OF CUSTOMER/SUPPLIER GROUP

Open the Tax Ledger Parameters page. In order to enable possibility to update customer/supplier
group in the Tax Ledger, select the Allow Change of Customer/Supplier Group radio button.

If the Allow Change of Customer/Supplier Group radio button is not selected, customer/supplier
group will still be available in the Tax Ledger, but it will not be possible to update.

LJ AMKA-PLN

Tax Ledger Parameters

Tax Transactions A Tax Proposal

Original v «

Modify Tax Transactions

3.2.4 ENTER INVOICES

Follow IFS Cloud standard processes to enter customer invoices and supplier invoices.
3.2.5 UPDATE VOUCHERS TO GL

Follow IFS Cloud standard process to update vouchers to General Ledger.

3.2.6 FETCH TAX LEDGER INFO

Follow IFS Cloud standard process to update tax transactions with additional information.
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3.2.7 VIEW TAX TRANSACTIONS
Follow IFS Cloud standard process to view tax transactions.

The following new columns are added to the Tax Transactions page.

o Customer/Supplier Group — Customer or supplier group of the party from the Identity column
and the corresponding Description of the group.

e Original Customer/Supplier Group — Customer or supplier group of the party from the Identity
column. This original value remains unchanged when customer or supplier group is modified
in Tax Ledger. This also includes the Description of the group from the Original
Customer/Supplier Group column.

® > Financials > Tax Ledger > Tax Transactions & Company [ AMKA-PLN
Search  asvanced

I
TaxTransID ¥  TaxIDNumber ¥  Identity ¥  Accounting Period ¥ TaxCode ¥  Voucher Date ¥  Year Period Key ¥  Accounting Year ¥  More ¥ O Favorites  Clear Q ¢ Settings

Tax Transactions

VYV B v % Calculate Income Amount :: 0
IsPartof  Includein
Supplier/Custo Is Tax Tax TaxBase  TaxBase Curr Original Customer/Supplier
v on  Invoice Type Branch Branch Tax Code Fetched Reported Correcti.. Ledger  Proposal Amount Amount Tax Amount | Customer/Supplier Group Group
HEERES 23 0 o] Yes -813.01 -813.01 -186.99 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
i1 ks 23 m m -406.50 -406.50 -93.50 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 PREPAYDEB 23 o] o] Yes -500.00 -500.00 -115.00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 PREPAYCRE 23 m m 500.00 500.00 115.00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDDES 23 0 o] Yes -450.00 -100.00 10350 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDCOR 23 m m -540.00 -120.00 -124.20 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
1 CUSTORDCOR 23 o] o] Yes 450.00 100.00 103.50 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
HE >4 WNT23 m m 100.00 100.00 23,00 | 0 - Domestic Associated Unit 0 - Domestic Associated Unit
|1z WNT23 0 o] Yes -100.00 -100.00 -23.00 | 0- Domestic Associated Unit 0 - Domestic Assodiated Unit
i 1Rz WNT23 m m m -200.00 -200.00 -46.00 | SUPPLIERGROUP1 - Supplier 1 SUPPLIERGROUP1 - Supplier

3.2.8 MODIFY TAX TRANSACTIONS FROM TAX TRANSACTIONS

If customer or supplier group needs to be changed, update the value on the Tax Transactions page.
If you want to update the value for multiple tax transactions, select the Modify Tax Transactions
command to open the Modify Tax Transactions page. If you want to update customer group, enable
the Enable Change of Customer Group radio button, and enter value in the Customer Group field. If
you want to update supplier group, enable the Enable Change of Supplier Group radio button, and
enter value in the Supplier Group field.
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In case transaction is already reported, use the Modify Tax Transactions command to update
customer or supplier group. Two new tax transactions will be created according to the same logic as
if tax code or delivery types was changed in the standard system.

X Modify Tax Transactions

Enter Date Add Number of Days

Delivery Type

Enable Change of Delivery Type Delivery Type

Income Type v
Us Specific 1099 Reporting v
Tax Direction v

Customer/Supplier Group

Enable Change of Supplier Group Supplier Group Enable Change of Customer Group

Customer Group

0K Cancel

3.2.9 CREATE TAX PROPOSAL AND VIEW TAX PROPOSAL DETAILS

Follow IFS Cloud standard process to create a new tax proposal in the Automatic Tax Proposal
page. When proposal is created, follow IFS Cloud standard process to view tax proposal details, by
selecting the Details command.

The following new column is added to the Details tab of the Tax Proposal Details page.

. Customer/Supplier Group — Customer or supplier group and description from tax transaction.
@ > #Fnancials > #Tax Ledger > #AUTOMATIC Tax Proposal > #Tax Proposal Details £ #Company
#Tax Proposal Details s:-so21 = #1101 .
» &~ v]

#Tax Propasal #Creation Date #User ID
32-5021 71242021 Qrvax
#Tax Report #Tax Template
AK S021 - Tax Sales S021 - #Tax Sales (Detailed)
v oe~ = -
#Tax
Transaction
#Tax 1D #Tax Number #invoice Liability #arrival
v i sCorrection Reference  #Trans Code #Tax Book ID #5ubgroup per Tax Code #Tax 1D Type Date Date Date #Customer/Supplier Group
H P4 T8 WNT - Sum for EU Purchase PL 7172021 72021 0 - Domestic Associated Unit
m P4 B WNT - Sum for EU Purchase PL 7n2021 2021 0 - Domestic Associated Unit
H m P4 TB WNT - Sum for EU Purchase PL 22021 71272021 0 - Domestic Assoclated Unit
o P4 8 WNT - Sum for EU Purchase PL 722021 71272021 0 - Domestic Associated Unit
- |
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3.2.10 MODIFY TAX TRANSACTIONS FROM TAX PROPOSAL DETAILS

If customer or supplier group needs to be changed, select the Modify Tax Transactions command to
open the Modify Tax Transactions page. If you want to update customer group, enable the Enable
Change of Customer Group radio button and enter value in the Customer Group field. If you want
to update supplier group, enable the Enable Change of Supplier Group radio button and enter value
in the Supplier Group field.

X Modify Tax Transactions

User Defined Date

Enter Date Add Number of Days

Delivery Type

Enable Change of Delivery Type Delivery Type

Income Type e

US Specific 1099 Reporting v

Tax Direction 4

Customer/Supplier Group

Enable Change of Supplier Group Supplier Group Enable Change of Customer Group

Customer Group

OK Cancel

Country Solution POLAND 26



\\\\

=" IFS

3.3 SAF-T For Poland — VAT Report from February 2026 (JPK_V7M (3))

3.3.1

SOLUTION — SAF-T PLV7M

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

In order to support the requirement for the SAF-T PL V7M report, the following has been done

1.
2.

3.

o~

New report type SAF-T added to the Audit Formats page.

In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

In Audit Interface Assistant page 2/3, new Audit Type field has been added to select
relevant SAF-T report. In page 3/3 additional Proposal ID field specific for the SAF-T V7M
has been added.

New external file type and new external file template were added to support SAF-T V7M.
List of values is added for the Reference Number column for vouchers of function group M
to have additional invoice information in tax transactions.
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Process Overview:

« Define Tax Office (Standard functionality)

« Define Person E-Mail and Phone Communication Methods (Standard functionality)

« Define Customer Groups, Invoice Series, Voucher Types, Delivery Types (Standard functionality)
Define Company « Define Tax Sub Group Details (Standard functionality)

Basic Data }
« Enter Audit Format for Poland J
S,

« Enter Audit File Basic Data: Tax Office ID, Person ID, Invoice Series for SAD, Invoice Series for Unreturned Deposit
Customer Groups, Voucher Types, Delivery Types used to follow specific transactions
Define Audit File Basic
DEIE]

« Enter transactions in accordance with IFS Cloud standard functionality
« Update vouchers to General Ledger
RE e B h ey ° Fetch tax transaction details to Tax Ledger
Tax Ledger
Transactions

« Select tax transactions for Tax Disbursed of the reporting period

Create Tax Sales

Create Tax Purchase

« Calculate the subtotals and totals of Tax to pay or Tax to return

Create Tax Summary
Report S118

« Run Audit Interface Assistant

« Select country as Poland

« Enter report type SAF-T and audit type JPK_V7M(3)

(O N Y - Select file type JPK_V7M3, template, date / period range and VAT-7 Proposal ID
XML File

« Select tax transactions for Tax Received of the reporting period J
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3.3.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and
enabled by default.

o It is recommended to create the company using Standard Polish Template (STD-PL).
3.3.3 DEFINE COMPANY BASIC DATA
3.3.3.1 Define Tax Office
Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax

Office for Poland — one from the list published on tax authority’s website. For example
“0202”, “10107, “3030” ...

L] Application Base Setup » Enterprise » Tax » Tax Office » S
Search  advanced
Tax Office * MName:PL% ~ @ CreationDate ¥ More ¥ © Favorites  Clear Q : Settings
sortby - -
Tax Office ozo2-rLraxofficepan v 10f1
0202 . : =
« =+ & 0] g Ji e Q0
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English v
Tax Report Name Country
PL Tax Office Dan POLAND v
Creation Date
8/4/2020

On the Tax Report sub menu, enter the Company and Tax ID Number. Connect the VAT-7 report
used as a base for SAF-T V7M report in the child table.

P - N =
® > Application Base Setup > Enterprise > Tox > Tax Office » Tax Report =

sorthy v

Tax Report VATPL-VATPL ¥ 1of1

VAT PL
&« B v
Name: VAT PL
Address
Communication Method Tax Office Name
Tax Report & VAT PL VAT BL

Company: AMKA-PLN - AMKA-PLN ¥

Q + &
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMKA-PLN 202001 vatplo1 vatplo1 W -

warminsko-mazurskie

Tax Report Info
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3.3.3.2 Define Person E-Mail and Phone Communication Methods

Open the Application Base Setup/Enterprise/Person/Person page General sub menu define
Person ID of person responsible for JPK_V7M reporting. On the Communication Method sub menu
enter E-Mail Communication Method and Phone Communication Method. Select the Default per
Method check box for both methods.

® 5 Application Base Setp > Enterprise > Person

soriby v

0 AMKALK

Full Name: Amaya Karunaratne
User ID: AMKALK

Address
Communication Method §

Documnents

> Person > Communication Method &2

Communication Method AMKALK - Amaya Karunaratne ¥  1of 1

Full Name

Amaya Karunaratne

Comm D Name Description

1 amaya

2 amaya

3.3.3.3 Define Customer Groups

Communication
Method

E-Mail

Phone

User ID Validity
AMKALK Active

Default
per
Default Method

per and
Method | Address ID Address  Validity Period

Value
amaya@amkapln.com

4443553535354

Using IFS Cloud standard functionality, define separate customer groups used to follow connections
between seller and buyer ((V7M) TP field).

] Financials » Customner Invoice » Basic Data » Customer Groups S
Customer Groups
= W P + &
Use
Collective Default No of
- H Customer Group Description Voucher Invoice Copies
| L Domestic Associated Unit m 1 |
N Domestic Mot Associated Unit m 1
| P2 Foreign Associated Unit m 1 |
: |3 Foreign Mot Associated Unit m 1
4 Internal Unit m 1

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.4 Define Invoice Series

Using IFS Cloud standard functionality, define separate invoice series used to follow documents
related to unreturned deposits (Invoice Series for Unreturned Deposits field).
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@ > Financials > CustomerInvoice > Basic Data > Invoice Series C Company Polish Company [

Invoice Series

® search
= 4+ p B v v 24~ B8 -
Max No of Payment
Char for Method for Separate
Payment Fixed Length Creation of Tax Tax
v Series ID Description Voucher Type Reference of Invoice No  Paym Ref Invoice Invoice
FS-SK Manual Customer Invoice, Deposit Refund System m m

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.5 Define Voucher Types

Using IFS Cloud standard functionality, define separate voucher types used to follow

¢ internal documents (WEW field)
¢ internal summary documents containing sales from cash registers (Sales/RO field).

company [ Dan Poland

@ > Accounting Rules > User Related Data > Voucher Type i
sortby -
Voucher Type WEW - Internal Documents PL ¥ 10f1
WEW — .
« 7 ] B8 v New Voucher Type Voucher Series Excluded From IL Translation Q
Descripti... Internal Documens..

Parameter Selection

Automatic Allotment single Function Group
= mulation Vou
nternal Documents PL m
;i L cher A
Ledger Selection Use Voucher Approval Workflo
Ledger Type Ledger ID Balance Mandatory m
GL, Affect IL *
Use Manual Internal Methods
Function Group Information
= ¥V B z E
Single
Optional VYoucher Automatic  Function
Auto Store  RowGroup Reference  Allotment  Group
i Function Group Balance  Original Validaton  Mandatory Required  Required

£ M- Manual vouchers m ﬂ m m u m

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.3.3.6 Define Delivery Types

Using IFS Cloud standard functionality, define separate delivery types used to follow
¢ invoices issued on the base of fiscal receipt (Sales/FP field)
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¢ invoices from small suppliers who selected cash method for VAT (Purchase/MK field).

@ > Financials > Custemer Invoice > Basic Data » Delivery Types 5 company | Dan Poland
Search  agvanced R
Delivery Type - MK ¥ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ & Favorites  Clear Q i Setings
Delivery Types
(] =+ rs = v
Include in
Inveice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
T MK Invoices from small suppliers who selected cash method for VAT m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:
e deliveries of alcoholic beverages (GTU_01 field)

deliveries of petroleum products (GTU_02 field)

deliveries of heating oil and other oil products (GTU_03 field)

deliveries of tobacco products (GTU_04 field)

deliveries of waste (GTU_05 field)

deliveries of electronic devices (GTU_06 field)

deliveries of vehicles and car parts (GTU_07 field)

deliveries of precious metals and base metals (GTU_08 field)

deliveries of medicines and medical devices (GTU_09 field)

deliveries of buildings and lands (GTU_10 field)

services in the scope of transferring the right to emit greenhouse gas (GTU_11 field)

selected intangible services (GTU_12 field)

transport and storage services (GTU_13 field).

L ] Financials > Customer Invoice > Basic Data > Delivery Types 2:3 Company | Dan Poland
Search  advancec I

Delivery Type : GTU% ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q © Semings
Delivery Types

- - 7

l
¢

Include in
Invoice
I Delivery Type Description Enclosure  Inveice Enclosure Series ID
POGTUO Deliveries of alcoholic beverages
i GTU_02 Deliveries of petroleum products
! GTU_03 Deliveries of heating oil and other oil products

i GTU04 Deliveries of tobacco products

i GTU_05 Deliveries of waste

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

o distance EU delivery of goods and provision of telecommunication services, broadcasting
and electronic services ((V7M) WSTO_EE field)

e delivery of goods to EU consumers where taxpayer enables electronic platform to non EU
taxpayer and does not use OSS or IOSS procedures ((V7M) IED field)

¢ invoices for tourism services ((V7M) MR_T/(FA) P_106E_2 field)

¢ invoices for secondhand goods and work of art (V7M) MR_UZ/(FA) P_106E_3 field)

e EU delivery after import based on import procedure 42 ((V7M) |_42 field)
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EU delivery after import based on import procedure 63 ((V7M) |_63 field)

e transfer of a single-purpose voucher made by a taxpayer acting in his own name ((V7M)
B_SPV field)

o supply of goods and provision of services to which the single-purpose voucher relates to a
taxable person who issued the voucher ((V7M) B_SPV_DOSTAWA field)

e provision of brokering services and other services related to the transfer of multi-purpose
voucher ((V7M) B_MPV_PROWIZJA field).

® > Financials > Supplier involce > BasicData » Delivery Types & Company Polish company
Search  asvances ¥

Delivery Type : WSTO _EEIED ~ (] Description ¥  Include in Invoice Enclosure ¥ More ¥ 0 Favorites Clear

Delivery Types
=¥V B+ 4 v || S
Include In
Involce
Dell very "_;:e Description Enclosure Involce Enclosure Serles ID
WSTO_EE Distance EU delivery of goods and provision of telecommunication services, broadcasting and electronic serv m
IED Delivery of goods to EU consumers where the taxpayer enables electronic platform 1o non-EU taxpayer and ¢ m

Using IFS Cloud standard functionality, define separate delivery types by which:
e transaction value is retrieved and reported in the <K_14> tag ((V7M) K_14/(VAT) K_14 field)
e transaction value is retrieved and reported in the <K_35> tag ((V7M) K_35/(VAT) K_38 field)
e transaction value is retrieved and reported in the <K_36> tag ((V7M) K_36/(VAT) K_39 field).

® > Financials > Customer Invoice > Basic Data > Delivery Types &3 company
Search  sdvanced 4
Delivery Type : K% ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Sew ngs
Delivery Types
AT B v + e = v
Include in
Invoice
i Delivery Type Description Enclosure  Inveice Enclosure Series D
! K36 K_36 (Tax Template Field VAT_WNT_PAL_SIL)
PoK14 K_14 (Tax Template field ART_129_UST) m
POK3s K_35 (Tax Template field VAT_NALEZ_WNT_TRANSP)

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.
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3.3.3.7 Define Tax Sub Group Details

Using IFS Cloud standard functionality, connect new tax codes to existing tax sub groups in the Tax
Group/Sub Groups Details page for sub groups used for Tax Sales (Detailed) and Tax Purch
(Detailed) reports (Tax groups “KRS” and “KRZ” according to STD-PL company template).

If required, connect new delivery types in the same tab.

® > Financials > Tax Ledger > Basic Data » Tax Group £

oty w
TaX Group KRS - Classification of Items in Sales Register ¥
KOO
« + 7 m B o~
Descri... Classification of reversed charg...
KRS
Descrip... Classification of Items in Sale.. 2 Group 1D Bescripton 2% Group Selection Base
KRS Classification of Items in Sales Register Delivery Type -
KRZ
T M . Sub Groups
Descri..  Classification of ltems in Purch...
Sub Group Details
KUE

Descript... Classification for VAT-UE Decl.. LI s e

Currency Code ¥ SubGroup ¥  TaxCode:MPPR23% ¥ @ More ¥ © Favorites Clear Q i Serrings

~ 1 CurencyCode  SubGroup Tax Code Delivery Type Delivery Type Exceptions

: | PN SPRZ-KRAJ-22 - Domestic Sales, VAT 22% and 23% 23 - VAT 23%, domesti % ZLE-DLUGI-VAT-MINUS, ZLE-DLUGI-VAT-PLUS

i PN SPRZ-KRAJ-22-AB3A-U1 - Domestic Sales, VAT 22% and 23 esti... | ZLE-DLUGI-VAT-MINUS...

i |PIN SPRZ-KRAJ-22-A89A-U4 - Domestic Sales, VAT 22% and 23 23 - V) esti.. | ZLE-DLUGI-VAT-PLUS - ...

3.3.4 DEFINE AUDIT FILE BASIC DATA

3.3.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
e Report Type as “SAF-T”
e |f the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

3.3.4.2 Enter Audit File Basic Data

Click Audit File Basic Data command to open the Audit File Basic Data page.

. - . ~
® > Accounting Rules > Audit Interface > Basic Data > Audit Formats &

Audit Formats

[® o~ - & W o B~ Audit File Basic Data Audit File Tax Information Audit File Log

Thousands Negatve  Leading

L Country Report Type Decimal Symbol | Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
i | POLAND SAFT -{paint) , lcomma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.
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The new tab SAF-T Poland Setup includes ten sections. For SAF-T V7M report, following sections
are applicable.

£ » Accounting Rules > Auditinterface » BasicData » AuditFormats > Audit File Basic Data Campany Polish Company B |,

Audit File Basic Data

A
7 W
HEADER STANDARD AUDIT CODE MAPPING SAF-T POLAND SETUR i .
L w
General Info
Tax Office ID Address ID
0202 - Al-COMP i

Misc Parameters

Peraon ID Invoice Series for SAD mvoice Series for Unreturned Deposits
MABEPL - sD FS-5K
ivery Types for D Types [JPK_V7M)
WEW Sales/RO Sales/FP Purchase/MK
Delivery Types for Specific Procedures [JPK_FA) s
Delivery Type for Delivery Goods and Services
GTU_O1 GTU0Z GTUO3 GTU04
GTU_O5 GTU_06 GTUO7 GTU_08
GTU_02 GTUO GTUM GTUAaZ
ETRE]
Delivery Types/Customer Groups for Specific Procedures
(V7M) WSTO_EE (VTM] IED V7M) TP (VTM] MR_T/(FA) PIIDEE_2
(W7M) MR_UZ/(FA) PIDBE_3 (vTM) 182 V7M) 163 (W7M) B_SPY
(V7M} B_SPV_DOSTAWA {WTM) B_MPV_PROWIZJA [W7M) K14/ (VAT] K14 (VTM) K_35/ [VAT) K_38
(V7M) K_38/ (VAT) K_39 (VTM) SW (V7M) EE
Tax Codes for Specific Procedures
(W7M} MPP} (FA} P1EA
Invoice Type Mappings W

General Info section
o Tax Office ID — Select from list of values; only values from legal list are accepted by tax office.

Misc Parameters section

e Person ID — Enter person ID; on list of values there are only persons connected to given
company; The e-mail address and the phone number defined for the specified person is
reported in SAF-T V7M XML file.

¢ Invoice Series for SAD — Enter invoice series from list of values — to be used for customs
documents registration. When SAF-T V7M XML file is created and invoices with series
entered in the Invoice Series for SAD field exist, it is validated if there are any references
in the Ref Invoice No and Ref Supplier ID fields in the Supplier Invoice Details/General
tab. If supplier is different from the one on the invoice, XML file contains mixed data from two
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invoices. In particular supplier data is fetched from the referred invoice. If supplier is the same
or Ref Invoice No is empty — only data from basic invoice is reported in XML file.

Invoice Series for Unreturned Deposits — Enter invoice series from list of values — to be used
for registration of documents related to unreturned deposits. When SAF-T V7M XML file is
created and manual customer invoices with series entered in the Invoice Series for
Unreturned Deposits field exist, fixed text “SYSTEM KAUCYJNY” is set in the
<DowodSprzedazy> tag in XML file, instead of invoice number.

Voucher/Delivery Types for Document Types (JPK_V7M) section

WEW - Enter voucher type used in order to follow internal documents.

Sales/RO - Enter voucher type used in order to follow internal summary documents
containing sales from cash registers.

Sales/FP - Enter delivery type used in order to follow invoices issued on the base of fiscal
receipt.

Purchase/MK - Enter delivery type used in order to follow invoices from small suppliers who
selected cash method for VAT.

Delivery Types for Goods and Services (JPK_V7M) section

GTU_01 - Enter delivery type used in order to follow deliveries of alcoholic beverages.
GTU_02 - Enter delivery type used in order to follow deliveries of petroleum products.
GTU_03 - Enter delivery type used in order to follow deliveries of heating oil and other oll
products.

GTU_04 - Enter delivery type used in order to follow deliveries of tobacco products.
GTU_O05 - Enter delivery type used in order to follow deliveries of waste.

GTU_O06 - Enter delivery type used in order to follow deliveries of electronic devices.
GTU_07 - Enter delivery type used in order to follow deliveries of vehicles and car parts.
GTU_08 - Enter delivery type used in order to follow deliveries of precious metals and base
metals.

GTU_09 - Enter delivery type used in order to follow deliveries of medicines and medical
devices.

GTU_10 - Enter delivery type used in order to follow deliveries of buildings and lands.
GTU_11 - Enter delivery type used in order to follow services in the scope of transferring the
right to emit greenhouse gas.

GTU_12 - Enter delivery type used in order to follow selected intangible services.

GTU_13 - Enter delivery type used in order to follow transport and storage services.

Delivery Types/Customer Groups for Specific Procedures section

(V7M) WSTO_EE - Enter delivery type used in order to follow distance EU delivery of goods
and provision of telecommunication services, broadcasting and electronic services.

(V7M) IED - Enter delivery type used in order to follow delivery of goods to EU consumers
where taxpayer enables electronic platform to non EU taxpayer and does not use OSS or
IOSS procedures.

(V7M) TP - Enter customer group used in order to follow connections between seller and
buyer.

(V7M) MR_T/(FA) P_106E_2 - Enter delivery type used in order to follow invoices for tourism
services.

(V7M) MR_UZ/(FA) P_106E_3 - Enter delivery type used in order to follow invoices for
secondhand goods and work of art.

(V7M) 1_42 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 42.

(V7M) |_63 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 63.
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(V7M) B_SPV - Enter delivery type used in order to follow transfer of a single-purpose
voucher made by a taxpayer acting in his own name.

(V7M) B_SPV_DOSTAWA - Enter delivery type used in order to follow supply of goods and
provision of services to which the single-purpose voucher relates to a taxable person who
issued the voucher.

(V7M) B_MPV_PROWIZJA - Enter delivery type used in order to follow provision of brokering
services and other services related to the transfer of multi-purpose voucher.

(V7M) K_14/(VAT) K_14 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_14> tag in the SAF-T V7M XML file.

(V7M) K_35/(VAT) K_38 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_35> tag in the SAF-T V7M XML file.

(V7M) K_36/(VAT) K_39 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_36> tag in the SAF-T V7M XML file.

CHANGE TO MANUAL FIELDS IN JPK_V7M REPORT

Using IFS Cloud standard functionality, update values in the Automatic Tax Proposal/Template
Field Presentation/Edit Manual Fields as presented below.

@ > Financials

Tax Ledger > Automatic Tax Proposal » Tax Proposal - Template Field Presentation C Company Polish Company B3

Tax Proposal - Template Field Presentation

@ Sea

9-2026-01,JPKN7M3 ¥ 101

»

reh (1)

Created/Simulated
—

(A w

reation Date User ID

9 - 2026-01, JPKV7M3 1/27/20286 MB' MABEPL

= Edit Manual Fields o 1= ~ 24 ~

Tax Template

Template Field # inReport Field  Field #1 Value

i VAT_ZWROT_BEZP - P_54 Wysokos¢ nadwyzki podatku naliczonego nad naleznym do zwrotu na rachunek wskazany przez podatnika PS4 0.00

i WYBOR_ZWROT_VAT_15 - P_540 Zwrot na rachunek rozliczeniowy podatnika w terminie 15 dni: 1 - tak P_S40 1.00

i WYBOR_ZWROT_NA_RACH_VAT - P_S5 Zwrot na rachunek VAT podatnika w terminie 25 dni: 1 - tak P_S5 -1.00

H WYBOR_ZWROT_VAT_25 - P_56 Zwrot na rachunek rozliczeniowy podatnika w terminie 25 dni (art. 87 ust. 6 ustawy): 1 - tak P_56 -1.00

i WYBOR_ZWROT_VAT_40 - P_560 Zwrot na rachunek rozliczeniowy podatnika w terminie 40 dni: 1- tak P_580 -1.00

i WYBOR_ZWROT_VAT_180 - P_SB Zwrot na rachunek rozliczeniowy podatnika w terminie 180 dni: 1- tak P_s8 -1.00

For an example, P_63 and P_64 manual fields should be edited as “1” if any invoices for tourism
services or secondhand goods and work of arts exist in the reporting period respectively.

3.3.6

CREATE SAF-T V7M XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M
XML file.

On Task Options in Audit Interface Assistant page, select one of the below options.

Start Now: This option enables user to instantly create an audit file.
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Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).

Specify the following and Click Next:

Company: The company you want to generate SAF-T V7M file.

Country: “Poland”

Report Type: “SAF-T” - the value is prompted per default Audit Formats settings for Poland.
Audit Type: “‘UPK_V7M(3)”

Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
File Type: Select JPK_V7M3 structure from list of values.

File Template: Shows up automatically after File Type is specified.

(A Accounting Rules > Audit Interface > Audit Interface Assistant e

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters == Schedule Schedule Options

Start Option
(@ Start now
() Schedule
Parameters
Company* Country* Report Type* Audit Type
MABE-JPK v POLAND v ‘ SAF-T v ‘ JPK_V7M(3) v
Audit Source Ledger ID File Type File Template
JPKV7M3 v JPK_V7M3_TEMPLATE v
Selection
Period/Date Range From until
(O Date 2026 ‘ ‘ 2 ‘ ‘ 2026 ‘ ‘ 2 ‘
(@ Period
b Next Cancel

On SAF-T PL Additional Parameters in Audit Interface Assistant page specify the Tax Proposal
ID, the VAT-7 proposal ID that was created for the period. Use the list of values to search for the
correct proposal. Click Finish button to generate the SAF-T V7M XML file. The file is named as
<Audit Type>_<Time stamp(yyyymmddhhmmss)>. XML

e.g. JPK_V7M3_20260212162006.XML
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O— Task Options —.— SAF-T PL Additional Parameters == Schedule Schedule Options
3-VIM A

4 Previous Finish Cancel

3.3.6.1 Reporting of Bad Debt Corrections for Tax Disbursed

Use IFS Cloud standard functionality of manual voucher to register tax amount correction in
connection to bad debts for domestic sales.

o If tax disbursed is to be decreased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-U1, SPRZ-KRAJ-7-A89A-U1 or SPRZ-KRAJ-3-A89A-U1 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
MINUS, according to default setup).

o If tax disbursed is to be increased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-U4, SPRZ-KRAJ-7-A89A-U4 or SPRZ-KRAJ-3-A89A-U4 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
PLUS, according to default setup).

¢ In the New Voucher page, register manual voucher to correct tax amount. Enter series of
original invoice in the Reference Series field and use list of values to select number of
original invoice in the Reference Number field.

In case tax disbursed is decreased, <TerminPlatnosci> tag (due date) is automatically set to date
from the Current Due Date field of the first invoice installment. If other date should be reported in
the <TerminPlatnosci> tag, use the Text field in the New Voucher/Voucher Postings section to enter
required date.

In case tax disbursed is increased, <DataZaplaty> tag (payment date) is automatically set to latest
payment date (within the reported period) for the invoice. If other date should be reported in the
<DataZaplaty> tag, use the Text field in the New Voucher/Voucher Postings section to enter required
date.

The text can have the following format ‘<any text>: YYYY-MM-DD’. For example
o ‘Korekta z tytutu faktury z terminem ptatnosci: 2022-01-01’
o ‘Korekta z tytutu faktury zaptaconej: 2022-01-01’

3.3.6.2 Reporting Tax for Unreturned Deposits

Use IFS Cloud standard functionality of manual customer invoice to register transactions related to
unreturned deposits.
¢ Inthe Invoice Series page, enter new invoice series.
¢ Inthe Audit File Basic Data/SAF-T Poland Setup/Misc Parameters section, enter new
invoice series in the Invoice Series for Unreturned Deposits field.
e Inthe New Voucher Type Assistant, enter new voucher type and connect it to the “F”
function group.
¢ Inthe Audit File Basic Data/SAF-T Poland Setup/Voucher/Delivery Types for
Document Types (JPK_V7M) section, enter new voucher type in the WEW field.
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In the Customer page, enter deposit system operator for whom you want to register
unreturned deposits. Make sure to include tax identity number.
In the New Manual Customer Invoice assistant

o Enter new document for the previously specified customer, using previously
specified voucher type and invoice series.

o Inthe Invoice No field, enter number consisting of three elements: “SYSTEM
KAUCYJNY” text, year to which unreturned deposits are applicable and tax id
number of deposit system operator, for example “SYSTEM KAUCYJNY 2025
9999999999”. When these three elements are used, invoice number is unique for
each document.

o Click Next

o Inthe Line Information section, enter two lines per each applicable tax rate. In the
first line, select tax code connected to subgroup SPRZ-KRAJ-22, SPRZ-KRAJ-7,
SPRZ-KRAJ-3, SPRZ-KRAJ-0 or SPRZ-KRAJ-ZW (tax code 23, 8, 5, 0 or ZW,
according to default setup), and enter amount of unreturned deposit for this tax rate.
In the second line, select tax code connected to subgroup SYS-KAUC (tax code
SYSKAUC23, SYSKAUCS, SYSKAUCS5, SYSKAUCO or SYSKAUCZW, according
to default setup) and enter amount of unreturned deposit per this tax rate with
reversed sign. Total net amount, tax amount and gross amount of the invoice are 0.

o Click Next. Click Finish.

Example
Invoice registered with tax code 23 and SYSKAUC23.
Lines

Tax Code Net Amount Tax Amount
1 23 1000 23
2 SYSKAUC23 -1000 -23

Tags in the XML
<K_19>1000</K_19>
<K_20>23</K_20>
<K_360>23><K_360>

If invoice was entered with incorrect information, cancel the invoice and enter it again. Note that
multiple invoices per single deposit system operator in the same JPK_V7M3 report are not
supported.

3.3.6.3 Reporting of E-invoice Reference Number (KSeF)

The following logic is used when reporting E-invoice Reference Number and in case of scenarios
when E-Invoice Reference Number is not applicable. If

In the Tax Transactions page, the E-invoice Reference Number field has a value
o Value from the E-invoice Reference Number field is reported in <NrKSeF> tag
In the Tax Transactions page, value from the Voucher Type field belongs to function
group ‘M’, the Identity field has a value and values from the Series ID field and Invoice
Number field refer to invoice for which the E-Invoice Reference Number field has a value
o Value from the E-invoice Reference No field is reported in <NrKSeF> tag (Bad
Debt Transaction)
In the Tax Transactions page, value from the Series ID field is included in the Invoice
Series for SAD field or Invoice Series for Unreturned Deposits field
o <DI>1</DI> is reported
In the Tax Transactions page, the ldentity field has a value
o <BFK>1/<BFK> is reported (Bad Debt Transaction)
In other cases
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o <DI>1</DI> is reported
Note: <OFF> tag is not used.

3.3.7 CREATE SAF-T V7M XML CORRECTION FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
correction file.

On page 1/3 and 2/3, select the same information as when generating the ordinary file. On page 3/3
specify the proposal identity of VAT-7 correction report and continue in the same way as when
generating the ordinary file. The new XML file is created. The XML tag <CelZlozenia> indicates a
correction file with value 2 as follows,

<CelZlozenia poz="P_7">2</CelZlozenia>

If only information in manual fields of VAT-7 was changed comparing to the previous report
e <Deklaracja> block is created in the XML file.
e <Ewidencja> block is not created in the XML file.

If only transaction related information was changed/added comparing to the previous report with no
impact on total amounts in VAT-7
e <Deklaracja> block is not created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
e For each document changed comparing to the original report, <Ewidencja> block additionally
contains.
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

If both transaction related information is changed and VAT-7 information is changed
e <Deklaracja> block is created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
e For each document changed comparing to the original report, <Ewidencja> block additionally
contains.
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

3.3.8 DELIMITATION

o JPK_V7K (quarterly variant of JPK_V7M for small companies) is not supported.

e Reporting of fiscal registers and invoices based on fiscal registers is not supported.

e In case of correction instant invoices for which debit lines are not required, standard
functionality allows to set quantity to 0 (as for CO invoices) or remove the debit lines
completely. Scenario in which debit lines are removed is not supported by JPK_V7M.
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3.4 SAF-T For Poland — VAT Report from January 2022 (JPK_V7M (2))
3.4.1 SOLUTION - SAF-T PLV7M

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

In order to support the requirement for the SAF-T PL V7M report, the following has been done:

6. New report type SAF-T added to the Audit Formats page.

7. In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

8. In Audit Interface Assistant page 2/3, new Audit Type field has been added to select
relevant SAF-T report. In page 3/3 additional Proposal ID field specific for the SAF-T V7M
has been added.

9. New external file type and new external file template were added to support SAF-T V7M.

10. List of values is added for the Reference Number column for vouchers of function group M
to have additional invoice information in tax transactions.
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Process Overview:

« Define Tax Office (Standard functionality)
« Define Person E-Mail and Phone Communication Methods (Standard functionality)
« Define Customer Groups, Voucher Types, Delivery Types (Standard functionality)
Define Company « Define Tax Sub Group Details (Standard functionality)

Basic Data

« Enter Audit Format for Poland
< Enter Audit File Basic Data: Tax Office ID, Person ID, Invoice Series for SAD, Customer Groups, Voucher Types,
Delivery Types used to follow specific transactions
Define Audit File Basic
Data

« Enter transactions in accordance with IFS Cloud standard functionality
« Update vouchers to General Ledger
RE e B h ey ° Fetch tax transaction details to Tax Ledger

Tax Ledger

Transactions

« Select tax transactions for Tax Received of the reporting period

Create Tax Purchase

« Calculate the subtotals and totals of Tax to pay or Tax to return

Create Tax Summary
Report S106

« Run Audit Interface Assistant

« Select country as Poland

« Enter report type SAF-T and audit type JPK_V7M(2)

(O N a4V - Select file type JPK_V7M2, template, date / period range and VAT-7 Proposal ID
XML File

« Select tax transactions for Tax Disbursed of the reporting period
Create Tax Sales
S021
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3.4.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and
enabled by default.

o It is recommended to create the company using Standard Polish Template (STD-PL).
3.4.3 DEFINE COMPANY BASIC DATA
3.43.1 Define Tax Office
Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax

Office for Poland — one from the list published on tax authority’s website. For example
“0202”, “10107, “3030” ...

L] Application Base Setup » Enterprise » Tax » Tax Office » S
Search  advanced
Tax Office * MName:PL% ~ @ CreationDate ¥ More ¥ © Favorites  Clear Q : Settings
sortby - -
Tax Office ozo2-rLraxofficepan v 10f1
0202 . : =
« =+ & 0] g Ji e Q0
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English v
Tax Report Name Country
PL Tax Office Dan POLAND v
Creation Date
8/4/2020

On the Tax Report sub menu, enter the Company and Tax ID Number. Connect the VAT-7 report
used as a base for SAF-T V7M report in the child table.

P - N =
® > Application Base Setup > Enterprise > Tox > Tax Office » Tax Report =

sorthy v

Tax Report VATPL-VATPL ¥ 1of1

VAT PL
&« B v
Name: VAT PL
Address
Communication Method Tax Office Name
Tax Report & VAT PL VAT BL

Company: AMKA-PLN - AMKA-PLN ¥

Q + &
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMKA-PLN 202001 vatplo1 vatplo1 W -

warminsko-mazurskie

Tax Report Info
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Open the Application Base Setup/Enterprise/Person/Person page General sub menu define
Person ID of person responsible for JPK_V7M reporting. On the Communication Method sub menu
enter E-Mail Communication Method and Phone Communication Method. Select the Default per
Method check box for both methods.

® 5 Application Base Setp > Enterprise > Person

soriby v

0 AMKALK

Full Name: Amaya Karunaratne
User ID: AMKALK

Address
Communication Method §

Documnents

> Person > Communication Method &2

Communication Method AMKALK - Amaya Karunaratne ¥  1of 1

Comm D Name

Full Name

Amaya Karunaratne

Description
1 amaya

2 amaya

3.4.3.3 Define Customer Groups

Communication
Method

E-Mail

Phone

User ID

AMKALK

Default

per
Value Method |Address ID
amaya@amkapln.com

4443553535354

Default

per

Method

and

Address  Validity Period

Using IFS Cloud standard functionality, define separate customer groups used in order to follow
connections between seller and buyer ((V7M) TP field).

] Financials » Customner Invoice » Basic Data » Customer Groups S
Customer Groups
= W P + &
Use
Collective Default No of
- H Customer Group Description Voucher Invoice Copies
| L Domestic Associated Unit m 1 |
N Domestic Mot Associated Unit m 1
| P2 Foreign Associated Unit m 1 |
: |3 Foreign Mot Associated Unit m 1
4 Internal Unit m 1

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.4.3.4 Define Voucher Types

Using IFS Cloud standard functionality, define separate voucher types used in order to follow:
¢ internal documents (WEW field)
¢ internal summary documents containing sales from cash registers (Sales/RO field).
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unting Rules > User Related Data > Voucher Type £ company
oy -
Voucher Type WEW - Internal Documents PL ¥ 1of 1
« 7 m B~ New Vioucher Type Voucher Series Excluded From IL Translation Q

Parameter Selection

Automatic e Fu G
<]
Description simulation Voucher Separate User Approval
nternal Documents PL m m
Ledger Selection Use Voucher Approval Workflow
Ledger Type Ledger ID Balance Mandatory m
GL, Affect IL *
Use Manual Internal Methods
Function Group Information
re = v
ngle
op Voucher Autom, Functi
A Row Group Reference  Allotment  Groy
I Function Group Balance  Original Validation — Mandatory Required  Required

&
t M- Manual vouchers m m m m m m

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.4.3.5 Define Delivery Types

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

e invoices issued on the base of fiscal receipt (Sales/FP field)
¢ invoices from small suppliers who selected cash method for VAT (Purchase/MK field).
® > Financials > Customer Invoice  Basic Data » Delivery Types £ company
Search  agvance i
Delivery Type: MK ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Semings
Delivery Types
e -+ rd = v
Include in
Invoice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
DMK Invoices from small suppliers who selected cash method for VAT m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

deliveries of alcoholic beverages (GTU_01 field)

deliveries of petroleum products (GTU_02 field)

deliveries of heating oil and other oil products (GTU_03 field)
deliveries of tobacco products (GTU_04 field)

deliveries of waste (GTU_05 field)

deliveries of electronic devices (GTU_06 field)

deliveries of vehicles and car parts (GTU_07 field)

deliveries of precious metals and base metals (GTU_08 field)
deliveries of medicines and medical devices (GTU_09 field)
deliveries of buildings and lands (GTU_10 field)

services in the scope of transferring the right to emit greenhouse gas (GTU_11 field)
selected intangible services (GTU_12 field)

transport and storage services (GTU_13 field).
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L ] Financials > Customer Invoice > Basic Data » Delivery Types 8 Compary
Search  avances ¥
Secrrin = - W <) Favorites € O3 L Carin
Delivery Type - GTU% ~ @ Description ¥ Include in Invoice Enclosure *  More ¥ O Favorites  Clear L & Setings
Delivery Types
(54 = s = v
Include in
Invoice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
POGTUO Deliveries of alcoholic beverages m
1 GTU_02 Deliveries of petroleum products m
! GTU_03 Deliveries of heating oil and other oil products m
PGTUD4 Deliveries of tobacco products m
i GTU_05 Deliveries of waste m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

distance EU delivery of goods and provision of telecommunication services, broadcasting
and electronic services ((V7M) WSTO_EE field)

delivery of goods to EU consumers where taxpayer enables electronic platform to non EU
taxpayer and does not use OSS or IOSS procedures ((V7M) IED field)

invoices for tourism services ((V7M) MR_T/(FA) P_106E_2 field)

invoices for secondhand goods and work of art ((V7M) MR_UZ/(FA) P_106E_3 field)

EU delivery after import based on import procedure 42 ((V7M) |_42 field)

EU delivery after import based on import procedure 63 ((V7M) |_63 field)

transfer of a single-purpose voucher made by a taxpayer acting in his own name ((V7M)
B_SPV field)

supply of goods and provision of services to which the single-purpose voucher relates to a
taxable person who issued the voucher ((V7M) B_SPV_DOSTAWA field)

provision of brokering services and other services related to the transfer of multi-purpose
voucher ((V7M) B_MPV_PROWIZJA field).

s » Suppller Involce > BasicData » Delvery Types &3 Company Polish company

Search  advenced

Delivery Type : WSTO_EE/IED ~ ] Description ¥ nclude in Invoice Enclosure ¥ More ¥ O Favorites w Clear

= B v + 7 24 =
Include in
Invelce
Delivery Type Description Enclosure Invoice Enclosure Serles ID
WSTO_EE Distance EU delivery of zoods and pravision of telecommunication services, broadcasting and electronic serv m
IED Delivery of goods to EU consumers where the taxpayer enables electronic platform to non-EU taxpayer and ¢ m

Using IFS Cloud standard functionality, define separate delivery types by which:

transaction value is retrieved and reported in the <K_14> tag ((V7M) K_14/(VAT) K_14 field)
transaction value is retrieved and reported in the <K_35> tag ((V7M) K_35/(VAT) K_38 field)
transaction value is retrieved and reported in the <K_36> tag ((V7M) K_36/(VAT) K_39 field).
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Search  advanced

= . |
> Basic Data » Delivery Types &
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Company | Dan Poland

Delivery Type : K% ~ €@ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q Setting
Delivery Types
/ o & = v

Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series 1D
K 36 K_36 (Tax Template Field VAT WNT_PAL SIL) W
K 14 K_14 (Tax Template field ART_129_UST) o |
K35 K_35 (Tax Template field VAT_NALEZ_WNT_TRANSP) P

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.4.3.6 Define Tax Sub Group Details

Using IFS Cloud standard functionality, connect new tax codes to existing tax sub groups in the Tax
Group/Sub Groups Details page for sub groups used for Tax Sales (Details) and Tax Purchase
(Details) reports (Tax groups “KRS” and “KRZ” according to STD-PL company template).

If required, connect new delivery types in the same tab.

® > Financials > Tax Ledger > Basic Data > Tax Group £
sortby v
TaX Gl’oup KRS - Classification of Items in Sales Register ¥
KOO ~
& + 4 B v
Descri... Classification of reversed charg...
KRS
Descrip... Classification of ltems in Sale. ax Group 1D pesepnen ax Group Selection Base
KRS Classification of Items in Sales Register Delivery Type -
KRZ
P . Sub Groups
Descri...  Classification of kkems in Purch...
Sub Group Details
KUE
[~ + &

Descript... Classification for VAT-UE Decl..

Currency Code ¥ Sub Group ¥  Tax Code: MPR;23% ~ [] More ¥ © Favorites Clear Q ! Setrngs
| i CurrencyCode | Sub Group Tax Code Delivary Type Delivery Type Exceptions
: | PN SPRZ-KRAJ-22 - Domestic Sales, VAT 22% and 23% VAT 23%, domesti % ZLE-DLUGI-VAT-MINUS, ZLE-DLUGI-VAT-PLUS
i PN SPRZ-KRAJ-22-AB3A-U1 - Domestic Sales, VAT 22% and 23 2. b, domesti... | ZLE-DLUGI-VAT-MINUS...
i PN SPRZ-KRAJ-22-AB9A-U4 - Domestic Sales, VAT 22% and 23 | 23 - VAT 23%, domesti... | ZLE-DLUGI-VAT-PLUS - ...

3.4.4 DEFINE AUDIT FILE BASIC DATA

3.4.41 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland

SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
o Report Type as “SAF-T”

e |fthe audit file is run on batch mode, the XML can be downloaded from the Batch Processed

Audit Files page.
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3.4.4.2 Enter Audit File Basic Data

Click Audit File Basic Data command to open the Audit File Basic Data page.

s - . ]
® > Accounting Rules » Audit Interface » Basic Data » Audit Formats g~

Audit Formats

B~ - & @ i B v Audit File Basic Data Audit File Tax Information Audit File Log

. Thousands Megative  Leading
m Country Report Type  Decimal Symbol  Seperator Format  Zeroes  Time Format Date Format File Type File Template ID
-
: | POLAND SAFT _{point) , [comma} =) 09 13:58 YY-MM-DD

IFS

Default

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If

required, do modifications in the Standard Audit Code Mappings.

The new tab SAF-T Poland Setup includes ten sections. For SAF-T V7M report, following sections

are applicable.

® > AccountingRules > AuditInterface > BasicData > Audit Formats > Audit File Basic Data & Company  Polish company

Audit File Basic Data

/&
HEADER STANDARD AUDIT CODE MAPPINGS RTUREJel W bR 351 4 »
7 10}

General Info

Misc Parameters

Person ID Invoice Series for SAD

MABEPL v SD =

Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services %
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

General Info section

e Tax Office ID — Select from list of values; only values from legal list will be accepted by tax

office.

Misc Parameters section

o Person ID — Enter person ID; on list of values there are only persons connected to given
company; The e-mail address and the phone number defined for specified person will be

reported in SAF-T V7M XML file.

¢ Invoice Series for SAD — Enter invoice series from list of values — to be used for customs
documents registration. When SAF-T V7M XML file is created and invoices with series
entered in the Invoice Series for SAD field exist, it is validated if there are any references
in the Ref Invoice No and Ref Supplier ID fields in the Supplier Invoice Details/General
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tab. If supplier is different from the one on the invoice, XML file will contain mixed data from
two invoices. In particular supplier data will be fetched from the referred invoice. If supplier is
the same or Ref Invoice No is empty — only data from basic invoice will be reported in XML
file.

Voucher/Delivery Types for Document Types (JPK_V7M) section

WEW - Enter voucher type used in order to follow internal documents.

Sales/RO - Enter voucher type used in order to follow internal summary documents
containing sales from cash registers.

Sales/FP - Enter delivery type used in order to follow invoices issued on the base of fiscal
receipt.

Purchase/MK - Enter delivery type used in order to follow invoices from small suppliers who
selected cash method for VAT.

Delivery Types for Goods and Services (JPK_V7M) section

GTU_01 - Enter delivery type used in order to follow deliveries of alcoholic beverages.
GTU_02 - Enter delivery type used in order to follow deliveries of petroleum products.
GTU_03 - Enter delivery type used in order to follow deliveries of heating oil and other oll
products.

GTU_04 - Enter delivery type used in order to follow deliveries of tobacco products.
GTU_O05 - Enter delivery type used in order to follow deliveries of waste.

GTU_O06 - Enter delivery type used in order to follow deliveries of electronic devices.
GTU_07 - Enter delivery type used in order to follow deliveries of vehicles and car parts.
GTU_08 - Enter delivery type used in order to follow deliveries of precious metals and base
metals.

GTU_09 - Enter delivery type used in order to follow deliveries of medicines and medical
devices.

GTU_10 - Enter delivery type used in order to follow deliveries of buildings and lands.
GTU_11 - Enter delivery type used in order to follow services in the scope of transferring the
right to emit greenhouse gas.

GTU_12 - Enter delivery type used in order to follow selected intangible services.

GTU_13 - Enter delivery type used in order to follow transport and storage services.

Delivery Types/Customer Groups for Specific Procedures section

(V7M) WSTO_EE - Enter delivery type used in order to follow distance EU delivery of goods
and provision of telecommunication services, broadcasting and electronic services.

(V7M) IED - Enter delivery type used in order to follow delivery of goods to EU consumers
where taxpayer enables electronic platform to non EU taxpayer and does not use OSS or
IOSS procedures.

(V7M) TP - Enter customer group used in order to follow connections between seller and
buyer.

(V7M) MR_T/(FA) P_106E_2 - Enter delivery type used in order to follow invoices for tourism
services.

(V7M) MR_UZ/(FA) P_106E_3 - Enter delivery type used in order to follow invoices for
secondhand goods and work of art.

(V7M) 1_42 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 42.

(V7M) |_63 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 63.

(V7M) B_SPV - Enter delivery type used in order to follow transfer of a single-purpose
voucher made by a taxpayer acting in his own name.
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(V7M) B_SPV_DOSTAWA - Enter delivery type used in order to follow supply of goods and
provision of services to which the single-purpose voucher relates to a taxable person who
issued the voucher.

(V7M) B_MPV_PROWIZJA - Enter delivery type used in order to follow provision of brokering
services and other services related to the transfer of multi-purpose voucher.

(V7M) K_14/(VAT) K_14 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_14> tag in the SAF-T V7M XML file.

(V7M) K_35/(VAT) K_38 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_35> tag in the SAF-T V7M XML file.

(V7M) K_36/(VAT) K_39 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_36> tag in the SAF-T V7M XML file.

CHANGE TO MANUAL FIELDS IN JPK_V7M REPORT

Using IFS Cloud standard functionality, update values in the Automatic Tax Proposal/Template
Field Presentation/Modify Manual Fields as presented below.

[ ] Financials > Tax Ledger » Automatic Tax Proposal > Tax Proposal - Template Field Presentation & Company  Palish company

18

Created Simulated
—

Tax Proposal - Template Field Presentation is-zozoipcvma ~ 1ori

Description: 2022-01 JPK_V7M(2)

& v Q
a sal Creation Date ser D
18 -2022-01 JPK_V7M(2) 1/27/2022 MABEPL
Tax Template
JPK_V7M2 - JPK_V7M2 S106 - Tax Sum VAT-7/22 Poland (Data for |PK_V7M(2) reporting, from..

Field Presentation 1

i= W e v Edit Manual Fields 24 2=z R

Field #1 Visible in

Template Field #1 Report Field Field #1 Value
VAT_ZWROT_BEZP - P_54 Wysokos¢ nadwyzki podatku naliczonego nad naleznym do zwrotu na rachunek wskazany przez poc  P_54 0.00
WYBOR_ZWROT_VAT_15 - P_540 Zwrot na rachunek rozliczeniowy podatnika w terminie 15 dni: 1 - tak P_540 -1.00
WYBOR_ZWROT_NA_RACH_VAT - P_55 Zwrot na rachunek VAT podatnika w terminie 25 dni: 1 - tak P_55 -1.00
WYBOR_ZWROT_VAT_25 - P_56 Zwrat na rachunek rozliczeniowy podatnika w terminie 25 dni (art. 87 ust. 6 ustawy): 1 - tak P_56 -1.00
WYBOR_ZWROT_VAT_40 - P_560 Zwrot na rachunek rozliczeniowy podatnika w terminie 40 dni: 1 - tak P_560 -1.00
WYBOR_ZWROT_VAT_60 - P_57 Zwrot na rachunek rozliczeniowy podatnika w terminie 60 dni: 1 - tak P_57 -1.00

For an example, P_63 and P_64 manual fields should be edited as “1” if any invoices for tourism
services or secondhand goods and work of arts exist in the reporting period respectively.

3.4.6

CREATE SAF-T V7M XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML

file.

On Task Options in Audit Interface Assistant page, select one of the below options.

Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).
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Specify the following and Click Next:

e Company: The company you want to generate SAF-T V7M file.

e Country: “Poland”

o Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for
Poland.
Audit Type: “‘UPK_V7M (2)’
Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
File Type: Select JPK_V7M2 structure from list of values.
File Template: Will show up automatically after File Type is specified.

[ ] Accounting Rules > Auditinterface » Audit Imerface Assistant company  Polish company

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters w Schedule Schedule Options

Start Option

(@) Start now

(D) schedule

Parameters

Company Country Report Type
MABEPL-PL - Polish company ¥ | | POLAND ¥ | |SAF-T -
Audit Type Audit Source Ledger ID

JPK_VTM(2) -
File Type File Template
JPK_V7TM2 ¥ | [ JPK_VTM2_TEMPLATE -
Selection
Period/Date Range From Unt
() Date 2022 1 2022 1
'i Period
b Next Cancel

On SAF-T PL Additional Parameters in Audit Interface Assistant page specify the Tax Proposal
ID, the VAT-7 proposal ID that was created for the period. Use the list of values to search for the
correct proposal. Click Finish button to generate the SAF-T V7M XML file. The file will be named as
<Audit Type>_<Time stamp(yyyymmddhhmmss)>. XML

e.g. JPK_V7M2_20220712162006.XML

Audit Interface Assistant

O_ Task Options _._ SAF-T PL Additional Parameters Sehedule Schedule Options

3-V/M -

4 Previous Finish Cancel

3.4.6.1 Reporting of Bad Debt Corrections for Tax Disbursed
Use IFS Cloud standard functionality of manual voucher to register tax amount correction in
connection to bad debts for domestic sales.
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o If tax disbursed is to be decreased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-U1, SPRZ-KRAJ-7-A89A-U1 or SPRZ-KRAJ-3-A89A-U1 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
MINUS, according to default setup).

e If tax disbursed is to be increased, use tax code and delivery type connected to subgroup
SPRZ-KRAJ-22-A89A-U4, SPRZ-KRAJ-7-A89A-U4 or SPRZ-KRAJ-3-A89A-U4 in the Tax
Group/Subgroup Details page (tax code 5, 8 or 23 and delivery type ZLE-DLUGI-VAT-
PLUS, according to default setup).

¢ In the New Voucher page, register manual voucher to correct tax amount. Enter series of
original invoice in the Reference Series field and use list of values to select number of
original invoices in the Reference Number field.

In case tax disbursed is decreased, <TerminPlatnosci> tag (due date) is automatically set to date
from the Current Due Date field of the first invoice installment. If other date should be reported in
the <TerminPlatnosci> tag, use the Text field in the New Voucher/Voucher Postings section to enter
required date.

In case tax disbursed is increased, <DataZaplaty> tag (payment date) is automatically set to latest
payment date (within the reported period) for the invoice. If other date should be reported in the
<DataZaplaty> tag, use the Text field in the New Voucher/Voucher Postings section to enter required
date.

The text can have the following format ‘<any text>: YYYY-MM-DD’. For example
o ‘Korekta z tytutu faktury z terminem ptatnosci: 2022-01-01’
‘Korekta z tytutu faktury zaptaconej: 2022-01-01’

3.4.7 CREATE SAF-T V7M XML CORRECTION FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
correction file.

On page 1/3 and 2/3, select the same information as when generating the ordinary file. On page 3/3
specify the proposal identity of VAT-7 correction report and continue in the same way as when
generating the ordinary file. The new XML file will be created. The XML tag <CelZlozenia> will
indicate a correction file with value 2 as follows,

<CelZlozenia poz="P_7">2</CelZlozenia>

If only information in manual fields of VAT-7 was changed comparing to the previous report
e <Deklaracja> block is created in the XML file.
e <Ewidencja> block is not created in the XML file.

If only transaction related information was changed/added comparing to the previous report with no
impact on total amounts in VAT-7
e <Deklaracja> block is not created in the XML file.
e <Ewidencja> block is created in the XML file and contains final information from all
documents.
e For each document changed comparing to the original report, <Ewidencja> block additionally
contains.
o Original information about the document
o Reversal information about the document (with reversed signs in the amount fields)

If both transaction related information is changed and VAT-7 information is changed
e <Deklaracja> block is created in the XML file.

Country Solution POLAND 53



\\\\',,
=" IFS

<Ewidencja> block is created in the XML file and contains final information from all
documents.
For each document changed comparing to the original report, <Ewidencja> block additionally
contains.

o Original information about the document

o Reversal information about the document (with reversed signs in the amount fields)

DELIMITATION

JPK V7K (quarterly variant of JPK_V7M for small companies) is not supported.

Reporting of fiscal registers and invoices based on fiscal registers is not supported.

In case of correction instant invoices for which debit lines are not required, standard
functionality allows to set quantity to 0 (as for CO invoices) or remove the debit lines
completely. Scenario in which debit lines are removed is not supported by JPK_V7M.
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3.5 SAF-T For Poland — VAT Report from October 2020 until December 2021
(JPK_V7M (1))

3.5.1 SOLUTION - SAF-T PLV7M

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

In order to support the requirement for the SAF-T PL V7M report, the following has been done:

11. New report type SAF-T added to the Audit Formats page.

12. In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

13. In Audit Interface Assistant page 2/3, new Audit Type field has been added to select relevant
SAF-T report. In page 3/3 additional Proposal ID field specific for the SAF-T V7M has been
added.

14. New external file type and new external file template were added to support SAF-T V7M.

15. List of values is added for the Reference Number column for vouchers of function group M
to have additional invoice information in tax transactions.
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Process Overview:

« Define Tax Office (Standard functionality)
« Define Person E-Mail and Phone Communication Methods (Standard functionality)
« Define Customer Groups, Tax Codes, Voucher Types, Delivery Types (Standard functionality)
Define Company « Define Tax Sub Group Details (Standard functionality)
Basic Data

« Enter Audit File Basic Data: Tax Office ID, Person ID, Invoice Series for SAD, Customer Groups, Tax Codes, Vouche

Types, Delivery Types used to follow specific transactions
Define Audit File » VP P

Basic Data

« Enter Audit Format for Poland J
r

« Enter transactions in accordance with IFS Cloud standard functionality
« Update vouchers to General Ledger
U[EIENEIRENL RSN * Fetch tax transaction details to Tax Ledger
Tax Ledger
Transactions

« Select tax transactions for Tax Disbursed of the reporting period

Create Tax Sales

Create Tax Purchase

« Calculate the subtotals and totals of Tax to pay or Tax to return

Create Tax Summary
Report S098

* Run Audit Interface Assistant

« Select country as Poland

« Enter report type SAF-T and audit type JPK_V7M(1)

(O R 24N - Select file type JPK_V7M, template, date / period range and VAT-7 Proposal ID
XML File

« Select tax transactions for Tax Received of the reporting period J
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3.5.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and
enabled by default.

o It is recommended to create the company using Standard Polish Template (STD-PL).

3.5.3 DEFINE COMPANY BASIC DATA
3.5.3.1 Define Tax Office
Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax

Office for Poland — one from the list published on tax authority’s website. For example
“0202”, “10107, “3030” ...

L] Application Base Setup » Enterprise » Tax » Tax Office » 5
Search  advancec
Tax Office = Name:PL% ~ @ Creation Date ~ Maore = 0 Favorites  Clear Q : Settings
sorthy v .
Tax Office ox2-pLraxofficenan ¥ 101
0202 . : -
& -+ & (i ) B v
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 Eng”Sh v
Tax Report Name Country
PL Tax Office Dan POLAND -
Creation Date
8/4/2020

On the Tax Report sub menu, enter the Company and Tax ID Number. Connect the VAT-7 report
used as a base for SAF-T V7M report in the child table.

. . . ~
@ > Application Base Setup > Enterprise > Tax » Tax Office » Tax Report &

i Tax Report VATPL-VATPL ¥ 1of1
VAT PL

& B v
Name: VAT PL
Address
Communication Method Tax Office
Tax Report ¥ VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ™

a + &
Company Tax ID Number Our Identity Electronic Tax ID
AMKA-PLN 202001 vatplo1 vatpl0o1 WHN -

warminsko-mazurskie

Tax Report Info
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3.5.3.2 Define Person E-Mail and Phone Communication Methods

Open the Application Base Setup/Enterprise/Person/Person page General sub menu define

Person ID of person responsible for JPK_V7M reporting.

On the Communication Method sub menu

enter E-Mail Communication Method and Phone Communication Method. Select the Default per

Method check box for both methods.

@ > Application Base Setup > Enterprise > Person > Person > Communication Method />

soriby v

Communication Method AMKALK - Amaya Karunaratne ¥  1of 1

© wos e

Full Name: Amaya Karunaratne

User ID: AMKALK

Address Person Full Name
Communication Methed & AMKALK Amaya Karunaratne

Documnents

Communication
Method

E-Mail

Phone

3.5.3.3 Define Customer Groups

User ID Validity
AMKALK

Default
Method
s Validity Period

Value

amaya@amkapln.com

88 ;:

4443553535354

Using IFS Cloud standard functionality, define separate customer groups used in order to follow

connections between seller and buyer ((V7M) TP field).

=

] [

Financials * Customer Invoice > Basic Data » Customer Groups

Customer Groups

= W 2w + 4
Use
Collective Default No of
- i | Customer Group Description Voucher Invoice Copies
| 0 Domestic Associated Unit m 1 |
N Domestic Mot Associated Unit m 1
| P2 Foreign Associated Unit m 1 |
: 3 Foreign Not Associated Unit m 1
4 Internal Unit m 1

Note: In brackets you can find the name of the field where the value should be connected in the

Audit File Basic Data/SAF-T Poland Setup tab.

3.5.3.4 Define Tax Codes

Using IFS Cloud standard functionality, define separate tax code used in order to follow invoices
which are a subject to the mandatory split payment mechanism ((V7M) MPP/(FA) P_18A field).
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® > Accounting Rules > Tax > Tax Codes k>
Search  agvances
Tax Code: MPP ~ @ Description ¥ Tax (%) * More >
Tax Codes
T 4 =+ &
~ i |TaxCode  Description Tax Type
MPP VAT 23%, Mandatory Spli - Tax

D Favorites  Clear Q Settings
Tax Tax Method Tax
(%) Deductible (%) = Valid From Valid To Received
23 100 | 14172020 12/31/2049

Invoice Entry

Tax Methed Tax
Disbursed

Invoice Entry

S\
7 IFS

company [ Dan Poland

::: I
Tax Amount
Limitin
Tax Amount at Invoice Accounting
Printout Currency

Separate from Price

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.5.3.5 Define Voucher Types

Using IFS Cloud standard functionality, define separate voucher types used in order to follow
e internal documents (WEW field)
¢ internal summary documents containing sales from cash registers (Sales/RO field).

- ~
® > Accounting Rules > User Related Data > Voucher Type ks

sorthy v

WEW

Voucher Type WEW - Internal Documents PL ¥ 10f1

& 7 ® &8 v New Voucher Type Voucher Series Excluded From IL Translation
Descripti..  Internal Documents...
Parameter Selection
er Typ Automatic Allotment
Des n Simulation Vou
nternal Documents PL m
. Use Vol
Ledger Selection
Ledger Type Ledger ID Balance Mand m

GL, Affect IL
Use Manual Internal Methods
Function Group Information

v AR 4

i Function Group

¢ M- Manual vouchers

Single
Optional Voucher Automatic  Function
Auto Store  RowGroup Refersnce  Allotment  Group

Balance  Orignal Validation ~Mandatory Required  Required

company [ Dan Poland

(¢]

Single Function Group

rate User Approval

[l
<

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.

3.5.3.6 Define Delivery Types

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:

¢ invoices issued on the base of fiscal receipt (Sales/FP field)

¢ invoices from small suppliers who selected cash method for VAT (Purchase/MK field).
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® > Financials > Customer Invoice > Basic Data > Delivery Types e Company
Search  advanced &
Delivery Type - MK ~ @ Description ¥  Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Setings
Delivery Types
] + & =~
Include in
Inveice
i Delivery Type Description Enclosure  Invoice Enclosure Series ID
MK Invoices from small suppliers who selected cash method for VAT m

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:
e deliveries of alcoholic beverages (GTU_01 field)

deliveries of petroleum products (GTU_02 field)

deliveries of heating oil and other oil products (GTU_03 field)

deliveries of tobacco products (GTU_04 field)

deliveries of waste (GTU_O05 field)

deliveries of electronic devices (GTU_06 field)

deliveries of vehicles and car parts (GTU_07 field)

deliveries of precious metals and base metals (GTU_08 field)

deliveries of medicines and medical devices (GTU_09 field)

deliveries of buildings and lands (GTU_10 field)

services in the scope of transferring the right to emit greenhouse gas (GTU_11 field)

selected intangible services (GTU_12 field)

transport and storage services (GTU_13 field).

L ] Financials > Customer Invoice > Basic Data > Delivery Types 2:3 Company | Dan Poland
Search  advanced R

Delivery Type : GTU% ~ @ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q i Semings
Delivery Types

i1 + &

I
<

Include in

Invoice
I Delivery Type Description Enclosure  Invoice Enclosure Series ID
1 GTUO Deliveries of alcoholic beverages
t GTU_02 Deliveries of petroleum products

OETU03 Deliveries of heating oil and other oil products

i GTU_D4 Deliveries of tobacco products

: GTU_05 Deliveries of waste

Using IFS Cloud standard functionality, define separate delivery types used in order to follow:
e mail orders ((V7M) SW field)

telecommunication services, broadcasting and electronic services ((V7M) EE field)

invoices for tourism services ((V7M) MR_T/(FA) P_106E_2 field)

invoices for secondhand goods and work of art (V7M) MR_UZ/(FA) P_106E_3 field)

EU delivery after import based on import procedure 42 ((V7M) |_42 field)

EU delivery after import based on import procedure 63 ((V7M) |_63 field)

transfer of a single-purpose voucher made by a taxpayer acting in his own name ((V7M)

B_SPV field)

e supply of goods and provision of services to which the single-purpose voucher relates to a
taxable person who issued the voucher ((V7M) B_SPV_DOSTAWA field)
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e provision of brokering services and other services related to the transfer of multi-purpose
voucher ((V7M) B_MPV_PROWIZJA field).

L] Financials > Customer Invoice > Basic Data > Delivery Types 5] Company
Search
Delivery Type : %SW%;%EE% ~ €@ Description ¥ Include in Invoice Enclosure ¥ More ¥ O Favorites  Clear Q. i Semings
Delivery Types
= |V LIRS + & =
Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series ID
EE Telecommunications services, broadcasting and electronic services m
sw Mail Orders m

Using IFS Cloud standard functionality, define separate delivery types by which:
e transaction value is retrieved and reported in the <K_14> tag ((V7M) K_14/(VAT) K_14 field)
e transaction value is retrieved and reported in the <K_35> tag ((V7M) K_35/(VAT) K_38 field)
e transaction value is retrieved and reported in the <K_36> tag ((V7M) K_36/(VAT) K_39 field).

® > Financials > Customer Invoice > Basic Data > Delivery Types Company
Search g
Delivery Type - K% ~ @  Description ¥  Include in Invoice Enclosure *  More * © Favorites  Clear Q, I Sedings
Delivery Types
= W B + =~
Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series 1D
K 36 K_36 (Tax Template Feld VAT _WNT_PAL SIL) =T
K14 K_14 (Tax Template field ART_129_UST) m
K_35 K_35 (Tax Template field VAT_NALEZ_WNT_TRANSP) W

Note: In brackets you can find the name of the field where the value should be connected in the
Audit File Basic Data/SAF-T Poland Setup tab.
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3.5.3.7 Define Tax Sub Group Details

Using IFS Cloud standard functionality, connect new tax codes to existing tax sub groups in the Tax
Group/Sub Groups Details page for sub groups used for Tax Sales (Details) and Tax Purchase
(Details) reports (Tax groups “KRS” and “KRZ” according to STD-PL company template).

If required, connect new delivery types in the same tab.

R R ~
® > Financials > Tax Ledger > Basic Data > Tax Group £

oty w

TaX Group KRS - Classification of Items in Sales Register ¥

KOO =

<+ 4 i B~
Descri... Classification of reversed charg...
KRS
Descrip... Classification of Items in Sale.. e peserpten 2% Group Selection Base

KRS Classification of Items in Sales Register Delivery Type -
KRZ
e . Sub Groups

Descri..  Classification of ltems in Purch...

Sub Group Details
KUE

Descript... Classification for VAT-UE Decl.. LI s e

Currency Code ¥ Sub Group ¥  Tax Code : MPP;23% ] More ¥ © Favorites Clear Q Settings

~ 1 CurencyCode  SubGroup Tax Code Delivery Type Delivery Type Exceptions

: | PN SPRZ-KRAJ-22 - Domestic Sales, VAT 22% and 23% esti % ZLE-DLUGI-VAT-MINUS, ZLE-DLUGI-VAT-PLUS

i PN SPRZ-KRAJ-22-AB3A-U1 - Domestic Sales, VAT 22% and 23 esti... | ZLE-DLUGI-VAT-MINUS...

i |PIN SPRZ-KRAJ-22-A89A-U4 - Domestic Sales, VAT 22% and 23 23 - V) esti.. | ZLE-DLUGI-VAT-PLUS - ...

3.5.4 DEFINE AUDIT FILE BASIC DATA

3.5.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
e Report Type as “SAF-T”
e |f the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

3.5.4.2 Enter Audit File Basic Data

Click Audit File Basic Data command to open the Audit File Basic Data page.

. I . ~
L ] Accounting Rules > Audit Interface > Basic Data > Audit Formats ko

Audit Formats

[~ + & ] & B v Audit File Basic Data Audit File Tax Information Audit File Log

Thousands Negative  Leading
‘J' Country Report Type Decimal Symbol | Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
i | POLAND SAFT -{paint) , lcomma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab SAF-T Poland Setup includes ten sections. For SAF-T V7M report, following sections
are applicable.
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Rules > AuditInterface > BasicData > Audit Formats > AuditFile Basic Data &

Audit File Basic Data

4

HEADER

/7
General Info
Tax Office ID Addr

0202 v Al v
Misc Parameters

MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

Fil
STANDARD AUDIT CODE MAPPINGS EETURRJe] U PEI:338] 4 4 »

General Info section

Tax Office ID — Select from list of values; only values from legal list will be accepted by tax
office.

Misc Parameters section

Person ID — Enter person ID; on list of values there are only persons connected to given
company; The e-mail address and the phone number defined for specified person will be
reported in SAF-T V7M XML file.

Invoice Series for SAD — Enter invoice series from list of values — to be used for customs
documents registration. When SAF-T V7M XML file is created and invoices with series
entered in the Invoice Series for SAD field exist, it is validated if there are any references
in the Ref Invoice No and Ref Supplier ID fields in the Supplier Invoice Details/General
tab. If supplier is different from the one on the invoice, XML file will contain mixed data from
two invoices. In particular supplier data will be fetched from the referred invoice. If supplier is
the same or Ref Invoice No is empty — only data from basic invoice will be reported in XML
file.

Voucher/Delivery Types for Document Types (JPK_V7M) section

WEW — Enter voucher type used in order to follow internal documents.

Sales/RO - Enter voucher type used in order to follow internal summary documents
containing sales from cash registers.

Sales/FP - Enter delivery type used in order to follow invoices issued on the base of fiscal
receipt.

Purchase/MK - Enter delivery type used in order to follow invoices from small suppliers who
selected cash method for VAT.

Delivery Types for Goods and Services (JPK_V7M) section

GTU_O1 - Enter delivery type used in order to follow deliveries of alcoholic beverages.
GTU_02 - Enter delivery type used in order to follow deliveries of petroleum products.
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GTU_03 - Enter delivery type used in order to follow deliveries of heating oil and other oll
products.

GTU_04 - Enter delivery type used in order to follow deliveries of tobacco products.
GTU_O05 - Enter delivery type used in order to follow deliveries of waste.

GTU_O06 - Enter delivery type used in order to follow deliveries of electronic devices.
GTU_07 - Enter delivery type used in order to follow deliveries of vehicles and car parts.
GTU_08 - Enter delivery type used in order to follow deliveries of precious metals and base
metals.

GTU_Q09 - Enter delivery type used in order to follow deliveries of medicines and medical
devices.

GTU_10 - Enter delivery type used in order to follow deliveries of buildings and lands.
GTU_11 - Enter delivery type used in order to follow services in the scope of transferring the
right to emit greenhouse gas.

GTU_12 - Enter delivery type used in order to follow selected intangible services.

GTU_13 - Enter delivery type used in order to follow transport and storage services.

Il‘ ! u\\\

Delivery Types/Customer Groups for Specific Procedures section

(V7M) TP - Enter customer group used in order to follow connections between seller and
buyer.

(V7M) MR_T/(FA) P_106E_2 - Enter delivery type used in order to follow invoices for tourism
services.

(V7M) MR_UZ/(FA) P_106E_3 - Enter delivery type used in order to follow invoices for
secondhand goods and work of art.

(V7M) |_42 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 42.

(V7M) |_63 - Enter delivery type used in order to follow EU delivery after import based on
import procedure 63.

(V7M) B_SPV - Enter delivery type used in order to follow transfer of a single-purpose
voucher made by a taxpayer acting in his own name.

(V7M) B_SPV_DOSTAWA - Enter delivery type used in order to follow supply of goods and
provision of services to which the single-purpose voucher relates to a taxable person who
issued the voucher.

(V7M) B_MPV_PROWIZJA - Enter delivery type used in order to follow provision of brokering
services and other services related to the transfer of multi-purpose voucher.

(V7M) K_14/(VAT) K_14 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_14> tag in the SAF-T V7M XML file.

(V7M) K_35/(VAT) K_38 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_35> tag in the SAF-T V7M XML file.

(V7M) K_36/(VAT) K_39 - Enter delivery type by which a transaction value is retrieved and
reported in the <K_36> tag in the SAF-T V7M XML file.

(V7M) SW - Enter delivery type used in order to follow mail orders.

(V7M) EE - Enter delivery type used in order to follow telecommunication services,
broadcasting and electronic services.

Tax Codes for Specific Procedures section

(V7M) MPP/(FA) P_18A - Enter tax code used in order to follow invoices which are a subject
to the mandatory split payment mechanism.
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3.5.5 CHANGE TO MANUAL FIELDS IN JPK_V7M REPORT

Using IFS Cloud standard functionality, update values in the Automatic Tax Proposal/Template Field
Presentation/Modify Manual Fields as presented below.

@ > Financials > Tax Ledger > Automatic Tax Proposal » Tax Proposal - Template Field Presentation &> company [ AMKA-PLN
oy - a .
"~ Tax Proposal - Template Field Presentation ».vmzzs ~ 1o O —
25

« B v

Description: v7m 2021/6

User ID
@ AMKALK

ax Sum VAT-7/21 Poland (Data for |PK_V7M reporting)

i
Field #1 Visible
v H Template Field #1 in Report Field Field #1 Value
i | VAT ZWROT_BEZP - P_54 Wysokosé nadwyzki podatku naliczoneg  P_54 0.00
| WYBOR_ZWROT_NA_RACH_VAT - P_55 Zwrot na rachunek VAT, o | P_55 -1.00
i WYBOR_ZWROT_VAT_25 - P_56 Zwrot w tarminie, o kedrym mowa  P_56 -1.00
i | WYBOR_ZWROT_VAT_60 - P_57 Zwrot w terminie, o kiérym mowa  P_57 -1.00
i WYBOR_ZWROT_VAT_180 - P_58 Zwrot w terminie, @ ktorym mow  P_58 -1.00
| WYBOR_ZWROT_PRZYSZ_ZOB_VAT - P_59 Zaliczenie zwrotu podat P_59 -1.00
| VAT_PRZENIES - P_62 Wysokost nacwyzki podatku naliczonego n:  P_62 0.00
| WYBOR_ART_119_USTAWY - P_63 Podatnik wykonywat w okresie | P_63 -1.00
| WYBOR_ART_120_USTAWY_UST_4_5 - P_64 Podatnik wykonywat v P_64 -1.00
| WYBOR_ART_122_USTAWY - P_65 Podatnik wykonywat w okresie | P_65 -1.00

For an example, P_63 and P_64 manual fields should be edited as “1” if any invoices for tourism
services or secondhand goods and work of arts exist in the reporting period respectively.

3.5.6 CREATE SAF-T V7M XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
file.

On Task Options in Audit Interface Assistant page, select one of the below options:
Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).

Specify the following and Click Next:
o Company: The company you want to generate SAF-T V7M file.
¢ Country: “Poland”

e Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for
Poland.

Audit Type: “UPK_V7M (1)’

Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
File Type: Select JPK_V7M structure from list of values.

File Template: Will show up automatically after File Type is specified.
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[ ] Accounting Rules » Auditinterface » Audit Interface Asslstant Company  Polish company

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters wm Schedule Schedule Options

Start Option

(@ start now

() schedule

Parameters

Company Country Report Type
MABEPL-PL - Polish company ¥ | POLAND ¥ | | SAF-T -
Audit Type Audit Source Ledger ID

JPK_V7M(1) -
File Type File Template
JPK_VTM - | | JPK_V7M_TEMPLATE -
Selection
Period/Date Range From Unti
() Date 2021 1 2021 1
. Period
b Mext Cancel

On SAF-T PL Additional Parameters in Audit Interface Assistant page specify the Tax Proposal
ID, the VAT-7 proposal ID that was created for the period. Use the list of values to search for the
correct proposal. Click Finish button to generate the SAF-T V7M XML file. The file will be named as
<Audit Type without brackets>_<Time stamp(yyyymmddhhmmss)>. XML

e.g., JPK_V7M1_20200712162006.XML

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O— Task Options —.— SAF-T PL Additional Parameters == Schedule Schedule Options
3-VIM -
4 Previous Finish Cancel

3.5.7 CREATE SAF-T V7M XML CORRECTION FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant to create the SAF-T V7M XML
correction file.

On page 1/3 and 2/3, select the same information as when generating the ordinary file. On page 3/3
specify the proposal identity of VAT-7 correction report and continue in the same way as when
generating the ordinary file. The new XML file will be created. The XML tag <CelZlozenia> will
indicate a correction file with value 2 as follows,

<CelZlozenia poz="P_7">2</CelZlozenia>

If only information in manual fields of VAT-7 was changed comparing to the previous report
o <Deklaracja> block is created in the XML file.
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<Ewidencja> block is not created in the XML file.

If only transaction related information was changed/added comparing to the previous report with no
impact on total amounts in VAT-7

<Deklaracja> block is not created in the XML file.
<Ewidencja> block is created in the XML file and contains final information from all
documents.
For each document changed comparing to the original report, <Ewidencja> block additionally
contains:

o Original information about the document

o Reversal information about the document (with reversed signs in the amount fields)

If both transaction related information is changed and VAT-7 information is changed

<Deklaracja> block is created in the XML file.
<Ewidencja> block is created in the XML file and contains final information from all
documents.
For each document changed comparing to the original report, <Ewidencja> block additionally
contains:

o Original information about the document

o Reversal information about the document (with reversed signs in the amount fields)

DELIMITATIONS

JPK V7K (quarterly variant of JPK_V7M for small companies) is not supported.

Reporting of fiscal registers and invoices based on fiscal registers is not supported.

In case of correction instant invoices for which debit lines are not required, standard
functionality allows to set quantity to 0 (as for CO invoices) or remove the debit lines
completely. Scenario in which debit lines are removed is not supported by JPK_V7M.
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3.6 SAF-T For Poland — VAT Report until September 2020 (JPK_VAT)

3.6.1

SOLUTION — SAF-T PL VAT

The solution is based on IFS Cloud standard functionality of tax reporting including tax transactions
and the corresponding tax proposal and audit interface functionality.

Since 2018 a new schema for this report has been introduced, thus in this document the latest
version, named JPK_VATS3, will be described.

In order to support the requirement for the SAF-T PL VAT report, the following has been done:

1.
2.

3.

New report type SAF-T added to the Audit Formats page.

In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

On Task Options in Audit Interface Assistant page, new Audit Type field has been added
to select relevant SAF-T report. And SAF-T PL Additional Parameters in Audit Interface
Assistant page, Tax Proposal ID field add to specify the tax proposal ID.

In Audit File Log page, a new column Correction Number column has been added.

New external file templates were added to support specific SAF-T reports.

List of values is added for the Reference Number column in New Voucher page when using
the function group M, this is to add additional invoice information for tax transactions.
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Process Overview:

* Tax Office (Standard functionality
« Define Person and e-mail address (Standard functionality)

Define Company « Define delivery types (Standard functionality)

Basic Data

* Enter Audit Format for Poland

* Enter general SAF-T PL data: Tax Office ID, Person ID and Invoice Series for SAD

Define Audit File
Basic Data

* Create VAT-7 report for the company for the SAF-T VAT reporting period (Standard functionality)

Create VAT-7
report

* Enter report type SAF-T and audit type JPK_VAT

(OICEICISTVRIMYZNE - Select file type JPK_VAT_3, template, date / period range and VAT-7 Proposal ID
XML File

» Compare the data of generated SAF-T VAT XML file with Poland VAT-7 report (Manual operation)
Compare SAF-T
VAT XML with
VAT-7 Report

» Manually change the values of fields K_14, K_38 and K_39 in VAT-7 report

« After doing manual changes, there should be no difference in values of SAF-T PL XML and VAT-7 report

Change Values in
VAT-7 Report

» Once all manual modifications are done in VAT-7 report, create the original SAF-T VAT XML file again.

Regenerate SAF-T
VAT XML File

* Run Audit Interface Assistant
« Select country as Poland

Country Solution POLAND 69



Note: VAT-7 report has no direct impact on the SAF-T VAT report. However, the SAF-T VAT report
is used to verify the VAT-7 report content. An additional step to the creation of SAF-T Vat report is
added to compare the results of the two reports. If the results do not match, user need to adjust the

VAT-7 report content manually.

3.6.2 PREREQUISITES

e The company must be set-up to use Polish localization, see the Company Set up chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization functionality is mandatory and

enabled by default.

o VAT-7 report should be created for the reporting period (standard functionality) before the

SAF-T VAT XML is created.

e It is recommended to create the company using Standard Polish Template (STD-PL).

3.6.3 DEFINE COMPANY BASIC DATA

3.6.3.1 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General sub menu, define
Tax Office for Poland — one from the list published on tax authority’s website. For example

‘02027, “10107, “3030” ...

® > Application Base Setup » Enterprise » Tax » Tax Office » =
Search  advanced
Tax Office = Name:PL% ~ @ Creation Date ~ More * & Favorites

sortby v .
Tax Office ox:-pLaxofficenan
0202

MName: PL Tax Office Dan

« + 7 i B B
Address Tax Office
0202

Communication Method

Tax Report Name

PL Tax Office Dan

1of1

Default Language
English
Country
POLAND
Creation Date

8/4/2020

: Settings

G

On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
company ID for the specific tax office. Connect the VAT-7 report that should be compared with the

SAF-T VAT report in the child table.
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® > Application Base Setup » Enterprise > Tax » Tax Office > Tax Report

sortoy

VAT PL

MName: VAT PL

Address
Communication Method

Tax Report &

~

Tax Report VATPL-VATPL ¥  1of1

« 82 v
Tax Office MName
VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + | # ] o]

Company Tax ID Number

AMEKA-PLN

Our Identity
PL 2337684748 123456789

State Name

warminsko-mazurskie

Tax Report Info

= v [ v + 4

Tax Report

VAT-2020 - Vat 2020

VAT7M - VAT7M

3.6.3.2 Define Person E-Mail Communication Method

2,

Electronic Tax ID State Code

varplo W -

On Enterprise/Person/Person page General sub menu define Person ID of person responsible for
JPK_VAT3 reporting. On Communication Method tab enter E-Mail Communication Method and
select Default per Method. Enter valid dates.

@ > Application Base Setup > Enterprise > Person > Person

@ DAALLK &

Full Name: Danushka Alwis
User ID: DAALLK

Address

Communication Method & DAALLK

Documents

Person

. o~
Communication Method &~

Full Name u
Danushka Alwis DAALLK
B~ + rd
Communication
CommID Name Description Method Value
1 Dan E-Mail
2 Dan Phone

3.6.3.3 Define delivery types

dan@ifs.com

+48000000000

validity
Active
Default
per
Default Method
per and
Method  Address ID Address  Validity Period

[ves | B  1/12020-9112029
o o

Using IFS Cloud standard functionality, define separate delivery types to be reported under K_14,
K_38, K_39 fields in SAF-T VAT XML file.
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@ > Financials > Customer Invoice > Basic Data » Delivery Types > Company
Delivery Types
i [~ TP £ =
Include in
Invoice
Delivery Type Description Enclosure  Invoice Enclosure Series ID
EE Telecommunications services, broadcasting and electronic services m
GTU_01 Deliveries of alcoholic beverages m
GTU_02 Deliveries of petroleum products m
GTU 03 Deliveries of heating oil and other oil products m
GTU_04 Deliveries of tobacco products m
GTU_05 Deliveries of waste m
K 14 K_14 (Tax Template field ART_129_UST) m
K 35 K_35 (Tax Template field VAT_NALEZ WNT TRANSP) m W
K 36 K_36 (Tax Template Field VAT_WNT_PAL_SIL) m W
MK Invoices from small suppliers who selected cash method for VAT m

3.6.4 DEFINE AUDIT FILE BASIC DATA

3.6.4.1 Enter Audit Format for Poland

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
o Country as “Poland”
e Report Type as “SAF-T”
e If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

3.6.4.2 Enter Audit File Basic Data
Select Audit File Basic Data command to open the Audit File Basic Data page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats <o company [ AMKA-PLN

Audit Formats

VB v + 7/ ® CHNN. Audit File Basic Data Audit File Tax Information Audit File Log I

. Thousands. Negative  Leading
‘l’ i | Country ReportType  Decimal Symbol  Seperator Format  Zeroes Time Format Date Format File Type File Template 1D Default
i | POLAND SAF-T - (point) , (comma) -9 0.9 1359 Y¥Y-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab: SAF-T Poland Setup includes ten sections. For SAF-T VAT report, the following
sections applicable.

Country Solution POLAND 72



[ ] Accounting Rules

/“ \\NS

\\\\lr
ZIFS

AuditInterface > BasicData > Audit Formats> Audit File Basic Data & Company Polish company

Audit File Basic Data

V4 0]
HEADER STANDARD AUDIT CODE MAPPINGS <«
7 o}
General Info
Tax Office ID Addr
0202 v Al v
Misc Parameters
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

Misc Parameters section

Person ID — specify person ID; on list of values there are only persons connected to given
company; the e-mail address defined for specified person will be reported in SAF-T VAT XML
file. This field is optional.

Invoice Series for SAD — enter invoice series from list of values — to be used for customs
documents registration.

When SAF-T VAT XML is created and invoices with series entered in Invoice Series for SAD
exist, it is validated if there is any Ref Invoice No in Supplier Invoice Details/General. If the
Supplier ID is different there — in XML file lines with supplier invoices with invoice series equal
to Invoice Series for SAD, there will be mixed data from two invoices. If the Supplier ID is the
same or Ref Invoice No is empty — only data from basic invoice will be reported in XML file.

Delivery Types/Customer Groups for Specific Procedures section

3.6.5

(V7M) K_14/(VAT) K_14, (V7M) K_35/(VAT) K_38 and (V7M) K_36/(VAT) K_39 - Enter the
delivery types that should be reported under each field K_14, K_38 and K_39.
If required, you can define more than one delivery type using semicolon as a separator.

CREATE VAT-7 REPORT

Use IFS Cloud standard functionality to generate VAT-7 report for the SAF-T reporting period in the
company. More information on creating VAT-7 report is available in IFS Cloud documentation.

3.6.6

CREATE SAF-T VAT XML FILE

On Task Options in Audit Interface Assistant page, select one of the below options:

Start Now: This option enables user to instantly create an audit file.

Schedule: This option enables user to create an audit output file as a background job. (Refer
IFS Cloud Documentation for more details).
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Specify the following and click Next:
o Company: The company you want to generate SAF-T VAT file.
e Country: “Poland”

o Report Type: “SAF-T” - the value will be prompted per default Audit Formats settings for
Poland.

o Audit Type: “UPK_VAT”
o Period From and Period Until: The year and month range to be covered in SAF-T V7M report.
o File Type: Select JPK_VAT structure from list of values.
o File Template: Will show up automatically after File Type is specified.
® > Accounting Rules > Audit Interface > Audit Interface Assistant Company

Audit Interface Assistant

.= Task Options =O

Start Option

‘Q‘ Start now

() schedule

Parameters

CCIWDEW'.-‘ Coul ntry Report T‘;.-‘DE‘

DAN POLAND - Dan Poland ~ | | POLAND v | SAF-T -
Audit Type Audit Source Ledger ID

JPK_VAT -

File T‘:JDE File Template

JPK VAT 3 v | | JPK_VAT 3 TEMPLATE -
Selection

Period/Date Range From Undil

() Date 2020 8 2020 8
@‘ Period

> Next Cancel

On SAF-T PL Additional Parameters, specify the Tax Proposal ID, the VAT-7 proposal ID that was
created for the period. Use the list of values to search for the correct proposal. Click Finish button to
generate the SAF-T VAT XML file. The file will be named as <Audit Type without brackets>_ <Time
stamp(yyyymmddhhmmss>. XML

e.g., JPK_VAT_20170914150743. XML

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O= Task Options =-.= SAF-T PL Additional Parameters = Schedule Schedule Options

Tax Proposal ID

4-VAT -

4 Previous Finish Cancel
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3.6.7 COMPARE SAF-T VAT XML WITH VAT-7 REPORT

Both the SAF-T VAT and the VAT-7 reports are legal documents relating to the same business
transactions of a company and hence both reports should produce identical data once the reports
are generated.

Due to the current functionality of VAT-7 (Standard) report, it always requires some manual input
from the user to generate the report with correct values. SAF-T VAT XML file is an automatically
generated file which does not require any manual input. When generating the SAF-T VAT file, IFS
Cloud will always crosscheck the values with the corresponding data fields in VAT-7 report. If there
is a difference, IFS Cloud will trigger a warning message. These warning messages can be viewed
in the Audit File Log page.

Audit File Log
[ =

FilelD-1770 ~ @ AuditType ¥ FromDae ~ More ¥ © Favorites Clear O § Semings

FilelD AuditType FromDate  ToDate Timestamp Correction Number  Warning Text

1770 JPK_VAT  ©/1/2019 ©/30/2019  2021-08-16-00:02:22 0 | Tax Proposal ID is not in Reported/Valid status; |

From the Audit Formats page, use the Audit File Log command to open the Audit File Log page.

Audit Formats

r B v + | 7 @ ol B v Audit File Basic Data Audit File Tax Information

Thousands Negative  Leading
¢ | Counuy ReporcType  Decimal Symbol  Seperator Format  Zeroes  Time Format Date Format File Type File Template ID Default

: | POLAND SAFT  (point) , (comma) =) 09 13:59 ¥Y-MM-DD

3.6.8 CHANGE VALUES IN VAT-7 REPORT

Check all the warning messages displayed on Audit File Log. If there are differences related to
manual Fields in VAT-7 report, the values in VAT-7 should be manually updated with values reported
in JPK_VAT3 XML (Automatic Tax Proposal/Template Field Presentation/Modify Manual Fields).

The current functionality of VAT-7 (Standard) report assumes that summarized tax amounts to be
reported in the P_14 tag, P_35 tag and P_36 tag are specified manually by the user. On the other
hand delivery types specified in the (V7M) K_14/(VAT) K_14 field, (V7M) K_35/(VAT) K_38 field and
(V7M) K_36/(VAT) K_39 field in the SAF-T PL Parameters tab are used to select detailed
transactions to be reported with values in the corresponding K_14 tag, K_35 tag and K_36 tag.

In order to make sure that values have been correctly specified manually, IFS Cloud will always
crosscheck the totals of K_14 tags, K_35 tags and K_36 tags with tax template fields from VAT-7
report used to fill P_14 tag, P_35 tag and P_36 tag. If there is a difference, IFS Cloud will trigger a
warning message. These warning messages can be viewed in the Audit File Log page.
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3.6.9 RECREATE SAF-T VAT XML FILE

Once all the manual modifications are done in VAT-7 report, generate SAF-T VAT XML file again
using Audit Interface Assistant. On Audit File Log page, the Correction Number will beset to 0 for
created original SAF-T VAT XML.

@ > Accounting Rules > Audit Interface > Basic Data > Audit Formats > Audit File Log & Company [ AMKA-PLN|
Audit File Log
Correction
FilelD Audit Type = From Date To Date Output File Directory Timestamp /Numher ‘Warning Text
63 JPKIVAT  1/1/2019  1/31/2019 2021-05-18-16:14:30 0 TaxProposal ID is not in
175 JPKVAT | 3/1/2019 | 3/31/2019 2021-06-01-16:31:29 0 | Tax Proposal ID is not in
41 JPKVZM 17172019 1/31/2019 2021-05-14-15:37:13 Tax Proposal ID 2 is not i
42 PKVZM 17172019 1/31/2019 2021-05-14-15:49:39 Tax Proposal ID 2 is not i
83 JPKVZM  2/1/2019 2/28/2019 2021-05-19-14:53:05 Tax Proposal ID 7 is noti
103 JPKVZM  3/1/2019 3/31/2019 2021-05-20-17:43:08 Tax Proposal ID 9 is noti

Note:

By default, the XML file generated using Audit Interface Assistant will be created as Original XML.
The Correction Number will be hence set to 0 in Audit File Log.

Recreate XML File context menu option is available only for Correction Number is not 0. This value
must be changed manually to create correction of SAF-T VAT3 XML. The value of XML tag
<CelZlozenia> (i.e., the option to indicate whether the file is submitted for the first time or if it is an
adjustment of a previously transmitted file) will be copied from Correction Number.

3.6.10 CREATE CORRECTION SAF-T VAT XML FILE

In case if there are errors or issues with SAF-T VAT XML that the company has already submitted
to Polish Tax Office, the company must correct the errors in the file and send the corrected XML
back. It is possible to create multiple corrections - changing the Correction Number to next number,
save and select the Recreate XML File context menu option in Audit File Log. Value of Correction
Number will be copied to <CelZlozenia> tag in SAF-T VAT XML file. Value of this tag cannot be
repeated in one period.

3.6.11 DELIMITATIONS

No known.
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3.7 SAF-T For Poland — Accounting Books (JPK_KR_PD)

3.7.1 SOLUTION — SAF-T PLACCOUNTING BOOKS

JPK_KR_PD file is the Standard Audit File which is a uniform control file for Accounting Books.
This is mandatory to be filed annually from the tax year 2025.

For capital groups and CIT taxpayers whose revenue exceed 50 million Euros in the previous tax
year, the requirement of filing these audit files is mandatory from January 1, 2025. For other
taxpayers, the requirement is mandatory from January 1, 2026.

The solution is based on IFS Cloud standard functionality of Accounting Journal, Turnover and
Balance Report, GL Voucher Rows Analysis, and the Audit Interface functionality.

In order to support the requirement for the SAF-T PL JPK_KR_PD report, the following has been
done:
o In Audit File Basic Data page, a new sub section JPK_KR_PD parameter in SAF-T Poland
Setup has been added to handle JPK_KR_PD specific data.
¢ New Audit Type JPK_KR_PD added to the Audit Interface Assistant.

« Create an Audit Format for Country Poland for Report Type : SAF-T
« Define Code Part Attributes and Connect Attribute Values
« Define Audit File Basic Data under JPK_KR_PD Parameters in SAF-T Poland Setup tab

Define Basic Data

~N
 Enter business Transactions
Enter
Transactions
J
~N
» Update General Ledger
Update GL
J

» Navigate to Audit Interface Assistant

« Select country as "Poland"

« Enter report type SAF-T and audit type JPK_KR_PD
Create » Select date or period range

JPK_KET';D WU . Enable Correction Report toggle when submitting a correction report of JPK_KR_PD file
i
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3.7.2 PREREQUISITES
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The following prerequisites should be satisfied to generate SAF-T PL Accounting Books xml file for

auditing purposes.

e The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.

e |tis recommended to create the company using Standard Polish Template (STD-PL).

¢ All transactions from the period being of subject of XML file must be updated into General
Ledger and Accounting Journal for the same period must be defined and created.

3.7.3 DEFINE COMPANY BASIC DATA

3.7.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the
command View Detailed Address. The following fields must have values:
o Street
e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number
Community
e District

X

Street

Edit Detailed Address

House No Community

‘ |SS!2 ‘ | Krakow

District

| Piaski

OK
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file:///C:/Users/wehelk/Desktop/JPK_KR_PD/Poland%20Country%20Solution%20Document%2024R1%20(PDV-150%20-%202370757%20-%201%20-%20A1)%20-%201%20(2).DOCX%23_Company_Set-up

3.7.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define the
Tax Office for Poland, based on the information published on Polish Tax Authority website. For
example,

“0202”, “1010”, “3030” ...

@ > Application Base Setup > Enterprise > Tax > TaxOffice > TaxReport &

Tax Report
Q Search
sortby ~ « 0202 - Poland Tax office ¥
uTo b :

Name: UK Tax Office

FA Tax Office Name
Name: Finanzamt Erlangen 0202 Poland Tax office
M Company: CRPLLTD - CR Poland Ltd ™~

Name: Bundeszentralamt fur Steuern

Q + @ 7 mw

NL
Name: Tax Office NL
Company CIS Reporting Tax ID Number Our Identity Electronic Tax ID
CRPLLTD \ ) 777777 CR8%654328
AT
Name: Finanzamt Salzburg Account Office Legal Address ID State Code State Name
- -
0202
User Name Password

Name: Poland Tax office

Address

) Tax Report Info
Communication Method

Tax Report & v

4 8 v 24 v

I
<

On the Tax Report submenu, enter values for the Tax ID Number and Our Identity fields after
selecting the relevant company. The field ‘Our Identity’ is used to enter the National Business
Registry Number of the company and will be copied in tag <REGON> in the xml file.

3.7.3.3 Define Journal ID (Standard functionality)

To create the xml file JPK_KR_PD at least one Accounting Journal (General Ledger/Accounting
Journal) must be defined and created.

In case when more than one Accounting Journals are defined all of them must be created
(Accounting Journal/Create Accounting Journals) and information from all journals will be
included in the created JPK_KR_PD file.
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@ > Financials > General Ledger > Accountingjournal > Create Accounting Journals & Company CR Poland Ltd

Create Accounting Journals

Q Search
Y - = Va ] JARRY Create Accounting Journals | Accounting Journals e v 2 v 24~ = v

‘:' Accounting Year  Sort By Sequence Number per
2022 Sequence No Voucher Row
2023 Sequence No Voucher Row
2024 Sequence No Voucher Row

B 2025 Sequence No Voucher Row
2026 Sequence No Voucher Row
2027 Sequence No Voucher Row
2028 Sequence No Voucher Row
2029 Sequence No Voucher Row
2030 Sequence No Voucher Row
2031 Sequence No Voucher Row

3.7.3.4 Define Code Part Attributes and Connect Attribute Values

According to the values published by the Polish Tax Authority for S_12 1, S 12 2, and S_12_3
tags, the user needs to define Code Part Attribute IDs and Attribute Values to map the chart of
accounts.

These three tags are printed under the ‘ZQis section’ of the xml file.

Note: The Appendix section contains values published by the PL Tax Authority for tags S_12_1,
S 12 2,and S_12_3. These values can be manually entered on the Code Part Attributes page or
imported using the data migration option.

In accordance with the JPK_KR_PD schema, the S_12_1 tag is mandatory for the ZOis7 section but
optional for the ZOis8 section. The S_12 2 and S_12_3 tags are optional for both the ZOis7 and
Z0is8 sections.

Note: If the Compliant with IFRS parameter is set to false, the S_12_1 tag must be defined, and
the ZOis7 section is included in the XML file.

Navigate to Accounting Rules/Code String/Code Part Attributes.
Define Code Part Attributes and Attribute Values. Then connect Attribute Values against the relevant
chart of accounts.
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® > AccountingRules > Code String > Code Part Attributes & Company  CR Poland Ltd
Code Part Attributes
Q Search
Y o+ v I} ARV Attribute Value Connect Attribute Copy to Companies 8o~ @~ 24 v =
m Acribute Description Code Part Name
BILANS Bilans Account
RZIS1 Rachunek zyskéw i strat..  Account
5121 5121 (Zois 7) Account
551252 512 2(Zois7) Account
S.12.3 S 12 3(Zois7 &8) Account

Note: The schema published by the Polish Tax Authority includes attribute values with some
lowercase characters. Since the Attributes Value field supports only uppercase characters, users
must specify the correct attribute value to be printed in the xml file using the “< >” symbol in the
Description column. This adjustment is required only for attribute values that contain lowercase
characters. For example:

Attribute value
in IFS Cloud

Attribute value as
per the schema

Description in IFS Cloud Value printed in

xml file

<B6ABIII_ipw_W>
AKTYWA | Aktywa
obrotowe | Inwestycje
krotkoterminowe | Inne
papiery wartosciowe

BBABII_ipw_W BBABII_IPW_W BBABIIL_ipw_W

® > Accounting Rules > Code String > Code Part Attributes > Atrioute Value & Company  CR Poland Ltd
Attribute Value
Q search (1)
s & S121-512.1(0is7) ¥ 1of1
S 121 4L M L ~  ConnectAttribute 2
Description: S_12_1 (Zois 7)
Code Name: Account
Attribute Code Part Name
5_12_1-5_12_1 (Zois 7) Account
Code Part Attribute Values
Y + 7 & v B~y 24v B v
- Auribute Value  Description
BAAINEW | <BAAllTe_W> AKTYWA | Aktywa trwate | Rzeczowe aktywa trwate | Srodki trwate | Inne Srodki trwate
BAAII_W AKTYWA | Aktywa trwate | Rzeczowe aktywa trwate | Srodki trwate w budowie
BPBII3D <BPBII3d> PASYWA | Zobowiazania | rezerwy na zob | via diugoterminowe | Wobec pozostalych jednostek | Zobowiazania wekslowe
BPBINI3H <BPBIII3h> PASYWA | Zobowiazania i rezerwy na zobowiazania | Zobowiazania krétkoterminowe | Wobec pozostatych jednostek | Z tytutu wynagrodzeri
RPEI WYNIKOWE | Koszty dziatalnosci operacyjne] | Amortyzacja
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3.7.3.5 Define JPK_KR_PD Parameters

Navigate to Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data
and define JPK_KR _PD parameters under the SAF-T Poland set-up tab.

® > Accounting Rules > Audit Interface > Basic Data > AuditFormats & Company  CR Poland Lid

Audit Formats

Q Search

v + 7 Iﬁ[ Q ~ Audit File Basic Data | Audit File Tax Information  Audit File Log {@} ~ P? v 24~ B v

Thousands Negstive  Leading File

C) Country Report Type Decimal Symbol Seperator Format Zeroes Time Format Date Format Extension  File Type File Template ID Default

i POLAND SAF-T - (point) , (comma) 9 0.9 1zEs) YY-MM-DD Yes

® > Accounting Rules > Auditinterface > B3 Data > Audit Formats > Auci File Basic D

Audit File Basic Data

/s 0

HEADER  STANDARD AUDIT CODE MAPPING [ELESEC TN 4
Y |

General Info

Tax Office 10 Address 10

0202 - WARSAW -

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

LR SRR SR S SR SRR S SN Y

Inventory Transaction Report Type Mappings

JPK_KR_PD Parameters

Compliant with IFRS 512 512 5123

5121 v 5122 > s123 ~ 5500000 35200.00 25463.00 26987 24

S K6 K7 ks

23654.00 28700.00 296323 8965.77

JPK_ST_KR General Parameters

3.7.4 CREATE SAF-T JPK_KR_PD XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On the Start Option section select Online or Schedule.
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And specify the following:
o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
o Audit Type: “JPK_KR_PD” selected from List of Values.
o Date From and Date Until: The start and end dates of the period to be covered in
SAF-T JPK_KR_PD report (xml can be created for one period or more but only from one year)
or:
e Period From and Period Until: The year and month range to be covered in SAF-T
JPK_KR_PD report.

@ > AccountngRules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters = Schedule Schedule Options

Start Option
(@) Start now
(O)schedule
Parameters
Company * Country * Report Type * Audit Type
CRPLLTD - CR Poland Ltd - ‘ | POLAND - ‘ SAFT - ‘ |JPK,KR,PD -
Audit Source Ledger ID
Selection
Period/Date Range From Unil
O Date 2024 ‘ |1 | ‘2024 ‘ ‘12
(@) Period
4 Pre P Next F Cancel

On SAF-T PL Additional Parameters, enable Correction Report toggle when submitting a correction
report of the JPK_KR_PD file. If enabled, the CelZlozenia tag in the JPK_KR_PD file will be set to 2
indicating a correction report, otherwise CelZlozenia tag will remain as 1, indicating an original
submission of JPK_KR_PD file.

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O— Task Options —.— SAF-T PL Additional Parameters == Schedule Schedule Options

Correction Report

»

4 Previous P Next Finish  Cancel

Click Finish button to generate the JPK_KR_PD XML file.

If the audit file is run in schedule option, the xml can be downloaded from the Batch Processed
Audit Files page.
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Please refer chapter Appendix to view the mapping of IFS data to XML tags.

3.7.5 DELIMITATIONS

None
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3.8 SAF-T For Poland - Fixed Assets and Intangible Assets (JPK_ST_KR)

3.8.1 SOLUTION — SAF-T PL FIXED ASSETS AND INTANGIBLE ASSETS

JPK_ST_KR file is the Standard Audit File for Fixed Assets which is a uniform control file for the
records of fixed assets and intangible assets. This is mandatory to be filed annually from the tax
year 2026.

For capital groups, CIT taxpayers, and others whose revenue exceeded 50 million Euros in the
previous tax year, the requirement of filing these audit files is mandatory from January 1, 2026.

The solution is based on the IFS Cloud standard functionality of Fixed Assets and the Audit
Interface functionality.

wa

‘Naglowek

JPK |-
(:)EI_— tn=:Podmiot1 [

ST_KR
1.0

| L

I
1
o

In order to support the requirement for the SAF-T PL JPK_ST_KR report, the following has been
done:

¢ Object class change details log introduced on the server side to record any Object Class
change done on the Fixed Asset Object page.

¢ Inthe Object Classes page, a new column Tax Depreciation Rate has been added to add
the annual tax depreciation rate for each object class.

¢ Inthe Audit File Basic Data page, new sub-sections in SAF-T Poland Setup have been
added to handle JPK_ST_KR specific data.

o New Audit Type JPK_ST_KR added to the Audit Interface Assistant.
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Define a Code String for FA Accounting Code Part Function
Def Enable Write Method Change Log parameter in Company/Fixed Assets/Depreciation Parameters section.
Corig;y Define Tax Depreciation Rate in Object Classes page
Etda o Define Fixed Asset Property Codes to add OT and LT numbers )
~
Create an Audit Format for Country Poland for Report Type : SAF-T
Enter Audit File Basic Data: Tax Office ID and Address ID
DL SWANIG[IM Define sections provided for JPK_ST_KR in SAF-T Poland Setup tab
Basic Data
J
~
Enter Fixed Asset and Intangible Asset related transactions
Enter
Transactions y
~
Update General Ledger
Update GL
J
Navigate to Audit Interface Assistant )
Select country as "Poland"
Creat Enter report type SAF-T and audit type JPK_ST_KR
JPK rg?reKR Select date or period range
XML File Enable Correction Report toggle when submitting a correction report of JPK_ST_KR file )

ZIFS

Define Tax Office (Standard Functionality) )

3.8.2 PREREQUISITES

The following prerequisites should be satisfied to generate SAF-T PL Fixed Assets and Intangible
Assets xml file for auditing purposes.

The company must be set up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by
default.

It is recommended to create the company using Standard Polish Template (STD-PL).

It is required to have a code part defined for the FA Accounting Code Part Function.

All fixed assets transactions of the selected period of XML file must be updated into
General Ledger.

The following filters were applied to recognize the fixed asset objects that should be printed in the
JPK_ST_KR file for a given period.

JPK_ST_KR file should include all the assets in the fixed asset ledger that are of “Normal”
and “Right-of-Use” object types. However, ROU Assets created via Operating Lease Type
will be excluded from the XML file.

Assets acquired during the reporting period are accurately identified by verifying the event
date of their initial acquisition transaction.

When generating the JPK_ST_KR file for a specific financial year, assets disposed before
the "From Date" or the initial reporting date will be excluded.

Example: when the file is ordered for the financial period 01.01.2025 till 12.31.2025, the fixed assets
disposed prior to 01.01.2025 will not be included.
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o Fixed asset objects in the Registered, Import, and Investment states will be excluded from
the XML file.

3.8.3 DEFINE COMPANY BASIC DATA
3.8.3.1 Define Company Address Details (Standard Functionality)
Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the

command View Detailed Address. The following fields must have values:
e Street

e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number

¢ Community
District

x Edit Detailed Address

Street House No ‘Communi ity

Street 1 ‘ ‘ 536/78 ‘ ‘ Communi ity 1

District 1 ‘

3.8.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/ Tax Office page. On the General tab, define the Tax
Office for Poland, based on the information published on the Polish Tax Authority website. For
example,

“0202”, “10107, “3030” ...
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@ > Application Base Sewp > Encerprise > Tax >

Tax Report
Q Search (1)

Sortby «

0202

Name: Poland Tax office
Address

Communication Method

Tax Report &

Tax Office > TaxReport &

« 0202 - Poland Tax office ¥ 1of1

o

Tax Office

0202

Company: STDPOLAND - STDPOLAND Co ¥

a + @ 7 m

Company

STDPOLAND

Account Office

User Name

CIS Reporting

Name

Poland Tax office

Tax ID Number

123-555-3333-1

Legal Address ID

Password

Our Identity

11223344

State Code

Electronic Tax

D

State Name

On the Tax Report submenu, enter values for the Tax ID Number and Our Identity fields after
selecting the relevant company. The field ‘Our Identity’ is used to enter the National Business
Registry Number of the company and will be copied in tag <REGON> in the xml file.

3.8.3.3 Define Write Method Change Log (Standard functionality)

Depreciation method change information will be generated by the system when information relevant
to depreciation calculation is modified in the Books tab of the Fixed Asset Object page when this
option is enabled in Application Base Setup/Enterprise/Company/Company/Fixed Assets sub-

menu.

Fixed Assets

QSearch (1) Advanced

STDPOLAND

Name: STDPOLAND Co
Address
Communication Method
Message Setup
Emplayees

Accounting Rules

Tax Control

Invoice

Payment

Fixed Assets 3

Periodical Cost Allacation

Supply Chain Information
Localization Control Center

Show less

Company: STOPOLAND ~

Name ¥

HULK

AssociationNo ¥  More ¥ C

Acquisition Parameters

Inventory Parameters

ysical Laca

tion Mandatary

w Clesy

Depreciation Parameters
[ @

Saved Searches

Whenever the Depreciation Method is changed in the Books tab for the Fixed Asset Book for Tax
Depreciation, the Tax Depreciation Mapping value for Old Value will be reflected in E_9 1 tag and
the Tax Depreciation Mapping value for New Value will be reflected in the E_9 2 tag respectively.
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@ > Financials > Fixed Assets > Reconciliation/Year-end > Depreciation Method Change Details & Company STDPOLAND Co

Depreciation Method Change Details

Q Search
Y Cleanup of Depreciation Method Change Details & v RBv 24v @V
- Book Object Date Changed User Column Name OldValue NewValue
PODATEK - Tax Depreciation CM1 - Change method 11/28/24,12:57 PM ML MANLLK| METHODID LINIOWA211/2PNO LINIOWA20PODATK

3.8.3.4 Define Tax Depreciation Rate in Object Classes

The Classification of Fixed Assets is used in statistical reporting and in the accounting records of
fixed assets. The Classification of Fixed Assets (KST) was introduced by the regulation of the Council
of Ministers on 10 December 2010 (Journal of Laws No. 242, item 1622).

The KST Classification codes should be defined in the Financials/Fixed Assets/Object Basic
Data/Object Classes page and then defined in the Financials/Fixed Assets/Fixed Asset Object
page in the Object Class field. The classification defined in the field will be printed in the E_8 tag.

® > Financials > Fixed Assets > Fixed Asset Object & Company  STDPOLAND C(
Fixed Asset Object
Q Search (1) Advanced 5
Status ¥  Object: ML1 ¥ X  Description ¥  Object Group ¥ ObjectType ¥ More ¥ O Favorites Clear Saved Searches ~
Sortby = .
« ML1-Object1 ¥ 1of1 Scrapped CEEE—
ML1 ol \ i Ir = vl
aF s [ii] Q. View Hold Information ObjectInventory ~  Other
Description: Object 1
Object Description Replaced/split Object
ML1 Object 1
Object Type *
Normal -
@ USER DEFINED BASE VALUES ~ BOOKS PREPOSTING  INVENTORY ~ PROPERTIES  DISPOSAL RENTAL ASSETS 4« »
General Details
Object Group * Valid * Object Class
7 - Vehicles w  1/1/2024-12/31/2049 774-741 - Cars -
Supplier Object Owner External ID
-
Attributes Notes Rotable Pool Object

In Poland, the tax depreciation rates are specified in the "Wykaz rocznych stawek
amortyzacyjnych," a schedule issued by the Ministry of Finance. These rates indicate the annual
percentage at which different types of fixed assets can be depreciated for tax purposes. Each tax
rate corresponds to KST.

Hence, the Tax Depreciation Rate column in the Financials/Fixed Assets/Object Basic
Data/Object Classes page is given to define the rates issued by the tax authority. This field is
controlled by the Poland Localization. The rate defined here will be printed in E_10A tag.
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® > Financials > Fixed Assets > Object Basic Data > Object Classes & Company STDPOLAND Cq
Object Classes
Q Search
Y o+ Vi 8 v B~ 24~ B\~
v Object Class Description Tax Depreciation Rate
001-010 Agricultural lands
002-020 Farests
007-070 Water regions 2.856
110101 Industry buildings 25512
110-105 Office buildings 2.56
220-201 Power-stations 45
222-221 Railway lines 10
331-311 Steam boilers 7
334-349 Nuclear reactors 14
441-415 Grinding machines 14

Note: When the actual depreciation factor is different than the Tax Depreciation Rate given for an
object, the E_11 tag will be printed. It is taken from the Fixed Assets/Depreciation Basic
Data/Depreciation Method/Factor% field. For instance, if the factor exceeds 100%, such as a
1200% rate for recording a one-time depreciation, the E_11 and E_25A tags will display the value
100.

3.8.3.5 Define Fixed Asset Properties

In the E_5 tag, it is required to specify the document number (OT) based on which the fixed asset or
intangible asset was introduced. Similarly, it is required to specify the number (LT) of the document
confirming deletion from the register in the E_30 tag.

To record these OT and LT numbers, you can use the existing functionality of Fixed Asset Property
Codes. Property Codes by names OT and LT should be defined in the Financials/Fixed
Assets/Object Basic Data/Fixed Assets Property Codes page with Data Type String.

@ > Financials > Fixed Assets > Object SasicData > Fixed Assets Property Codes C Company  STDPOLAND Co

Fixed Assets Property Codes

Q Search

® > Financlals > Fixed Assets > FixedAssetObject [ company  STDPOLAND Co

Fixed Asset Object

Qsearch (1) Advanced :
Saws:Sold ¥ X Object ¥  Description ¥  ObjectGroup ¥ ObjectType ¥  More ¥ @ Faverites Clear SavedSearches
o « SALE-Sold object ¥ 1of1 Sold e—
SAlE + V2 AN View Hold Information  Object Inventory ~  Other Q

Description: Sold object

Object Description Replaced/Split Object Object Type
SALE Sold object Normal -
GENERAL USER DEFINED BASE VALUES  BOOKS PREPOSTING  INVENTORY DISPOSAL RENTAL ASSETS 4 »
¥ + /  AddProperty Codes from Template S By 24v =v
property cod_ Suring value Number value Datevalue  Value Description Reference
:  OT-OT Document 7896
: LT-LTDocument 2023001
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3.8.3.6 Object Class Changes
It is required to print 1 (Yes) and 2 (No) respectively in the E_32 tag if a change is done in the KST

classification shown in the Object Class on Fixed Asset Object page. Therefore, a server-side
implementation was done to record the changes.

3.8.4 DEFINE AUDIT BASIC DATA

Navigate to Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data and
define JPK_ST_KR basic data under the SAF-T Poland Setup tab.

® > Accounting Rules » Auditinterface > BasicData > AudicFormats &% company  STDPOLAND Ca
Audit Formats
Q Search
v o+ / W 4 - || AuditFile Basic Data [Rudit File Tax Information | Audit File Log S v By 24y B
e
country Repert Type Decimal symool Time Format Date Format Extension  Flle Type File Template 1D Default
H POLAND SAF-T (point) . (comma) 9 09 13:59 YY-MM-DD

3.8.4.1 Define JPK_ST_KR General Parameter

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR General Parameters, define the fixed asset book used to record depreciation
for tax purposes in Fixed Asset Book for Tax Depreciation field and define the fixed asset book
used to record depreciation for internal accounting purposes in Fixed Asset Book for Accounting
Depreciation field.

Based on business practice, users can connect different fixed asset books or the same book in these
fields.

@ > AccountngRules > Audit Interface > BasicData > AuditFormats > AuditFlle Sasic Data > Company  STDPOLAND Col

Audit File Basic Data

s o

HEADER STANDARD AUDIT CODE MAPPING [ETNRR TN o

7 W
General Info
Misc Parameters
Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)
Delivery Type for Delivery Goods and Services
Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures
Invoice Type Mappings
SAF-T PL Inventory Transaction Report Types

Inventory Transaction Report Type Mappings

< < < KK K< <K

JPK_KR_PD Parameters
JPK_ST_KR General Parameters
Fixed Asset Book for Tax Depreciation Fixed Asset Book for Accounting Deprediation

PODATEK - Tax Depreciation ~  BILANS - Balance Depreciation -

JPK_ST_KR Intangible Object Groups
JPK_ST_KR Acquisition Reason Mapping

JPK_ST_KR Disposal Reason Mapping

< < <K

JPK_ST_KR Tax Depreciation Mapping
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3.8.4.2 Define Intangible Object Groups

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Intangible Object Groups, define the object groups that will be used to create
Intangible Assets in the Fixed Asset Object page.

This is required to identify which tag E_2 or E_3 to be printed to show the date of acquisition/creation
of a fixed asset in the JPK_ST_KR file.

@ > Accounting Rules > Audit Interfoce > Basic Data > AuditFormats » Audlt Flle Basic Dotz &2 Company  STDPOLAND C

Audit File Basic Data

|

HEADER STANDARD AUDIT CODE MAPPING »
IC}

General Info v
Misc Parameters v
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures “
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings ~
JPK_KR_PD Parameters v
JPK_ST_KR General Parameters v
JPK_ST_KR Intangible Object Groups

Y o+ ® 4~ (B~

- Other | I

3.8.4.3 Define Acquisition Reason Mapping

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Acquisition Reason Mapping, define the following.

e Transaction Reason (Acquisition Type) - Transaction reason applicable for the acquisition or
the acquisition value adjustment of a fixed asset object.

o Document Type - Select the type of document confirming the acquisition of the asset,
provided by the Poland Tax Authority which should be mapped to an acquisition reason in
IFS Cloud Transaction Reasons. This will be printed in the E_6 tag.

Document Type Description

Sales Agreement
Donation Agreement
Non-cash contribution
Production/Manufacturing
VAT invoice

Other

—|mis|z|o|n

Country Solution POLAND 92



(dI\S

\\\\',,
=" IFS

¢ Qualifying Reason - Select the option if, the Transaction Reasons are qualifying for tax and
accounting initial value changes of assets according to Article 15(5) and Article 31(3) of the
Corporate Income Tax Act in Poland. This will affect E_13 to E_15 tags for the Tax
Depreciation Book and E_22 to E_24 tags for the Accounting Depreciation Book.

® > Accounting Rules > Auditinterface » Basic Data » Audit Formats > AUdITFIle BasicData company  STDPOLAND ¢4

Audit File Basic Data

Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

Inventory Transaction Report Type Mappings
JPK_KR_PD Parameters

JPK_ST_KR General Parameters

< K< KK KK <K

JPK_ST_KR Intangible Object Groups

JPK_ST_KR Acquisition Reason Mapping

F - VAT invoice Yes

W - Production/Manufacturing

D - Donation Agreement

D - Donation Agreement

S - Sales Agreement

I-Other

N - Non-cash contribution

i ZAKUP - Purchase S - Sales Agreement

60eEO6EAE6:

3.8.4.4 Define Disposal Reason Mapping

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Disposal Reason Mapping, define the following.

e Transaction Reason (Disposal Type) - Transaction reason applicable for the disposal of a
fixed asset object.

o Document Type - Select the type of document confirming the disposal of the asset, provided
by the Poland Tax Authority which should be mapped to a disposal reason in IFS Cloud
Transaction Reasons. This will be reflected in the E_29 tag.

Document Type Description

Reclassification to another asset group
Sale

Identification of shortage

Theft

Donation

Non-cash contribution

Other

Z|O|X|X|»n|>
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® > AccountngRules > Auditinterface » Basic Data > AuditFormats > AuditFile Basic Data <

Audit File Basic Data

JPK_ST_KR Disposal Reason Mapping

Document Type

Construction of new buildings K-Theft

D - Donation

|- Other

X - Identification of shortage

WKOWY - Cash Discount A~ Reclassification to another asset Eroup
I WNIP - Write Off of intangible fixed assers N - Non-cash contribution
i WYCOFANIE - Withraw object from using 5-Sale

3.8.4.5 Define Tax Depreciation Mapping

In Accounting Rules/Audit Interface/Basic Data/Audit Formats/Audit File Basic Data/SAF-T Poland
Setup/JPK_ST_KR Tax Depreciation Mapping, define the following.

Company

STDPOLAND (]

Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services ~
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings ~
SAF-T PL Inventory Transaction Report Types ~
Inventory Transaction Report Type Mappings v
JPK_KR_PD Parameters ~
JPK_ST_KR General Parameters ~
JPK_ST_KR Intangible Object Groups v
JPK_ST_KR Acquisition Reasan Mapping v

o Depreciation Method — Identity of the depreciation method.

o Tax Depreciation Method - Select the Tax Depreciation Method, provided by the Poland Tax
Authority which should be mapped to IFS Cloud Depreciation Method. This is reflected in
E_ 9 1and E_9 2 tags.

Tax Depreciation Method Description

D Declining Balance
L Straight-line

J One-time

I Other

X No depreciation

o Frequency of Depreciation - Select the Frequency of depreciation, provided by the Poland
Tax Authority which should be mapped to IFS Cloud Depreciation Methods. This is reflected
in E_17 tags.
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Frequency

Description

Monthly

Quarterly

Annual

One-time

Seasonal

— <O IRIZ

Other

No deduction

@ > Accounting Rules > Audlt Interface > BasicData > Audit Formats > Audt File Sa:

Audit File Basic Data

company  STDPOLAND C

Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventery Transaction Report Type Mappings ~
JPK_KR_PD Parameters v
JPK_ST_KR General Parameters v
JPK_ST_KR Intangible Object Groups v
JPK_ST_KR Acquisition Reasan Mapping
JPK_ST_KR Disposal Reason Mapping
JPK_ST_KR Tax Depreciation Mapping
v o+ o @v By u-[BY
Depreciation Metnod Tax Depreciation Metnod Frequency of Deprediation
i DEGR14PO - Decline, 14%-ratio2, beginning of period D - Declining Balance M- Monthly
:  DEGR17PNO - Decline, 17%, beg.of next period D - Declining Balance M- Monthly
LINIOWA20PODATK - Straight Line, 20% from tax base value L- Straight-line M- Monthly
PNO - Straight Line next period L - Straight-line M- Monthly
NIO ight Line, 30%, beg.of ne: L- Straight-line M- Monthly
Straight Line 7%, beginning of period L- Straight-line R- Annual
- Rem/alue/RemManths - Other 1-Other
NIO T Line/onetime depreciation J-One-time |- One-time
INIOWAQDPIS1 - Str.Line/onetime depreciation J-One-time |- One-time
NA - Str Line/adjust fact, beginning of period L - Straight-line K- Quarterly
SOYD3 - Sum of year digits - 3 years X - No depreciation X - No deduction

3.8.5 CREATE SAF-T JPK_ST_KR XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On the Start Option section select Online or Schedule.

And specify the following:

Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.

Audit Type: “JPK_ST_KR” selected from List of Values.

Date From and Date Until: The start and end dates of the period to be covered in

SAF-T JPK_ST_KR report or:

Period From and Period Until: The year and month range to be covered in the SAF-T
JPK_ST KR report.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.— Task Options —O— SAF-T PL Additional Parameters == Schedule Schedule Options

Start Option

(®) Start now

(O)Schedule

Parameters

Company * Country * Report Type * Audit Type
‘ STDPOLAND - STDPOLAND Co - ‘ | POLAND v | |SART - ‘ |JPK,5T,KR -
Audit Source Ledger ID
Selection
Period/Date Range From Unil
(O Date 2026 ‘ |1 ‘ |2026 ‘ |12
(®) Period
4 Previous P Next Finish = Cancel

On SAF-T PL Additional Parameters, enable Correction Report toggle when submitting a correction
report of the JPK_ST_KR file. If enabled, the CelZlozenia tag in the JPK_ST_KR file will be set to 2
indicating a correction report, otherwise CelZlozenia tag will remain as 1, indicating an original
submission of JPK_ST_KR file.

@ > Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

O— Task Options —’— SAF-T PL Additional Parameters = Schedule Schedule Options

Correction Report

a»

4 Previous P Next  Finish  Cancel

Click Finish button to generate the JPK_ST_KR XML file.

If the audit file is run in schedule option, the xml can be downloaded from the Batch Processed
Audit Files page.

Please refer chapter Appendix to view the mapping of IFS data to XML tags.

3.8.6 DELIMITATIONS

None
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3.9 SAF-T For Poland - Inventory Report (JPK_MAG)

3.9.1

SOLUTION — SAF-T PL INVENTORY

The solution is based on Audit Interface functionality in standard IFS Cloud.

In order to support the requirement for the SAF-T PL Inventory report, the following has been done:

1.
2.

3.

3.9.2

Def'B‘;gaS'c » Connect inventory transaction codes to report types (Standard functionality)

\
»Update the General Ledger after entering invoices relating to inventory
[ EICNEIRENTe] * Fetch tax ledger information.
Fetch Tax
Ledger Info J
*Run Audit Interface Assistant (Standard functionality) A
« Specify Report Type, Audit Type
« Specify File Type
Create XML file -Spec!fy Dgte From - Date Until or Period Frorm - Period Until
* Specify Site, Warehouse )

3.9.3

New report type SAF-T added to the Audit Formats page.

In Audit File Basic Data page, a new tab SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

Task Options in Audit Interface Assistant page, new field Audit Type has been added to
select relevant SAF-T report. In SAF-T PL Additional Parameters, additional fields specific
for the SAF-T MAG have been added.

New external file templates were added to support specific SAF-T reports.

PROCESS OVERVIEW

*Define Company Address Details (Standard functionality)
* Define Tax Office (Standard functionality)
 Define Inventory Transaction Report Types (Standard functionality)

* Enter Audit Format for Poland
» Enter general SAF-T PL data - Tax Office ID, Address ID and Journal ID

DI EVAUG[M - Map inventory transaction report types to SAF-T PL inventory transaction report types
File Basic Data

PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Inventory xml file for
auditing purposes.

The company must be set-up to use Polish localization, see the Company Set up chapter.
The functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by
default.

It is recommended to create the company using Standard Polish Template (STD-PL).
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3.9.4 DEFINE BASIC DATA

3.9.4.1 Define Company Address Details

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu use Edit
Detailed Address command button. The following fields must have values:
o Street

e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number

e Community

e District

X Edit Detailed Address

Straet House No Community

Lopuszanksal 123 Okecie

District

Wiochy

oK Cancel

3.9.4.2 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On General tab define Tax Office
for Poland — one from the list published on tax authority’s website. For example
“0202”, “10107, “3030” ...

® > Application Base Setup » Enterprise » Tax » Tax Office » =
Search  advanced B
Tax Office * Name:PL% ~ @ Creation Date ¥ More ¥ O Favorites  Clear Q Settings

sorty -

Tax Office ozoz-ritsxofficenan v 101

0202
&« + m B B~ ]
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English -
Tax Report Name Country
PL Tax Office Dan POLAND A

Creation Date

8/4/2020
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On the Tax Report sub menu connect the company, relevant tax ID number and specify our identity.
Our identity is company ID for the specific tax office.

@ > Application Base Setup > Enterprise > Tax > Tax Office » Tax Report =

Sort by

Tax Repo Ft varpL-vareL ¥ 10f1
VATPL

&« B v
MName: VAT PL
Address
Communication Method Tax Office Mame
Tax Report VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + I m B
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMEA-PLN PL 2337684748 123456789 varplol WN -

State Name

warminsko-mazurskie

Tax Report Info

= Nl [~ + i
Tax Report
VAT-2020 - Vat 2020

VAT7M - VAT7M

3.9.4.3 Define Inventory Transaction Report Types

Go to the Inventory/Transaction History/Report/inventory Transaction Report Basic Data
page. On the Report Types tab define report types used for inventory transactions.

= @ > warehouse Management > Transaction History > Report > Inventory Transaction Report Basic Data

Search  Asvanced ¥

Company ¥ More ¥ O Favorites  Clear Q Settings

Inventory Transaction Report Basic Data oanroiano ~

> &g v Copy To Company o
CG\“TDBH:.'
DAN POLAND

e limai 3 REPORT GROUPS =~ REPORT TYPE FOR TRANSACTION CODES = REPORT TYPE NUMBER SERIES

4 »
=Y B v t 4 Translation = v
Report
Type
v i ReportType Report Type Description Direction

s Consignment Stock

Pz External Receipt +

RT-INVM-COIN RT-.INVM-COIN +
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On Report Type For Transaction Codes tab, connect the defined report types to the transaction
codes. All inventory transactions to be considered in JPK_MAG report should be assigned to one of
defined report types. Note: internal transfer must be reported in one type “MM” in JPK_MAG XML,
while in IFS Cloud it is handled with two transactions (issue and receipt) — so only issue transaction
should be mapped (to report type “MM-).

= @ > warehouse Management > Transaction History > Report » Inventory Transaction Report Basic Data

Search  advanced ¥
Company ¥  More ¥ © Favorites  Clear Q i Sett ngs
Inventory Transaction Report Basic Data oavroiano ~
» B v Copy To Company Q
Company
DAN POLAND
REPORT TYPES ~ REPORT GROUPS REPORT TYPE NUMBER SERIES 4
= vV B v s = v
v i Transaction Code Direction Report Type
INVM-IN - Internal Transf + RT-.INVM-IN - RT-.INVM-II
INVM-ISS - Internal Trans - RT-.INVM-ISS - RT-.INVM-
INVM-COIN - Inter Site Tr + RT-.INVM-COIN - RT-.INV?
INVM-OUT - Inter Site Tre - RT-.INVM-OUT - RT-INVIV

3.9.5 DEFINE AUDIT FORMAT BASIC DATA

Go to Accounting Rules/Audit Interface/Basic Data /Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:

o Select the Country as “Poland”,

o Report Type as “SAF-T”

e If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed
Audit Files page.

Select the Audit File Basic Data command to open the Audit File Basic Data page.

® > Accounting Rules > Audit Interface > Basic Data > Audit Formats &2 company
Audit Formats

Audit File Tax Information  Audit File Log iz

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page.
The new tab: SAF-T Poland Setup includes ten sections.

For SAF-T Inventory report below sections are applicable:

e General Info
e SAF-T PL Inventory Transaction Report Types
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e Inventory Transaction Report Type Mappings

General Info
On SAF-T Poland Setup tab General Info section applicable to all SAF-T report types are entered.

To generate JPK_MAG xml file, General Info group fields must have values:
o Tax Office ID - Select from list of values; only values from legal list will be accepted by tax
office.

e Address ID - Specify company address ID. The address should be defined with all details.

® > AccountingRules > AuditInterface > BasicData > AuditFormats> Audit File BasicData & Company  Polish company

Audit File Basic Data

7 o
HEADER STANDARD AUDIT CODE MAPPINGS 4 »
7 o]
General Info
Tax Office ID Address ID
0202 v Al v
Misc Parameters
Person ID Invoice Series for SAD
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services N/
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v
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SAF-T PL Inventory Transaction Report Types Section

SAF-T PL Inventory Transaction Report Types section contains a list of inventory transaction report
types required by JPK_MAG to be reported in xml file in relevant blocks with their English description.

® > AccountingRules > AuditInterface > BasicData > Audit Formats > Audit File Basic Data &3 Company  Polish company

Audit File Basic Data

7 o
HEADER STANDARD AUDIT CODE MAPPINGS <« >
0|
General Info v
Misc Parameters v
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures %
Invoice Type Mappings v
SAF-T PL Inventery Transaction Report Types
= A4 B ~ 24 ~ = %
JPK Inventory Report Type Description
MM Inventory Movement
PZ External Reciept
RW Internal Issue
WZ External Issue
Inventory Transaction Report Type Mappings g

Inventory Transaction Report Type Mappings Section

On the Inventory Transaction Report Type Mappings section, all inventory transaction report types
to be reported in JPK_MAG, should be connected to one of SAF-T PL report types. SAF-T report
types are listed on the SAF-T PL Inventory Transaction Report Types section. The mapping should
be done for required inventory transaction report types, defined in IFS Cloud in the Inventory
Transaction Report Basic Data page. Hence IFS Cloud inventory transaction report types should
be mapped against the SAF-T inventory transaction report types with correct direction.
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[ ] Accounting Rules > AuditInterface > Baslc Data > AuditFormats > AuditFlle Basic Data £

Audit File Basic Data

ra [
HEADER STANDARD AUDIT CODE MAPPINGS LT Ey W1 RSV

General Info

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M}
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

Inventory Transaction Repert Type Mappings
AT A +

SAF-TPL Inventory Transaction  INVentory Transaction Report
Report Type Type Direction

MM s

Pz Pz

Pz RT-INVIM-COIN

MM RT-INVI-IN 0
MM RT-INVIM-I55 0

WSS

R,
S Es

With this mapping, the user can specify which inventory transaction reports with assigned
transactions will be reported in JPK_MAG xml file and in which block PZ, WZ, RW or MM.
The data from mapped transactions, quantity and value, will be reported with specified sign assigned

to SAF-T PL Inventory Transaction Report Type in Direction.

“0” direction should be assigned to “MM” SAF-T PL Inventory Transaction Report Type, so that “MM”

report type will show both the source and destination.

3.9.6 CREATE SAF-T INVENTORY (JPK_MAG) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:

o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for

Poland
o Audit Type: “UPK_MAG”

e Date From and Date Until: The start and end dates of the period to be covered in

SAF-T MAG report or:

e Period From and Period Until: The year and month range to be covered in SAF-T MAG report.
o File Type: select the file type for JPK_MAG xml structure from List Of Values. To have

Inventory transactions correctly reported in xml file, “JPK_MAG” file type must be selected.
¢ File Template will show up automatically after File Type is specified.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =Q= SAF-T PL Additional Parameters == Schedule Schedule Options

Start Option

(C) Start now

() schedule
Parameters
Company Country Report Type

DAN POLAND - Dan Poland ¥ | POLAND v | SAF-T -
Audit Type Audit Source Ledger ID

JPK_MAG -
File Type File Template

JPK_MAG v | | JPK_MAG_TEMPLATE -
Selection
Period/Date Range From until
(O bate 2020 8 2020 8
@' Period

4 Previous » Next Finish Cancel

On SAF-T PL Additional Parameters specify:
¢ Site — enter one of the sites connected to the company — use list of values.
e Warehouse — enter a warehouse connected to the selected site — use list of values. Enter %
to include all warehouses connected to site in the report.

Click Finish button to generate the SAF-T Inventory XML file. The file will be named as:
<Audit Type without brackets>_<Time stamp(yyyymmddhhmmss>.XML

e.g., JPK_MAG_20170914154614. XML

The generated XML file must be submitted to Polish Tax Office.

{3 Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

O= Task Options =.= SAF-T PL Additional Parameters = Schedule Schedule Options

Site Warehouse
PL * | PL hd
4 Previous » Next Finish Cancel

3.9.7 DELIMITATION

No known.
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3.10 SAF-T For Poland - VAT Invoices Report (JPK_FA)

3.10.1 SOLUTION — SAF-T PL VAT INVOICES

The solution is based on Audit Interface functionality in IFS Cloud core.

In order to support the requirement for the SAF-T PL VAT Invoices report, the following has been

done:

1.
2.

3.

4.

New report type SAF-T added to the Audit Formats page.

On the Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has
been added to handle SAF-T Poland specific data.

Task Options in Audit Interface Assistant page, new field, Audit Type, has been added to
select relevant SAF-T report. In SAF-T Additional Parameters, additional fields specific for
the SAF-T VAT Invoices report (JPK_FA) have been added.

New external file template is added.

Process Overview

» Define Company Address Details )
« Define Tax Office
« Define Delivery Types
: : « Define Invoice Texts
BLIYCREEEIABEICY . Define Correction Reasons
J
\
« Enter Delivery Types for Specific Procedures
» Connect Customer Invoice Types
Define Audit
Format Basic Data
J
)
» Update the general ledger after entering customer invoices
U[eTeEICHENEIEI « Fetch tax ledger information
Ledger and Fetch
Tax Ledger
Information J
] , N\
* Run Audit Interface Assistant
« Specify report Type, Audit Type
* Specify File Type
: * Specify Date From - Date Until or Period From - Period Until
CCEICDAIRIER . Specify Currency, Selection Date )

3.10.2 PREREQUISITES

The company must be set-up to use Polish localization, see the Company Setup chapter.
The “Standard Audit File-Tax for Poland (JPK)” localization parameter is mandatory and
enabled by default.
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It is recommended to create the company using Standard Polish Template (STD-PL).
e ltis recommended to use “Prepayment Based Invoice” as Method For Invoicing Prepayment
in company setup.

3.10.3 DEFINE BASIC DATA

3.10.3.1 Define Company Address Details

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu click the
View Detailed Address. The following fields must have values:
e Street
e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number
¢ Community

District
X Edit Detailed Address
Street House No Community
Lopuszanksa| 123 Okecle
District
Wiochy
oK Cancel

3.10.3.2 Define Tax Office

Open the Application Base Setup/Enterprise/Tax Office page. On the General section define Tax
Office for Poland — one from the list published on tax authority website. For example
“0202”, “1010”, “3030”

@ > Application Base Setup > Enterprise » Tax » Tax Office » (5
Search  advanced 7
Tax Office ¥ Name:PL% ¥ @ CreationDate ¥ More ¥ 0 Favorites  Clear Q Settings

sortby

Tax Office o2 taxofficepan v 10f1
0202

« + 7 @ B @ o
MName: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English v
Tax Report Name Country

PL Tax Office Dan POLAND -

Creation Date

8/4/2020
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On the Tax Report sub menu connect the company, relevant tax ID number and specify our identity.
Our identity is company ID for the specific tax office.

B > Application Base Setup > Enterprise » Tax > Tax Office » Tax Report 5

VAT PL

Name: VAT PL

Address

Communication Method

Tax Report

-

Tax Report VAT PL-VATPL ¥ 1of1

« 8
Tax Office Mame
VAT PL VAT PL
Company: AMKA-PLN - AMKA-PLN ¥

a +|~s @ @
Company Tax ID Number Our Identity
AMEKA-PLN PL 2337684748 123456789

State Name

warminsko-mazurskie

Tax Report Info

= ¥V B v + | 7
Tax Report
VAT-2020 - Vat 2020

VAT7M - VATTM

3.10.3.3 Define Delivery Types

Electronic Tax [D

vatplo1

State Code

WN -

Go to the Financials/Customer Invoice/Basic Data/Delivery types page. Define Delivery Types
to be used as selection criteria in P_20, P_21, P_22, P_106E_2 and P_106E_3 fields of XML
JPK_FA report — according to XSD schema provided by tax authorities.

@ > Financials > Customer Invoice > Basic Data > Delivery Types &

Delivery Types

[
<

Delivery Type

P_106E_3

P_106E_2

P_22

P_21

P_20

EE

GTU_D

Z =
Include in
Invoice Invoice Enclosure
Description Enclosure  Series ID
P_106E_3 o |
P 106E 2 o
P22 o |
P2 o
P_20 o |
Telecommunications services, broadcasting : m
Deliveries of alcoholic beverages m

company | Dan Poland
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3.10.3.4 Define Invoice Texts

Go to the Financials/Customer Invoice/Basic Data/lnvoice Texts page. Define Texts to be used
on invoices with corresponding delivery types specified on Delivery Types for Specific Procedures
section P_20, P_21 or P_22 fields. The invoice texts should be defined as follows.

Delivery Type Invoice Text Format

P 20 <Text1>:<collector's name>, <Text2>:<collector’s address>

P_21 <Text1>:< representative’s name>, <Text2>:<representative’s address>,
<Text3>:<representative’s ID>

P 22 <Text1>:< registration date>, <Text2>:<mileage>, <Text3>:<working hours>

If the invoice is created with one of the above delivery types, additional information is required and
must be entered in invoice text. The required information must be defined with relevant Tax ID to be
reported correctly in corresponding XML tag. For invoices with tax code meeting specific criteria,
tags P_19A, P_19B and P_19C contain the texts defined with the same Tax Ids.

For P_20A, P_20B, P_21A, P_21B, P_21C, P_22A, P_22B and P_22C fields text defined in basic
data can be used — as well as can be entered using the Invoice Text command. To be reported
correctly in XML, the text must be defied in specified format with colons and commas as delimiters.

® > Financials > Customer Invoice > Basic Data » Invoice Texts £ Company
Invoice Texts

= Y B v 7 E v
Ending
v : TextID Text Text
P_19C ZwohienE na prodstawie: Art 43 Ustawy Ordynacja podatkowa m
P_198B Zwohiene na podstawie: Artr_ 100 dyreRywy 2006/112AVE m
P_19A Zwohiene na podstawie: Artr.34 uSt. 1-9 Ustawy o podatku Od towaréw | m
p_22 <Textl=:< registration date><Text2>:<mileage=><Text3=<working hours= m
P_21 Przedstawicél podatkowy: FOKUS, adres: 25-908 Reszow ULZEnuwt 12, m
P_20A <Text1>:<collector's name=> <Text2><collector's address> m

3.10.3.5 Define Correction Reasons

Go to the Financials/Customer Invoice/Basic Data/Invoice Correction Reason page. Define
correction reasons to be used on correction invoices.

If the correction invoice is created, information about reason of the correction is required and must
be entered in Correction Reason field on invoice details tab. Correction reasons defined in basic
data can be used — as well as can be entered in the field on invoice details tab.
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@ > Financials > Customer Invoice > Basic Data > Invoice Correction Reasons &> Company
Invoice Correction Reasons

= W B v 4

= v
Correction

v H Reason ID Correction Reason Vahnl\ry
INVTAX Invalid Tax Active
ERR Error Active

3.10.4 DEFINE AUDIT FORMAT BASIC DATA

Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows. Click New, select the Country
as “Poland”, Report Type as “SAF-T” and save. If the audit file is run on batch mode, the XML can
be downloaded from the Batch Processed Audit Files page.

Click the Audit File Basic Data command to open Audit File Basic Data page.

® > Accounting Rules » Audit Interface > Basic Data > Audit Formats < company [ AMKA-PLN |
Audit Formats

v ® v + e m B B v Audit File Basic Data Audit File Tax Information Audit File Log B v

Thousands Negative  Leading

"t | counmy ReportType  Decimal Symbol | Seperator Format  Zeroes  Time Format Dare Format File Type File Template 1D Default
POLAND SART (point) , [comma) -9 09 1359 YY-MM-DD

This opens Audit File Basic Data page. The new tab, SAF-T Poland Setup is added with ten
sections. For JPK_FA below sections are applicable:

BasicData > Audit Formats > Audit File Basic Data & C Polis

Audit Interface Compay ish company

Audit File Basic Data

/ 0]
HEADER STANDARD AUDIT CODE MAPPINGS «
7 o]
General Info
Tax Office ID Address ID
0202 v Al v
Misc Parameters
Person ID Invoice Series for SAD
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v
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General Info section
o Tax Office ID - select from list of values; only values from legal list will be accepted by tax
office.
e Address ID - specify company address ID. The address should be defined with all details.

Delivery Types for Specific Procedures (JPK_FA) section
o P_20, P_21, P_22 — enter delivery types to be used as selection criteria for the invoices to
be reported in corresponding XML file fields; use list of values; multiple values can be entered
for each field.
o VAT on Cash — enable this radio button, if there are invoices with cash basis method used in
tax operations.

Delivery Types/Customer Groups for Specific Procedures section
o (V7IM)MR_T/(FA)P_106E_2 and (V7M) MR_UZ/(FA) P_106E_3 — enter delivery types to be
used as selection criteria for the invoices to be reported in the corresponding <P_106E_2>
tag and <P_106E_3> tag of the XML file; use list of values; multiple values can be entered
for each field.

Invoice Type Mappings section
In the Invoice Type Mappings section, connect the invoice types and series. Only the invoice types
connected are reported in JPK_FA.
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@ Accounting Rules > AuditInterface > Basic Data > Audit Formats > Audit Flle Basic Data

Audit File Basic Data

/7 @

HEADER STANDARD AUDIT CODE MAPPINGS
7 m

General Info

Tax Office ID Address ID

0202 v Al G

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures
Tax Codes for Specific Procedures

Invoice Type Mappings

2 v o
nvolce Type nvolce Series
CUSTCOLCOR - Customer  KF - Customer Order Cort
CUSTORDDEB - Customet  ZK - Customer Order Invc
FP - Instant Customer Inv  FP - Instant Customer Inv
KP - Correction Instant C. ~ KP - Correction Instant Ct
PREPAYDEB - Prepaymen  ZK - Customer Order Invc

PRJINV - Project Invoice PJ - Project Invoice

PRJINVCOR - Project Corrt  PJ - Project Invoice

Company

24

Polish company

]

3.10.5 CREATE SAF-T VAT INVOICES (JPK_FA) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.

On Start Option section select Online or Schedule.

And specify following:

_5\\\!5

e Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for

Poland.
o Audit Type: “JPK_FA”.

e Date From and Date Until: The start and end dates of the period to be covered in

SAF-T VAT Invoices report or:

e Period From and Period Until: The year and month range to be covered in SAF-T VAT

Invoices report.

o File Type: select the file type as “JPK_FA”

¢ File Template will show up automatically after File Type is specified.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =O= SAF-T PL Additional Parameters = Schedule Schedule Options

Start Option

@ start now

() schedule
Parameters
Company Country Report Type

DAN POLAND - Dan Poland ~ | POLAND ~ | SAF-T -
Audit Type Audit Source Ledger ID

JPK_FA -
File Type File Template

JPK_FA v | | JPK_FA_TEMPLATE -
Selection
Period/Date Range From Until

() Date 2020 8 2020 8
(@) Period

4 Previous b Next Finish Cancel

Click Next.

On SAF-T PL Additional Parameters specify:

e Selection Date — enter a criteria date to select invoices to be reported. Possible values are:
“Voucher Date”,” Invoice Date”, “Tax Liability Date” and Delivery Date”. “Voucher date” will
be prompted as default.

e Customer ID — enter a customer id to select invoices to be reported. Possible customer ids
will be listed in the List of Values.

e Customer Group — enter a customer group to select invoices to be reported. Possible
customer groups will be listed in the List of Values.

@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

O= Task Options =.= SAF-T PL Additional Parameters = Schedule Schedule Options

Date Type Customer Id Customer Group
Tax Liability Date * | % v | % -
4 Previous b Next Finish Cancel

Click Finish to generate the SAF-T VAT Invoice (JPK_FA) XML file. The file will be named as:
<Audit Type without brackets>_<Time stamp(yyyymmddhhmmss>.XML
e.g. JPK_FA_20170906124804.XML

The generated XML file is submitted to Polish Tax Office.
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3.10.6 INVOICE REPORTING IN XML

The transactions are classified in the XML using the Tax Group functionality in IFS Cloud. Tax Group
“KRS” is used for this purpose. The net amount and tax amount in invoice header (faktura) are shown

in below tags as per the classification.

Transaction Tax Tax Sub Group | Net Tax Value in
Rate Amount Amount <P_12>
Domestic Sales 23% or | SPRZ-KRAJ-22 | P_13 1 P_14 1 23
22%
Domestic Sales 8% or | SPRZ-KRAJ-7 | P_13 2 P_14 2 8
7%
Domestic Sales 5%  or | SPRZ-KRAJ-3 P 13 3 P 14 3 5
3%
Domestic Reverse Charge | 0% NABPOD- P_13 4 P_14 4 00
DOST
Sales of Goods and | 0% ZAG P_13 5 P_14 5 np
Services - Taxable Outside ZAG-UE
Country ZAGB
ZAGB-UE
Domestic Sales 0% 0% SPRZ-KRAJ-0 P 13 6 N/A 0
Export EKSP-TOW
EU Delivery of Goods WDT
Tax Free Sales — Exempted | 0% SPRZ-KRAJ- P 13 7 N/A Zw
zZW
Tourism Services, Second | 0% SPN N/A N/A N/A
Hand Goods and Work of Art

Following transactions are specifically handled in XML.

3.10.6.1 Correction invoices

Following customer invoice types are considered as correction invoice in JPK_FA and identified by
“‘KOREKTA” value in <RodzajFaktury> tag.

e Customer Order Correction Invoice

e Customer Order Collective Correction Invoice
e Correction Instant Invoice
e Customer Order Rebate Credit Invoice

3.10.6.2 Prepayment invoices

Following customer invoice types are considered as prepayment invoice in JPK_FA and identified
by “ZAL” value in <RodzajFaktury> tag.
o Prepayment Based Debit Invoice

e Prepayment Based Credit Invoice

Additionally, delivery invoices matched with a prepayment-based invoices are considered as
prepayment invoices (ZAL) in JPK_FA.

Following amounts in invoice header (faktura), are fetched from customer order for prepayment

invoices.
e Net Amount (P_13_1,P_13 2,P_13 3,P_13 4, P_13 5,P_13 6,P_13 7)
e Tax Amount (P_14_1,P_14 2,P_14 3,P_14 4 ,P_14_5)
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Foreign currency transactions are recalculated to accounting currency using tax currency rate in
relevant invoice.
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For all other invoices, the information is fetched from invoice.

3.10.6.3 Invoices with tax exempt transactions

For invoices with tax exempt transactions (belonging to tax sub group SPRZ-KRAJ-ZW) the
information in P_19A, P_19B and P_19C XML tags, is fetched from Invoice Texts with corresponding
Tax ID defined in basic data.

3.10.6.4 Invoices issued by Tax Collectors

Invoices issued by Tax Collectors are identified by delivery type specified in P_20 field in Delivery
Types for Specific Procedures (JPK_FA) section. The Invoice Text entered in invoice header will be
shown in P_20A and P_20B tags.

3.10.6.5 Invoices issued by Tax Representatives

Invoices issued by tax representatives are identified by delivery type specified in P_21 field Delivery
Types for Specific Procedures (JPK_FA) section. The Invoice text entered in invoice header, is show
as below in the XML.

P_21A: Tax Representative

P_21B: Address of the Tax Representative

P_21C: Tax ID number of Tax Representative

3.10.6.6 Invoices related to delivery of new means of transport

Invoices related to delivery of new means of transport in EU are identified by delivery type specified
in P_22 field in Delivery Types for Specific Procedures (JPK_FA) section.

Invoice text entered in invoice header, is show as below in the XML.
P_22A: Date of Registration

P_22B: Course of transport

P_22C: No of hours spent

3.10.6.7 Invoices related to secondhand goods or work of art
Invoices related to secondhand goods or work of art are identified by delivery type specified in the
(V7M) MR_UZ/(FA) P_106E_3 field in the Delivery Types/Customer Groups for Specific Procedures

section. The additional information is required in P_106E_3A XML tag. This information is fetched
from specified Delivery Type Description.

3.10.6.8 Invoices related to tourism services

Invoices related to tourism services are identified by delivery type specified in the (V7M) MR _T/(FA)
P_106E_2 field of the SAF-T PL Parameters tab.

3.10.7 DELIMITATIONS

No known.
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3.11 SAF-T For Poland — Mixed Payment Report (JPK_WB)

3.11.1 SOLUTION — SAF-T PL MIXED PAYMENTS

The solution is based on IFS Cloud standard functionality of Mixed Payments and the Audit Interface
functionality.

In order to support the requirement for the SAF-T PL Mixed Payment report, the following has been
done:

New report type SAF-T added to the Audit Formats page.

¢ In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data.

o In Task Options on Audit Interface Assistant page, new Audit Type field has been added to
select relevant SAF-T report. In SAF-T PL Additional Parameters in Audit Interface
Assistant page Short Name field specific for the SAF-T WB has been added.

o New external file template JPK_WB_TEMPLATE has been added to support specific SAF-T
reports.

Process Overview

 Enter JPK General Info - Tax Office ID and Company Address 1D

Define Basic Data

» Mixed Payments with Approved state should be present
» Update General Ledger
Update General « Fetch the tax ledger information

Ledger and Fetch
Tax Leder Info

* Run "Audit Interface Assistant"

» Select country as "Poland"

« Enter report type SAF-T and audit type JPK_WB
« Select date or period range
OTCEICMIEIOY|EIE - Select Cash Account Short Name

3.11.2 PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Mixed Payments xml file
for auditing purposes.

. The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.
. It is recommended to create the company using Standard Polish Template (STD-PL).
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. Mixed Payments with status Approved must exist in company.
3.11.3 DEFINE COMPANY BASIC DATA

3.11.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address sub menu click the
View Detailed Address command. The following fields must have values:
e Street
e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number
¢ Community

e District
X Edit Detailed Address
Street House No Community
Lopuszanksa| 123 Okecle
District
Wiochy
0K Cancel

3.11.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General sub menu, define
Tax Office for Poland — one from the list published on tax authority’s website. For example
“0202”, “10107, “3030” ...

® > Application Base Setup » Enterprise » Tax » Tax Office » =
Search agvanced R
Tax Office * Name:PL% ~ @ CreationDate ¥ More ¥ @ Favorites  Clear Q } Semings

Sort by

Tax Office oz02-pimaxofficenan ¥ 101
0202

« + 72 ® B m- ©
Name: PL Tax Office Dan
Address Tax Office Default Language
Communication Method 0202 English h
Tax Report Name Country
PL Tax Office Dan POLAND v

Creation Date

8/4/2020
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On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
a National Business Registry Number of company and will be copied in tag <REGON> in XML file.

@ > Application Base Setup » Enterprise > Tax > Tax Office » Tax Report =
sortoy v

Tax Repo Ft varpL-vareL ¥ 10f1
VAT PL

« B o
MName: VAT PL
Address
Communication Method Tax Office ame
Tax Report £ VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + | / m B
Company Tax ID Number Qur Identity Electronic Tax ID State Code
AMEKA-PLN PL 2337684748 123456789 vatplol WHN A

State Name

warminsko-mazurskie

Tax Report Info
B~ + &

Tax Report
VAT-2020 - Var 2020

VAT7M - VAT7M

Other parameters from General Info (Journal ID and Person ID) will not be used in JPK_WB file.
3.11.4 ENTER AUDIT FILE BASIC DATA

Click the command Audit File Basic Data to open Audit File Basic Data page.

company [ AMKA-PLN

"~ + s B v Audit File Basic Data Audit File Tax Information Audit File Log B
T nds Negotive  Leading
‘/ Country ReportType  Decimal Symbol S or Format  Zero ime Format Di i File Tyy File Te D Defaul
I | POLAND SAF-T  (point) . (comma) 9 09 13:59 YY-MM-DD

Use IFS Cloud standard functionality to add a header record in the Audit File Basic Data page. If
required, do modifications in the Standard Audit Code Mappings.

The new tab, SAF-T Poland Setup contains ten sections. For SAF-T_WB report only data from
General Info should be defined.

e Tax Office ID
e Address ID
Data from the rest of group boxes are not used in creation of JPK_WB file.
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® > AccountingRules > AuditInterface > Basic Data > Audit Formats> Audit File Basic Data & Company Po o
Audit File Basic Data
V4 0]
HEADER STANDARD AUDIT CODE MAPPINGS <«
7 o}
General Info
Tax Office ID
0202 v Al v
Misc Parameters
Person ID
MABEPL v SD =
Voucher/Delivery Types for Document Types (JPK_V7M) v
Delivery Types for Specific Procedures (JPK_FA) v
Delivery Type for Delivery Goods and Services v
Delivery Types/Customer Groups for Specific Procedures v
Tax Codes for Specific Procedures v
Invoice Type Mappings v
SAF-T PL Inventory Transaction Report Types v
Inventory Transaction Report Type Mappings v

3.11.5 CREATE SAF-T MIXED PAYMENTS (JPK_WB) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:
o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
e Audit Type: “JPK_WB” selected from List of Values.
¢ Date From and Date Until: The start and end dates of the period to be covered in
SAF-T WB report (XML can be created for one period or more or even for one day) or:
e Period From and Period Until: The year and month range to be covered in SAF-T WB report.
e File Type: select the file type for JPK_WB from List of Values.
¢ File Template will show up automatically after File Type is specified.
After entering all needed data select button Next.
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@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company
Audit Interface Assistant

.= Task Options =-O= SAF-T PL Additional Parameters = Schedule Schedule Options

Start Option

@) Start now
() schedule
Parameters
Company Country Report Type
DAN POLAND - Dan Poland - POLAND w | |SAF-T -
Audit Type Audit Source Ledger ID
JPK_WB -
File Type File Template
JPK_WB ~ | |JPK_WB_TEMPLATE -
Selection
Period/Date Range From Uniil
() Date 2020 9 2020 9
(@ Period
4 Pre S » Next Finish Cancel

On SAF-T PL Additional Parameters specify:
e Short Name: select Cash Account Short Name from List of Values
e Currency — will be changed automatically for Cash Account Currency (default value is
accounting currency)
@ > Accounting Rules > Audit Interface > Audit Interface Assistant Company

Audit Interface Assistant

O= Task Options =-.= SAF-T PL Additional Parameters = Schedule Schedule Options

Currency Short Name
PLN ¥ | | BRE-PLN -
4 Previous » Next Finish Cancel

Press the button Finish and file will be saved.
If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed Audit
Files page.

In created XML file values in tags like Opening Balance or Transaction Amount are fetched from
approved Mixed Payments created for Cash Account selected in Audit Interface Assistant.

3.11.6 DELIMITATIONS

None
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3.12 SAF-T For Poland — Accounting Books (JPK_KR)

3.12.1 SOLUTION — SAF-T PLACCOUNTING BOOKS

The solution is based on IFS Cloud standard functionality of Accounting Journal, Turnover and
Balance Report, GL Voucher Rows Analysis, and the Audit Interface functionality.

In order to support the requirement for the SAF-T PL KR report, the following has been done:

o New report type SAF-T added to the Audit Formats page.

e In Audit File Basic Data page, a new tab, SAF-T Poland Setup with ten sections has been
added to handle SAF-T Poland specific data. For generation of JPK_KR only values from
group box General Info will be used.

o Task Options in Audit Interface Assistant page, new Audit Type field has been added to
select relevant SAF-T report.

~

« Enter JPK General Parameters - Tax Office ID, Company Address ID and Journal ID

Define Basic Data

)

~

* Run "Audit Interface Assistant”

« Select country as "Poland"

« Enter report type SAF-T and audit type JPK_KR
» Select date or period range

Create JPK XML File

3.12.2 PREREQUISITES

Following prerequisites should be satisfied in order to generate SAF-T PL Accounting Books xml file
for auditing purposes.

e The company must be set-up to use Polish localization, see chapter Company Set Up. The
functionality “Standard Audit File-Tax for Poland (JPK)” is mandatory and enabled by default.

e |tis recommended to create the company using Standard Polish Template (STD-PL).

¢ All transactions from period being of subject of XML file must be updated into General Ledger
and Accounting Journal for the same period must be defined and created.

e In XML file there are tags <TypKonta>, <KodZespolu> and <OpisZespolu> which can be
filled only with manually added two new attributes in Accounting Rules/Code Part Attributes
(ID-s of attributes are hard coded):
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o ZESPOL connected with Account.

o TYP_KONTA connected with Account.

&5 @ > Accounting Rules > Code String > Code Part Attributes Company | Dan Poland

Code Part Attributes

=V B v } 4
o I Attribute . Description Code Part Name
ZESPOL ZESPOL Account
TYP_KONTA TYP_KONTA Account
RZIS1 Rachunek zyskéw i strat-  Account
¢ BILANS Bilans Account

There are recommendations to use the following values for above attributes.

1. ZESPOL

=2 @ > Accounting Rules > Code String > Code Part Attributes > Attribute Value Company | Dan Poland

Attribute Value zsroL-zespor v 10f1

»> | g ] B v Connect Attribute

Attribute

ZESPOL - ZESPOL

Code Part Name

Account

Code Part Attribute Values

=Y | B v f 7

s i Attribute Value Description
9 Konta statystyczne
i 8 Kaptab' whsne
i7 Przychody i koszty ich uzyskania
L Produkty i rozliczenia miedzyokresowe
i 5 Koszty w ukhdzie kalkulacyjnym
14 Koszty wedaug rodzajow
i3 Materiab' i towary
:2 Rozra ch Oki i roszczenia
LI In westy cje krotkotermino we
FE] Aktywa trwale
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2. TYP_KONTA

=2 @ > Accounting Rules > Code String > Code Part Attributes > Attribute Value  Company | Dan Poland

Attribute Value e xonma-tvekona v 1o

> } w R~ Connect Attribute Q

Attribute

TYP_KONTA - TYP_KONTA

Code Part Name

Account
Code Part Attribute Values
=Y B v } 7 = v
v i Atribute Value Description
. WYNIKOWE Konta wynikowe
i ROZLICZENIOWE Konta rozliczeniowe
i POZABILANSOWE Konta pozabilansowe
3 BILANSOWE Konta bilansowe

The Attribute ZESPOL must be created because the tag <KodZespolu> is obligatory in XML. If such
Attribute does not exist or some Account used in transactions is not connected with this Attribute —
the XML is created with errors.

If Attribute TYP_KONTA is not created, or some used Account is not connected with Attribute in tag
<TypKonta> - in XML values from Accounting Rules/Code String/Account Types connected with
used account will be selected. So, the user can choose to use an Attribute or Account Type.

3.12.3 DEFINE COMPANY BASIC DATA

3.12.3.1 Define Company Address Details (Standard functionality)

Open the Application Base Setup/Enterprise/Company page. On the Address submenu, click the
command View Detailed Address. The following fields must have values:
o Street
e House: Number1/Number2 format, where Number1 is house number and Number2 is
apartment number
Community
e District
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X Edit Detailed Address
Street House No Community
Lopuszanksa 123 Okecie
District
Wiochy

oK Cancel

3.12.3.2 Define Tax Office (Standard functionality)

Open the Application Base Setup/Enterprise/Tax Office page. On the General tab, define Tax

Office for Poland — one from the list published on tax authority’s website. For example
‘02027, “10107, “3030” ...

. » Application Base Setup > Enterprise » Tax » Tax Office » Tax Report 9

sortby v
Tax Report VATPL-VATPL ¥ 1of1
VAT PL
€ B v
Name: VAT PL
Address
Communication Method Tax Office Mame
Tax Report £ VAT PL VAT PL

Company: AMKA-PLN - AMKA-PLN ¥

Q + & ] B

Company Tax ID Number Our Identity Electronic Tax IO State Code
AMKA-PLN PL 2337684748 123456789 varplo1 WN

State Name

warminsko-mazurskie

Tax Report Info

= YV o® v + '
s i TaxRepor
| VAT-2020 - Vat 2020

| 3 VATIM-VATIM

On the Tax Report sub menu, enter the Company, Tax ID Number and Our Identity. Our identity is
a National Business Registry Number of company and will be copied in tag <REGON> in XML file.
3.12.3.3 Define Journal ID (Standard functionality)

In order to create XML file JPK_KR at least one Accounting Journal (General Ledger/Accounting
Journal) must be defined and created.
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In the case when more than one Accounting Journal are defined all of them must be created
(Accounting Journal/Create Accounting Journals) and all of them will be included in created JPK_KR
file.

3.12.4 CREATE SAF-T MIXED PAYMENTS (JPK_KR) XML FILE

Open the Accounting Rules/Audit Interface/Audit Interface Assistant.
On Start Option section select Online or Schedule.

And specify following:
o Report Type: “SAF-T” - the value will be prompted according to Audit Formats settings for
Poland.
o Audit Type: “JPK_KR” selected from List of Values.
e Date From and Date Until: The start and end dates of the period to be covered in
SAF-T KR report (XML can be created for one period or more but only from one year) or:
e Period From and Period Until: The year and month range to be covered in SAF-T KR report.

[ ] Accounting Rules > Audit Interface > Audit Interface Assistant

Audit Interface Assistant

.— Task Options == Schedule Schedule Options

Start Option

@‘ Start now

"C:" Schedule
Parameters
Company Country Report Type

POLCOM - POLCOM - POLAND - SAF-T A4
Audit Type Audit Source Ledger ID

JPK_KR. -
Selection

Period/Date Range From unti

(O Date 2023 8 2023 8
@) Period

Finish ~ Cancel

Press the button Finish and file will be saved.
If the audit file is run on batch mode, the XML can be downloaded from the Batch Processed Audit

Files page.

In order to check if values in XML tags are correct a Turnover and Balance Report should be created
for the same period and values from this report should be compared with values in block ZOiS.
Values from block Dziennik should be compared with values in Journal Report created for the same
period. Values in block KontoZapis can be compared with values in General Ledger Report.
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3.12.5 DELIMITATIONS

No known.
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4 Reposting of Currency Difference on Tax
4.1 Overview Legal Requirement

According to Polish Income Tax Law there are two ways for handling currency rate differences:
e Directly according to Income Tax Law (art. 15a)

e Following the Accounting Law (art. 9b ust. 1 pkt 2)
First method is the default and most of companies use this method. When using this method,
currency differences at payment are considered as revenue/cost for income tax only in part related
to net amount and non-deductible tax amount. Currency differences related to deductible VAT are
not considered as revenue/cost.

4.2 Solution

Standard solution is used in order to create currency differences postings (PP12 and PP13), that is,
differences related to gross amount.

In addition, the following new postings are added for differences related to deductible vat amount:
e PP81 - Currency Loss, Tax Related Difference
e PP82 - Contra Account, Currency Loss, Tax Related Difference
e PP83 - Currency Profit, Tax Related Difference
e PP84 - Contra Account, Currency Profit, Tax Related Difference

4.2.1 OVERVIEW PROCESS

Enter Supplier
Define Basic Invoice/ Enter

and Approve

Data Create and Print Payment

Customer Invoice

4.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set Up chapter. The
parameter “Reposting of Currency Difference on Tax” should be enabled.

4.4 Define Basic Data

Follow the IFS Cloud standard process to define basic data:
e Inthe Payment Terms page, define payment terms. Note that the value selected in the Tax
Distribution field affects the calculation logic.
¢ In the Posting Control page, make sure to have standard posting types PP12 and PP13
defined.

441 NEW POSTING TYPES

New posting types PP81, PP82, PP83 and PP84 are available in the Posting Control page.
e PP81 - Currency Loss, Tax Related Difference
e PP82 - Contra Account, Currency Loss, Tax Related Difference
e PP83 - Currency Profit, Tax Related Difference
e PP84 - Contra Account, Currency Profit, Tax Related Difference
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The new posting types are used according to the following rules:

In case of PP12 Currency Loss (debit)
o PP81 is used to repost currency difference related to deductible tax amount (debit)
o PP82 is used to clear currency difference related to deductible tax amount from PP12
account (credit)

In case of PP13, Currency Profit (credit)

e PP83 is used to repost currency difference related to deductible tax amount (credit)
o PP84 is used to clear currency difference related to deductible tax amount from PP13
account (debit)

Follow the IFS Cloud standard process to define new posting types in the Posting Control page.

4.5 Enter Supplier Invoice/Create and Print Customer Invoice

Follow the IFS Cloud standard process to enter foreign currency supplier invoices.
Follow the IFS Cloud standard process to create and print foreign currency customer invoices.

4.6 Enter and Approve Payment

Follow the IFS Cloud standard process to enter and approve payment in the Mixed Payment page
or other payment page.

Amounts to be reposted with the new posting types depend on the tax distribution.

Tax Distribution Installment | Reposting Logic
ID
Even All Amount to be reposted considers

deductible tax as evenly distributed on
all installments.

First Installment only Tax | 1 Amount to be reposted considers
deductible tax as fully included in the first
installment.

First Installment only Tax | Other than 1 | No amount is reposted.

All Tax on First Installment | 1 Amount to be reposted considers

deductible tax as fully included in the vat
portion of the first installment.
All Tax on First Installment | Other than 1 | No amount is reposted.
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Example 1: Tax distribution “Even” and currency loss calculated

Invoice type customer invoice
Net amount 100

Deductible tax amount 23

Currency rate at invoice entry 4

Currency rate at payment 3.5

Payment Posting Method field on the | Gross

Company/Payment/General tab

Currency difference

(123 * 4) - (123 * 3.5) = 492 - 430.50 =
61.50

Currency difference related to net

61.50 * (100/123) = 61.50 * 0.81300813 =
50

Currency difference related to tax

61.50- 50 =11.50

Purple color: New posting types.

Green color:  Net balance on the currency different account.

P2, Customer Claims
(1) Invoice 123,00 USD {4) 292,00/ 123,00 USD(3,5) 43050 (2) Payment
Entry

0,00 USD (2,5) 61,50 (2) Payment

PP12, Currency Loss
2) 0,00 USD (3,5) 61,50
Payment

M28, Taxable Sales
| 100,00 USD (4) 400,00 (1) Invoice

Entry

P4, Tax Disbursed, Invoice
23,00 USD(4) 92,00 (1) Invoice
Entry

PP82, Contra Account, Currency Loss, Tax Related Difference
0,00 USD(3,5) 11,50{(2)
| Additional

PP81, Currency Loss, Tax Related Difference
2) 0,00 USD(3,5) 11,50]
Additional

Example 2: Tax distribution “Even” and currency profit calculated

Invoice type customer invoice
Currency rate at invoice entry 4
Currency rate at payment 4.5

the Company/Payment/General
tab

Payment Posting Method field on | Gross

Currency difference (123

*4)-(123 * 4.5) = 492 - 553.50 = -61.50

Currency difference related to net -61.50 * (100/123) = -61.50 * 0.81300813 = -50

Currency difference related to tax -61.50 - (-50) = -11.50

Purple color: New posting types.

Green color: Net balance on the currency different account.
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1P2, Customer Claims
(1) Invoice 123,00 USD (4) 492,00 123,00 USD (4,5) 553,50 (2) Payment
Entry
(2) Payment 0,00 USD (4,5) 61,50

PP13, Currency Profit
0,00 USD (4,5) 61,50|(2) Payment

S\
SVIFS

M28, Taxable Sales

100,00 USD(4) 400,00 (1) Invoice
Entry

IP4, Tax Disbursed, Invoice

23,00 USD(4) 92,00 (1) Invoice
Entry

PP84, Contra Account, Currency Profit, Tax Related Difference
(2) 0,00 USD (4,5) 11,50,
Additional

PP83, Currency Profit, Tax Related Difference

0,00 USD(4,5) 11,50 (2)
Additional

4.7 Delimitations

When specific tax currency rates are enabled for the company, and the tax code used for the
transaction has tax method as payment entry, the tax currency difference is handled through PP61
(Tax Currency Loss) /PP62 (Tax Currency Profit) postings in core application. In that case, if any
duplication of entries arises with the above functionality, those have not been specifically handled.

Additional delimitations may apply; all relevant flows should be tested to ensure completeness.
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5 Currency Rate Date and Voucher Date Extended
Capabilities for Outgoing Invoices

5.1 Overview Legal Requirements

According to legal regulations in countries like Hungary, Czech Republic, Slovakia or Poland, date
of posting of debit sales invoices, as well as currency rates used for posting, should be based either
on invoice date or on delivery date, depending on type of transaction.

Also, according to legal regulations in Poland, prepayment based invoices should be posted with the
date of the payment which is the base for the invoice.

5.2 Solution Overview

Process Overview
Standard invoicing flow is used in the solution:

Create

Modify

Define Basic Print and Post

Customer
Invoice

Customer

. Invoice
Invoice

Data

Solution Summary
New field Delivery Date is added to handle delivery dates on project invoices.

Handling of default value of the Latest Ship Date field on prepayment based invoices is modified,
so that payment date could be the base for posting of the invoice.

New fields Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added to
define base for voucher date, currency rate and tax currency rate for invoices. The fields are added
on customer order invoices, instant invoices and project invoices. Either invoice date or delivery date
can be the base for voucher date and currency rates.

New fields are added on company and customer level as sources of default values for new fields on
invoices mentioned above.

5.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“Currency Rate Date and Voucher Date Extended Capabilities for Outgoing Invoices” parameter
must be enabled on the Company/Localization Control Center tab.

5.4 Set up Basic Data

Settings on Company level
New field Outgoing Invoice Voucher Date Base is added on the Company/Invoice/General tab.
Available values are: “Invoice Date” and “Delivery Date”.
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Invoice swei-swee v 1on

L@ B

Company

SW-PL

W DEFAULT INVOICE TYPES
s W

Posting Parameters

Create Posting at Invaice Entry

Accepted Invoice Voucher Difference in Accounting Currency

Miscellaneous Parameters
Planned Payment Date Calculation Base

Pay. Term Base Date

Name

SW-PL

POMATCHING ~ DOCUMENT MANAGEMENT

Same No Preliminary and Final Supplier Invoice
Accepted Invoice Rounding Difference in

voice Currency

Urique Supplier Invoice No Per

~  Supplier -

Ouitgoing Invoice Voucher Date Base

Delivery Date
nvoice Date

Delivery Date

upplier Invaice Authorization Only by Separate Function

nique Payment Reference Validation

Invoice Payment Reference No

Custamer Invoice Creation Method

Not Used ~ Not Used

Attachments

Supplier Invoice Validation Method

Association No [«

SASGLK

Same Date Preliminary and Final Supplier Invoice Us:

Incoming Invoice Currency Rate Base

Invoice Date

Cash Discount Based on Gross Amount

Credit

Company Credit Limit

rezted By

- Posting Propasal

Outgoing Invoice Currency Rate Base

~  Delivery Date -

Irvaice Date to Current Date When Printing Outgoing Invoices

New field Tax Sell Currency Rate Base is added in the Company/Accounting Rules/Currency
Rate Type Information tab. The field is enabled when the Allow Specific Currency Rates for Tax
Transactions option is enabled. Available values are “Invoice Date” and “Delivery Date”.

K@ =2~

Company

SW-PL

4

Default Buy Currency Rate Type

1- Normal

Default Currency Rate Types for TAX

Allow Specific Currency Rates for Tax Transactions

Buying Currency Rate for Tax

1- Normal

Accounting Rules swei-swe ~ 1011

Name

SW-PL

(F LRI CURRENCY RATE TYPE INFORMATION

Tax Sell Currency Rate Base

Delivery Date
nvoice Date

Delivery Date

Association No

Default Sell Currency Rate Type

- 1 - Normal

Selling Currency Rate for Tax

- 1 - Normal

Created By

SASGLK

Note: Apart from new fields mentioned above, the standard Outgoing Invoice Currency Rate Base
field on the Company/Invoice/General tab is used in this solution and it has to be set according to

the needs.
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Settings on Customer level
Following fields are added on Customer/Address/Delivery Tax Information tab: Voucher Date

Base, Currency Rate Base, Tax Currency Rate Base. Available values for these fields are “Invoice
Date”, “Delivery Date” and “Specified on Company”.

Address customersweL-customER sWPLe ¥ 161

L8P B~ Q
Customer Name Association No
CUSTOMER SWPL CUSTOMER SWPLe

Address ID: CUSPL ¥

VA |

End Customer

Customer's Own Address ID Customer Name End Customer Address Identity

GENERAL ADDRESS INFORMATION JMNVIZ:VRTVRUTRe /ATl DOCUMENT TAX INFORMATION |~ SALES ADDRESS INFORMATION 1)

Company: SW-PL-SW-PL ¥

/J Wl | B IPD Tax Information
Tax Withholding Tax Rounding Method Tax Rounding Level Vioucher Date Base
Blocked + Round 1o the Nearest ~  Specified on company = || Spedified on Company a
Currency Rate Base Tax Currency Rate Base Invaice Date
Delivery Date ~  Invoice Date -
Delivery Date
Specified on Company
Supply Country: POLAND ¥

PN |

5.5 New Fields on Invoices

Customer Order Invoice

New fields: Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on
Customer Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery
Date”.

Note: In customer order invoice the Latest Ship Date field plays role of delivery date. “Delivery Date”
setting means that value of the Latest Ship Date field will be taken as a base for voucher date or
currency rate.

The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or

Latest Ship Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate
Base fields.
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H Posted Auth
Customer INVOICe customer swpL - CUSTOMER SWPLe - 200700004 - CUSTORDDES - D550344 ¥ 5 of 24+
LK 7 B v Share v Credit/Correction Invoice v Posting Installment Plan and Discounts Notes Q
Customer No Customer Address Na_. ~ Series ID Invaice No Company Site Invoice Created Order Created
.CUSTOMER ... CUSTOMER SWPLe ZK 200700004 SW-PL SWPL 17/07/2021 17/07/2021
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate
usD 293.30 279.33 13.97 7.6 7.16
LINES HISTORY 4 4
Indicators
Invoice Type Price Adjustment Advance/Prepayment Invoice
CUSTORDDEB - Customer Order Invoice, Debit m m
Invoice Address Invoice Date Use Price Incl Tax Notes
@ CuspPL 17/07/2021 o o]
Printed Date Preliminary Invoice No Correction Exist Correction Invoice
17/07/2021 204701 m m
Our Reference Customer Reference
Correction Reason 1D Correction Reason
O nicowas Lecterca -
Customer Reference Name Branch
Customer Branch Jinsui Status
Non Jinsui
Payment Delivery
Pay Term Base Date Due Date Delivery Address Latest Ship Date
17/07/2021 27/07/2021 © cuspL 01/09/2021
Payment Terms Payment Reference Wanted Delivery Date Ship Via
10-10 Days 02/09/2021, 02:00 IFS APPLICATIONS
Delivery Terms Description Delivery Terms Location
IFS APPLICATIONS
Forwarder ID Label Note
References v | Invoice Text %
T R T T T T
Voucher Date Base Currency Rate Base Tax Currency Rate Base
Delivery Date Invoice Date Invoice Date

Instant Invoice

New fields Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on
the Instant Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery

Date”.

The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or
Delivery Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate

Base fields.
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Instant Invoice rr-200700000 ~ —

& 2 t & |0f g~ More Information Instaliment Plan and Discounts Pre Posting Reprint Original Reprint Modified Q
Customer Invoice Type series ID Invoice No Project ID TAVGIce Date

. CUSTOMER SWPL - CUSTOMER ... FP FP 200700009 01/08/2021

Delivery Date Invoice Address Delivery Address Notes Advance Invoice Invoice Fee Correction Invoice Correction Exists
01/09/2021 CUSPL cusPL [ o] [ o] [ no | [ o] [ no |

Preposting Currency Currency Rate Voucher Date Base Currency Rate Base

ﬂ usD 9.1 Delivery Date Delivery Date

Tax Currency Rate Base Gross Amount Net Amount Tax Amount

Delivery Date 3622.50 3450.00 172.50

Payment and Tax Information

Pay Term Base Date Payment Terms Due Date Payment Method Payment Address ID

01/08/2021 10 - 10 Days 11/08/2021 -

Supply Country Tax Liability

POLAND TAX

Lines

X More Information

Payment Reference Payer Language
| ‘ |. CUSTOMER SWPL - CUSTOMER... ~ ‘ English - |
Transfer Status Tax Currency Rate Our Reference

703 |
Customer Reference Creator Reference Signature
| | | [susax |
QOrder Date QOrder No Ref Invoice Series ID
| =] | -
Ref Invoice Mo Correction Reason ID Correction Reason

| | |
Branch Customer Branch Deduction Group
| d | -
Deduction Amount Invoice Text ID Invoice Text

| -

Additional Reference

Cancel

Project Invoice

New field Delivery Date is added on Project Invoice/General tab. When invoice is created the field
gets the same value as Invoice Date. It can be modified when invoice is in state “Preliminary”.

New fields: Voucher Date Base, Currency Rate Base and Tax Currency Rate Base are added on
Project Invoice/General tab. Available values for these fields are “Invoice Date” and “Delivery
Date”.
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The Currency Rate and Tax Currency Rate fields are based on value of either the Invoice Date or
Delivery Date fields, depending on setting of the Currency Rate Base and Tax Currency Rate
Base fields.

H H Posted Auth

PI’O] ect Invoice » 20070002 ~ o——

& 72 B~ Notes Printout Credit Entire Invoice Create Carrection Invaice Customer Installment Plan q
Customer Customer Name Project nvoice Series

CUSTOMER SWPL CUSTOMER SWPLe PJ

Invoice No Invoice Period Start Invoice Period End Notes Invoice Text
200700032 01/07/2021 01/07/2021 o] o]

Amounts

CUI’I’EI“C}“ Gross Amount Net Amount Tax Amount

UsD 2160.00 2000.00 160.00

LINES m PRE POSTING =~ ACCOUNTING 4 M

Invoice Information

Invoice Date Voucher Date Base Currency Rate Base Tax Currency Rate Base

01/08/2021 Delivery Date Invoice Date Delivery Date

Invoice Type series Reference Invoice Number Reference ey Rate

PRJINV 8.1

Our Reference Customer Ref Order No Tax Currency Rate
80.1

Voucher Type Voucher No Correction Invoice Correction Reason ID

F 2021000106 o]

Correction Reason Correction Exist Div Factor Currency

o] 1 uUsD

Customer Information

Invoice Address Delivery Address Payment Address Media Code
CUsPL CUSPL
Pay Term Base Date Due Date elivery Date Payment Terms
01/08/2021 11/08/2021 19/08/2021 10-10 Days
Branch Site Payment Method Supply Country Customer Branch

DOl AND

Tax ID Number

214234234

5.6 Process Invoices

General

New functionality to define the base for voucher date and currency rates is added for following types
on invoices:

e Customer order invoices — normal debit invoices (invoice type CUSTORDDEB), collective
debit invoices (invoice type CUSTCOLDEB) and prepayment based debit invoices.

¢ Instant invoices — normal instant debit invoices (invoice type INSTINV).

e Project invoices — debit invoices (invoice type PRJINV).
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For all other invoices currency rates and voucher date are handled in a standard way. In particular
for correction invoices, as well as for credit customer order and project invoices, the Voucher Date
Base, Currency Rate Base and Tax Currency Rate Base fields are always set to hidden.

Create Invoice

When debit customer invoice (customer order invoice, instant invoice, and project invoice) is created
then the Voucher Date Base, Currency Rate Base and Tax Currency Rate Base fields get default
values based on settings on customer level. Fields which are set to “Specified on Company” on
customer level get values based on settings on company level.

Note: When the Currency Rate Base field on customer level is set to “Specified on Company” then
the Currency Rate Base field on invoices for this customer will get default value based on setting
of the standard Outgoing Invoice Currency Rate Base field for company.

When prepayment based invoice is created then the Latest Ship Date field gets default value equal
to date of payment. In standard solution this field is empty when invoice is created.

Modify Invoice
Values of the Voucher Date Base, Currency Rate Base and Tax Currency Rate Base fields can
be modified when debit invoice is in the “Preliminary” state with following exceptions:

e The Tax Currency Rate Base field can be modified only when the Allow Specific Currency
Rates for Tax Transactions option for company is enabled.

¢ On instant invoice the Currency Rate Base and the Tax Currency Rate Base fields can be
modified only before invoice line is entered.

Whenever the Currency Rate Base or the Tax Currency Rate Base fields get modified, values in
the Currency Rate or the Tax Currency Rate fields are updated accordingly.

Print and Post Invoice
When invoice gets printed then it will be posted with voucher date based on value in the Voucher
Date Base field. If the Voucher Date Base field is set to “Invoice Date” then voucher date will be
equal to value of the Invoice Date field. If the Voucher Date Base field is set to “Delivery Date” then
voucher date will be equal to value of the Delivery Date field (or the Latest Ship Date field in
customer order invoice).

Note: Value of the Voucher Date Base field has no impact on voucher date of invoices in following
cases:

o When invoice is printed from the Print Invoice page with the Use Voucher Date option
enabled.

¢ When invoice is processed from the Customer Invoices with Errors page with the Use
Voucher Date option enabled.

¢ When invoices are processed from the Create Collective Vouchers page.

5.7 Delimitations

e Manual customer invoices are not handled.
¢ Qutgoing supplier invoices are not handled.

Additional delimitations may apply; all relevant flows should be tested to ensure completeness.
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6 Discounted Price Rounding (moved to generic
functionality)

The functionality Discounted Price Rounding is removed as a country specific functionality. This is
now available as a generic functionality through the system toggle “Use Discounted Price
Rounding” in Company Settings. Information and more details can be found in the supply chain
News presentation for the IFS Cloud 25R2.
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7 Specific Data for Customer Invoice Reports

7.1 Overview Legal Requirement

The invoice layouts released with IFS Cloud standard version meet all the legal requirements for
Poland. There are some additional data which are typically printed on the invoices generated by
Polish companies that does not exist in the standard layouts.

7.2 Solution

The additional data fields are added to customer invoice report definition files (.RDF). This allows to
define new invoice report layouts according to requirements from Poland. Example data added are
company addresses, company tax id, information regarding VAT and gross amount. Also, some
changes in the existing functionality, e.g., presenting delivery address on collective invoices. New
Tax Character field is added to the Tax Codes page to group the tax types.

The following invoices reports are affected:

e Customer Order Invoice

e Customer Order Collective Invoice
e Prepayment Based Invoice

e Instant Invoice

Note
Generated xml file can be extracted from the Print Manager page. Select the relevant report RMB,
“save xml Data” will facilitate you to download xml to the local machine.

The major changes are:
» Company payment and document addresses are added to the report header
» Tax amount and gross amount are added to the report lines

« Company Tax ID is presented differently depending on whether the goods are delivered to a
domestic or a foreign customer

* Translatable texts TF or NT are added to invoice line depending on tax character attribute of tax
code (in Polish ZW, NP).

» Customer delivery address is added to the header of the collective invoice report when the address
is the same on all the invoiced orders. Otherwise, it will be presented in each invoice line separately

7.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“Specific Data for Customer Invoice Reports — Poland” parameter must be enabled.
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7.4 Set Up Basic Data Accounting Rules

The new column Tax Character is added to the Tax Codes page. The allowed values are “Normal”,
“Tax Free”, “No Tax” and “Export”. The value is set to “Normal” by default.

Tax Codes
Y B v t 4 ot B &8 Tax Texts per Tax Code Copy to Companies Translation Y

Tax Amount

Limitin

Tax Method Tax Tax Method Tax Tax Amount at Invoice ACCDUHUI‘Tg

{l] (%) Deductible (%) Valid From valid To Received Disbursed Printout (LH’I'EHC}’ Tax Repomng (ategmy Tax Character|

0 100 1/1/2020 12/31/2049 No Tax No Tax Separate from Price None No Tax
H 0 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
P23 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal
5 100 1/1/2020 12/31/2049 Invoice Entry Invoice Entry Separate from Price None Normal

The ‘No Tax’ value is allowed only for tax codes with Tax Type set to ‘No Tax’ or ‘Calculated Tax'.

The ‘Tax Free’ and ‘Export’ values are allowed for tax codes with 0% tax rate and with Tax Type
different than ‘No Tax'.

This function is used when printing customer invoices. When the value is either ‘Tax Free’ or ‘No
Tax’, a report text “TF’ or ‘NT’ can be printed instead of the tax rate (in Polish ZW, NP).

7.5 Print Customer Orderdebit Invoice

New fields have been added to the standard report data, and existing ones have been changed to
comply with the requirement. Specific changes for other invoice types are described in the next
chapters of the document.

File modified: ORDER/CustomerOrderlvc.rdf

Report Fields Added
* Company Addresses - Company payment address is included in the report header.

XML tags: COMPANY_PAY_ADDR_1 unti COMPANY_PAY_ADDR_7 is used for company
payment address.

Here is a company payment address:

<COMPANY_PAY_ADDR_1>Braty i kompany</COMPANY_PAY_ADDR_1>
<COMPANY_PAY_ADDR_2>Karpielowka 414</COMPANY_PAY_ADDR_2>
<COMPANY_PAY_ADDR_3>34-511 - Koscielisko</COMPANY_PAY_ADDR_3>
<COMPANY_PAY_ADDR_4>PL - POLSKA</COMPANY_PAY_ADDR_4>
<COMPANY_PAY_ADDR_5 xsi:nil="1"/>

<COMPANY_PAY_ADDR_6 xsi:nil="1"/>

<COMPANY_PAY_ADDR_7 xsi:nil="1"/>
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e Company Tax Identity Number - Company Tax Identity Number (NIP) is added to invoice
header. The value is fetched from the Tax ID Number column on the Company/Tax
Control/Invoice tab. The tax identity number consists of ten digits separated with dashes,
e.g., 123-456-78-90. It should always be registered in the system with ‘PL’ prefix, e.g., PL123-
456-78-90. The prefix or the dashes are removed from entered value depending on the
country defined in a customer delivery address settings.

» If the country is Poland or the country is not marked as EU member, then the ‘PL’ prefix is
removed from registered tax identity, e.g., 123-456-78-90

+ If the country is different than Poland and is marked as EU member, then the dashes are
removed from registered tax identity, e.g., PL1234567890

XML tag: COMP_TAX_ID_NUMBER
<COMP_TAX_ID_NUMBER>1112223344</COMP_TAX_ID NUMBER>

« Tax Amount and Gross Amount - New columns — Tax Amount and Gross Amount — have
been added to the invoice line. The values are retrieved from an invoice item.

XML tags: LINE_VAT_AMOUNT, LINE_GROSS_AMOUNT
<LINE_VAT_AMOUNT>354.2</LINE_VAT_AMOUNT>

<LINE_GROSS_AMOUNT>1894.2</LINE_GROSS_AMOUNT>

+ Tax Character — New column has been added to invoice line and tax totals. Value from this
column can be used to print tax free or no tax information (“ZW” or “NP” in Polish) instead of
tax rate 0%.

o Tax Character Tax Free: a translatable report text ‘TF is presented
o Tax Character No Tax: a translatable report text ‘NT is presented

XML tag: TAX_CHARACTER

- <INVOICE_LIMNE>
<TAXABLE>0<,/TAXABLE>
<MNOTE_TEXT xsi:nil="1"/>
<LOT_BATCH_NO xsi:nil="1"/>
<SERIAL_MNO xsi:nil="1"/=
<LINE_NO=3</LINE_NO=
< PREPAY_INV_NO xsi:nil="1"/=
< PREPAY_INV_SERIES_ID xsi:nil="1"/>
<TAX_CHARACTER=>TF</TAX_ CHARACTER>
<ORDER_LINE_POS>2</0ORDER_LINE_POS=>

. Signatures - Two new fields for the signatures of seller and buyer are added at the end of the
report.

New report text PURCHSIGN and SELLSIGN are defined.
<PURCHSIGN>Purch Sign</PURCHSIGN >

<SELLSIGN>Sell Sign</SELLSIGN>

Report Fields Changed
+ Totals and Tax Totals sections - The sections which present the information total invoice
amount and total amount per tax code have been redesigned. The column labels have been
removed from the tax totals sections and the required data (Price — Tax Base Amount, Tax
Rate, Net Amount and Gross Amount) are presented in the proper report line columns.

XML tag: TAX_AMOUNT, SHOW_SUB_TOTAL_ITEMS
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- <SUB_TOTAL_ITEMS>
- <SUB_TOTAL_ITEM=>
<FEE_AMOUNT>0</FEE_AMOUNT>
<SUB_TOTAL_AMOUNT>1000</SUB_TOTAL_AMOUNT>
<SUB_TOTAL_INCL_TAX>1230</SUB_TOTAL_INCL_TAX>
<TAX_AMOUNT>230</TAX_AMOUNT>
<SHOW_SUB_TOTAL_ITEMS>FALSE</SHOW_SUB_TOTAL_ITEMS>
</SUB_TOTAL_ITEM=>
</SUB_TOTAL_ITEMS>

7.6 Print Customer Order correction Invoice

According to legal requirements, the correction invoice contain information based on the original
invoice lines (retrieved for the corresponding debit invoice).

The Tax Totals section should not be shown in the Invoice before Correction section anymore. Only
one Tax Totals section presenting the information about the final correction amount per tax code is
shown at the end of the report.

File modified: ORDER/CustomerOrderlvc.rdf

7.7 Print Customer Order collective invoice

In IFS Cloud standard version, customer delivery addresses are always printed for each invoice line
separately. The Polish requirement states that the delivery address should be printed in the report
header when the goods have been delivered with the same delivery address. When printing
collection invoices, the system checks if a delivery address registered on all the invoiced customer
order headers is the same. If it is, then the address is presented in the header part of the report in
the same way like on debit invoices. Otherwise, it is handled as in standard: no information will be
presented in the header; the corresponding delivery addresses is present in the report data for each
invoice line.

Note: If the delivery address is specific for customer order lines (which are not marked as Default) it
is handled as an exception and is always presented under invoice line regardless of the mentioned
validation.

File modified: ORDER\CustomerOrderColllvc.rdf

7.8 Print Prepayment Based Debit/Credit Invoice

New fields have been added to the standard report layout and existing fields have been changed,
very similar to the customer order debit invoice:

. Company addresses and company tax id are added to the report header.

. Value printed in Tax Rate column depend on the Tax Character settings.

Also, the Prepayment Invoice Lines and Order Information sections which are shown in the report
details are redesigned. The existing logic for fetching the required data is not affected.
File modified: ORDER\CustOrderPrepayminvoice.rdf

Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_1',

comppayaddr1_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_2',

comppayaddr2_);

Country Solution POLAND 141



A,
S IFS

Xml_Record_Writer_ SYS.Add_Element(xml|_,'/COMPANY_PAY_ADDR_3/,
comppayaddr3_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR 4/,
comppayaddr4 );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_5',
comppayaddr5_);
Xml_Record_ Writer_ SYS.Add_Element(xml|_,/COMPANY_PAY_ADDR_6',
comppayaddr6_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_PAY_ADDR_7',
comppayaddr7_);
Xml_Record_Writer SYS.Add_Element(xml_,/COMPANY_ADDR_1', compaddr1_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_2', compaddr2_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_3', compaddr3_);
Xml_Record Writer SYS.Add_Element(xml_,/COMPANY_ADDR _4', compaddr4 );
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_5', compaddr5_);
Xml_Record_Writer_SYS.Add_Element(xml_,/COMPANY_ADDR_6', compaddr6_);
Xml_Record Writer SYS.Add_Element(xml_,/COMPANY_ADDR _7', compaddr7_);
Xml_Record Writer SYS.Add_Element(xml_,'OUR_REF', header_rec_.authorize_name);

Xml_Record Writer SYS.Add_Element(xml_,/COMPANY_VAT_NO', company_tax_no_);
Xml_Record_Writer SYS.Add_Element(xml_,/CUSTOMER_VAT_NO',
customer_tax_no_);

Xml_Record Writer SYS.Add_Element(xml_, '"TAX_CHARACTER,
Statutory _Fee APIl.Get_Tax_Character_db(company _, inv_line_rec_.vat_code));

7.9 Print Instant invoice

The changes are similar as for customer order debit invoice. The only exception is the customer
order information since they do not exist on the instant invoices (Delivery Term, Ship Via, CO
Number, Customer’s PO No, Delivery Note Number etc.).

File modified: INVOIC\Instantinvoice.rdf

TAX_CHARACTER
CUSTOMER_VAT_NO_PL

COMP_PAY_ADDR 1
COMP_PAY_ADDR_2
COMP_PAY_ADDR_3
COMP_PAY_ADDR 4
COMP_PAY_ADDR_5
COMP_PAY_ADDR_6
CURRENCY_CODE

7.10 Delimitations

No invoice print layouts are modified. It is only the RDF files that are changed. The RDL files (Report
layout) are modified in each implementation project.
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8 Round VAT Amount for Supplier Invoices in
Accounting Currency

8.1 Overview Legal Requirement

In Poland VAT is rounded to O decimals in customs documents. Due to art. 33a of Tax law, when
using simplified procedure for importing goods, tax disbursed is reported in VAT Declaration.
Therefore, when customs document is registered as supplier invoice, Calculated Tax functionality is
used in order to have both tax disbursed and tax received. It is not possible in that case to adjust tax
amount manually.

8.2 Solution

The following is added to support this requirement:
* Possibility to set up rounding to 0 decimals for a specific tax code of type “Calculated Tax”.

* Rounding of tax amount is performed in the Preliminary Supplier Invoice and Manual Supplier
Invoice pages.

PROCESS OVERVIEW

Enter Supplier

Define Basic Data Post Invoice View Vouchers

Invoice

8.3 Prerequisites

The company must be set-up to use Polish localization, see the Company Set up chapter and the
“‘Round VAT Amount for Supplier Invoices in Accounting Currency” parameter must be enabled.

8.4 Define Basic Data

Open the Tax Codes page and select the Round to 0 Decimals check box for tax codes which are
used when customs documents are registered as supplier invoices.

Tax Codes
AT LA t 7 W B 8 v Tax Texts per Tax Code Copy to Companies Translation
Tax Code ¥  Description ¥  TaxType ¥ More ¥ O Favorites  Clear H Settings
Round to 0

~/ : Tax Code Description Decimals Tax Type Tax (%) Deductible (%)
i IM-PUD Import of goods, simplified procedure, 0% m Calculated Tax 0 100

i IM-PU23 Import of goods, simplified procedure, 23%. Calculated Tax 23 100
i IM-PU23B Import of goods, simplified procedure, 23%, m Calculated Tax 23 100
IM-PU23S Import of goods, simplified procedure, 23%, m Calculated Tax 23 100

IM-PUS Import of goods, simplified procedure, 5%, v m Calculated Tax 5 100

IM-PUSB Import of goods, simplified procedure, 5%, v m Calculated Tax 5 100

IM-PUSS Import of goods, simplified procedure, 5%, ¢ m Calculated Tax 5 100

IM-PU8 Import of goods, simplified procedure, 8%, v m Calculated Tax 8 100
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Note that it is only possible to select this check box for tax code of type “Calculated Tax” with tax
received method “Invoice Entry” or “Final Posting” and deductible percentage set to 100.

As customs documents are always registered in PLN, only supplier invoices in accounting currency
are affected by this functionality.

8.5 Enter Supplier Invoice

Follow the IFS Cloud standard process to register supplier invoice via the Preliminary Supplier
Invoice or Manual Supplier Invoice pages. Use tax code with the Round to 0 Decimals check box
selected.

8.6 Post Invoice
Follow the IFS Cloud standard process to post the invoice.

8.7 View Vouchers
Follow the IFS Cloud standard process.

Follow the IFS Cloud standard process to view voucher. Tax amount posted on IP9 and IP10 posting
types is rounded to 0 decimals.

Voucher Rows
Yo B
Currency Debit  Currency Credit Currency Conversion  Accounting

v # ection  Trans Code Amount Amount Amount Currency Rare Factor  Currency

& IP5 139.00 139.00 1 1 PLN

@ IP1 139.00 -139.00 1 1 PLN

& IF10 32.00 -32.00 1 1 PLN

? IP9 32.00 32.00 1 1 PLN

In the example above net amount = 139.00 PLN, Tax % = 23% so tax amount is calculated in the
following way: round (139.00 * 0.23, 0) = round (31.97, 0) = 32.00.

8.8 Delimitations
No known.
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9 Polish Split Payment

9.1 Overview Legal Requirement

In July 2018 split payment model was introduced in Poland.

This model introduces additional VAT bank account for every company. The new bank
account is created in the same bank where the company has its regular bank account. The
access to the new bank account is limited.
When sending payment instruction to the bank, company can indicate that payment is to be
made in the split payment model. This requires including additional details, that is, VAT
amount, VAT identification number of the supplier and invoice number.
When bank (of the paying party) receives split payment instruction

o VAT amount is reposted from VAT account to regular account.

o Full payment amount is transferred to another bank according to the payment

instruction.

When bank (of the receiving party) receives split payment instruction

o Full payment amount is posted to regular account.

o VAT amount is reposted from regular account to VAT account.
The model is optional. However, if company receives payments via split payment model it is
forced to use this model also when sending payments since otherwise money will be blocked
on VAT bank account.
Split payment instruction can only be used when paying in PLN and from bank account in
PLN.
Split payment instruction must be created separately for each invoice.

Split Payment functionality is required for invoices in the accounting currency as well as for invoices
in the foreign currency.

In case of invoice in the accounting currency, either whole invoice or just VAT is paid in the
Split Payment model.

In case of invoice in the foreign currency, payment instruction must still be created in PLN
according to the Split Payment legislation. Therefore, in this scenario, only VAT is assumed
to be paid in PLN (with tax currency rate from the invoice). Net amount is to be paid in the
foreign currency, that is, according to standard functionality.

9.2 Process Overview

9.2.1

Define Basic

PROCESS OVERVIEW-PAYMENT TO SUPPLIER FOR THE INVOICES IN ACCOUNTING
CURRENCY

Create Supplier
Payment
Proposal

Create Supplier
Payment Order

Enter Supplier

Data Invoice
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9.2.2 PROCESS OVERVIEW - REPAYMENT TO CUSTOMER FOR THE INVOICES IN
ACCOUNTING CURRENCY

Create
Customer

Create
Customer
Payment Order

Create and
Print Customer
Invoice

Define Basic

Data Repayment

Proposal

9.2.3 PROCESS OVERVIEW - PAYMENT TO SUPPLIER FOR THE INVOICES IN FOREIGN
CURRENCY

Create Supplier
Payment
Proposal

Define Basic Enter Supplier
Data Invoice

Create Supplier
Payment Order

View View
View Payment Acknowledge Acknowledge
Order ltems Supplier Payment
Payment Order Details

Acknowledge

Supplier Approve Mixed Cancel Mixed
Payment in Payment Payment

Mixed Payment

Load into Mixed

Payment/Create
Mixed Payment

9.3 Solution Overview

9.3.1 SOLUTION FOR INVOICES IN THE ACCOUNTING CURRENCY

Solution is based on the First Installment only Tax functionality of payment terms (standard
functionality). All invoices that are to be paid with split payment instruction must use payment terms
with this setup.
In addition, the following has been changed to support the requirement for invoices in the accounting
currency:
¢ New column and new field are introduced in the basic data for payment institutes so that it is
possible to indicate that payment instruction should be created in the split payment variant.
o PLBREPLN and 1SO20022 payment formats are adjusted to handle split payment.

This functionality is available for supplier payment order flow and customer repayment order flow.
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9.3.2 SOLUTION FOR INVOICES IN THE FOREIGN CURRENCY

The following has been additionally changed to support the requirement for invoices in the foreign
currency:
¢ New column and new field are introduced in the basic data for payment institutes so that it is
possible to indicate whether tax installment from foreign currency invoice should be paid in
the accounting currency.
o When creating payment order, selection rules related to currency are changed.
e New columns are introduced in the payment order and acknowledge payment to indicate tax
installment paid in the accounting currency and currency of the invoice.
¢ PLBREPLN and ISO20022 payment formats are adjusted to handle tax installment of foreign
currency invoice paid in the accounting currency.

This functionality is available only for supplier payment order flow.

9.4 Prerequisites

The company must be set-up to use Polish localization, see the Company Set-Up chapter. The
parameter “Polish Split Payment” should be enabled.

9.5 Define Basic Data for Basic Solution for Invoices in the Accounting
Currency

Follow the IFS Cloud standard process to define basic data:

¢ In the Format Specific Info per Institute page (available from Payment Institutes page,
Payment Methods per Institute command, Format Specific Info per Institute command)
setup payment formats details as required by the bank. In case of ISO20022 format, make
sure not to select the Structured Payment option.

¢ In order to handle payment to supplier, in the Payment Addresses page (available from the
Supplier/Payment tab, Electronic Payment Addresses command) setup payment format
details as required by the bank.

¢ In order to handle repayment to customer, in the Payment Addresses page (available from
the Customer/Payment tab, Electronic Payment Addresses command) setup payment
format details as required by the bank.

¢ Inthe Payment Terms page, define payment term with “First Installment only Tax” selected
in the Tax Distribution field. Use this payment term when entering/creating invoices within
this process.

9.5.1 SETUP SPLIT PAYMENT FOR INVOICES IN THE ACCOUNTING CURRENCY

9.5.1.1 PLBREPLN format (BRE Bank/mBank)

For PLBREPLN format, the Split Payment feild is added to the Format Specific Info per Institute
page (available from Payment Institutes page, Payment Methods per Institute command, Format
Specific Info per Institute command).

Use this field to setup split payment. The following options are available:
¢ Not Used
e Optional
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e Mandatory

See chapter Split payment options for description of the options.

n N n N i _ o Do " % D P JE T _ e - ~ P - — e |
@ > Finandials > Payment Basic Data » Cash Book » Payment Institutes > Payment Methods per Institute > Format Specific Information per Institute - BRE - BREPLN &

Format Specific Information per Institute - BRE - BREPLN

row |
Format D Split Payment Use Acc Curr for Tax Instaliment
PLBREPLN Optional - «

9.5.1.2 1S020022 format

For ISO20022 format, the Split Payment field is added to the Format Specific Info per Institute page
(available  from  Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command).

Use this field to setup split payment. The following options are available:
¢ Not Used

e Optional
o Mandatory

See chapter Split payment options for description of the options.

@ > Fnancials > Payment Basic Data > Cash Book > Payment Institutes > Payment Methods per Institute > Format Specific Information per Institute - BANK - 1020022 i

Comgzny [ Chmalk Polish Company_
Format Specific Information per Institute - BANK - 15020022
sw |

L gl aye Tl CASH ACCOUNT INFORMATION 4
File Template XML Schema Version

CORE ~ 001.001.03 %

Initiating Party Identification Information Debtor/Division Identification Information

BICOrBE| Initiating Party ID Repeat in Debtor [dentification Leve! Debtor/Division 1D Repeat in Intiating Party Identification Level Hide From Debtor Level

Initiating Party Identification Scheme Name Debtor/Division |dentific

Code Issu

Payment Parameters Credit Notes Grouping For Structured Payment

Charge Bearer Level Payment Type Info Level Create Separate Payment Information per Curren Maximum Gccurences Allow Credit Grouping for Non-SEPA Payments Allow Credit Grouping for SEPA Payments

Detailed Postal Address Batch Booking ed Pay

Natienal Bank Code for Repayment
Polish Split Payment Parameters.
Spiit Payment. Use Acc Curr for Tax Installment
Optional -
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9.5.1.3 Split payment options

The following options are available for split payment:

e Not Used
o Standard payment instruction is created.
e Optional

o Split Payment instruction is created for invoices with “First Installment only Tax” setup
as long as first installment is included in the payment order.

o Other payment transactions can be included in the same payment order.

e Mandatory

o Only invoices with “First Installment only Tax” setup can be included in the payment
order.

o Iffirst installment of the invoice is included, split payment instruction is created.

o If first installment of the invoice is not included, standard payment instruction is
created for other installments.

o Other payment transactions cannot be included in the same payment order.

o This option makes it possible to setup the system so that all payments to unreliable
supplier are handled via split payment method.

9.6 Define Basic Data for Solution for Invoices in the Foreign currency

9.6.1 SETUP SPLIT PAYMENT FOR INVOICES IN THE FOREIGN CURRENCY

9.6.1.1 PLBREPLN format (BRE Bank/mBank)

For PLBREPLN format, the Use Acc Curr for Tax Installment field is added to the Format Specific
Info per Institute page (available from Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command). Select this option in order to pay tax
installment, that is, first installment of the invoice with “First Installment only Tax” setup, in the
accounting currency.

Also select value in the Split Payment field in the similar way as for invoices in the accounting
currency.

@ > Financials > Payment Basic Data > Cash Book > Payment Institutes > Payment Methods per Institute » Format Specific Information per Institute - BRE - BREPLN (5

Format Specific Information per Institute - BRE - BREPLN

s w |

Format ID Split Payment Use Acc Curr for Tax Installment

PLBREPLN Optional - «
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9.6.1.2 1S020022 format

For 1ISO20022 format, the Use Acc Curr for Tax Installment field is added to the Format Specific
Info per Institute page (available from Payment Institutes page, Payment Methods per Institute
command, Format Specific Info per Institute command). Select this option in order to pay tax
installment, that is, first installment of the invoice with “First Installment only Tax” setup, in the
accounting currency.

Also select value in the Split Payment field in the similar way as for invoices in the accounting
currency.

® > Financials > Payment Basic Data > Cash Book > Payment Institues > Payment Methods per Institute > Format Specific Information per Institute - BANK - 15020022 1 Compan,
Format Specific Information per Institute - BANK - 1S020022

sow
Lt g i eyl Tl CASH ACCOUNT INFORMATION 4 »
File Template XML Schema Version

CORE ~ 00100103 )

nitiating Party Identification Information Debter/Division |dentificatien Information

BICOTBEI nitting Party ID Repeat in Debtor Identification Level Debtor/Division ID Repeatin Irtiating Party Idenification Leve! Hide From Debtor Leve!

nitiating Party Identification Scheme Name Debtor/Division Identification Scheme Name

Credit Notes Grouping For Structured Payment

Polish Split Payment Parameters

SplitPayment use
Optional .«

9.7 Details of Basic Solution for Invoices in the Accounting Currency

9.7.1 ENTER SUPPLIER INVOICE

Follow the IFS Cloud standard process to enter supplier invoice.

Make sure to enter invoice in “PLN”. Also make sure to use payment terms with “First Installment
only Tax” specified in the Tax Distribution field.

9.7.2 CREATE SUPPLIER PAYMENT PROPOSAL
Follow the IFS Cloud standard process to create and acknowledge supplier payment proposal.

9.7.3 CREATE SUPPLIER PAYMENT ORDER
Follow the IFS Cloud standard process to create supplier payment order.
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9.7.3.1 PLBREPLN format
X New Payment Order

N
.:- Payment Order Information —{ = Cash Accounts Infarmation
\_/

Selected Proposals

5

Payment Methad

BREPLN - BRE domestic format in PLN

Only Instaliments Specified with Default Payment Method

Payment Institute

BRE - BRE Bank in Poland

Currencies

Payment Date Cash Account

= -

»  Next Cancel

Note split payment details in the output file for PLBREPLN format

¢ VAT amount after “/VAT/

o Supplier tax identity number after “/IDC/”
e Invoice number after “/INV/”

e Optional text after “/TXT/”

[ ]

“53” instruction (instead of standard “51”)

| BREPLN.DAT - Notepad

- ] X
File Edit Format View Help
D/Add Add2/ZIP city”,"CH-SUPPLIER1/Add @1 Add ©2/ZIP City/",0,18300004,)/VAT/230,00/IDC/123456X1/INV/08/01-|01/TXT/||}, ", 1,53 """
D/Add Add2/ZIP city","CH-SUPPLIER1/Add @1 Add @2/ZIP City/",@,18300004,)'/VAT/230,00/IDC/123456X1/INV/08/01-|02/TXT/||[,""," "L, "53"|""

Also note the following
¢ In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.

¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.7.3.2 1S020022 format

X New Payment Order

N
.:- Payment Order Information ={ = Cash Accounts information
\_/

Selected Proposals Payment Method

4 —

022 - IS0 20022 Payments

Only Instaliments Specified with Default Payment Method

Payment Institute

BANK - Bank in Poland

4
ES
I

Payment Date Cash Account

= -

> Next Cancel
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Note split payment details in the output file for ISO20022 format (unstructured variant)
e <Priry> tag
o “SPLT”
e <Ustrd>tag
o VAT amount after “/VAT/”
o Supplier tax identity number after “/IDC/”
o Invoice number after “/INV/”
o Optional text after “/TXT/”

<CdtTrfTxInf>
- <Pmtld=>
<Instrid=798/2021-08-01/1<=/Instrid >
<EndToEndld=798/2021-08-01/1</EndToEndld=>
</Pmtld=
- «PmtTpInf>
<InstrPrty >NORM</InstrPrty =
- <Svelvl>
<Cd=NURG</Cd=
=/Svclvl=
- <CtgyPurp>
<Prry>SPLT</Prtry> |
LLI_.")’I‘LI[IJ
</PmtTpInf>
- <Amt>
<InstdAmt Ccy="PLN">1230.00</Instd Amt=>
</Amt=
- =Cdtr>
<Nm=PL Supplier 01</Nm>
- <Pstladr>
<Ctry=PL</Ctry>
=/PstlAdr=
</Cdtr> [:}
- =CdtrAcct>
- <Id=
- <0thr=
<1d=>123456</Id>
- <SchmeNm=
<Cd=BBAN</Cd>
=/SchmeNm=
</Othr=
</Id=
<fCdtrAcct=
- =RgltryRptg >
<DbtCdtRptgIlnd>DEBT</DbtCdtRptgInd >
- <Dtls>
<Cd /=
<Inf /=
=/Dtls=
</RgltryRptg>
- <RmtInf>
[<Ustrd>/VAT/230,00/IDC/123456/INV/08/01-02/TX1/,08/01-02/2</Ustrd> |
<RIMCInT =
</ CdtTHTxInf=
=/PmtInf=
</ CstmrCdtTrfInitn=
</Document=

Also note the following
¢ Inthe standard version, unstructured 1ISO20022 format creates common payment instruction
for multiple invoices from the same supplier.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.
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9.7.4 CREATE AND PRINT CUSTOMER INVOICE
Follow the IFS Cloud standard process to create and print customer correction invoice with negative
total amount.

Make sure to create invoice in “PLN”. Also make sure to use payment terms with “First Installment
only Tax” specified in the Tax Distribution field.

9.7.5 CREATE CUSTOMER REPAYMENT PROPOSAL
Follow the IFS Cloud standard process to create and acknowledge customer repayment proposal.

9.7.6 CREATE CUSTOMER REPAYMENT ORDER
Follow the IFS Cloud standard process to create customer repayment order.

9.7.6.1 PLBREPLN format
X New Payment Order

.:- Payment Order Information ={  }= Cash Accounts Informarion

S | | BREPLN - BRE domestic format in PLN -

E Bank in Poland - | |PLN

=]

b Next Cancel

Note split payment details in the output file for PLBREPLN format
e VAT amount after “/VAT/”
e Customer tax identity number after “/IDC/”
¢ Invoice series and number after “/INV/”
e Optional text after “/TXT/”
e “53” instruction (instead of standard “51”)
|

File Edit Format View Help
Add2/7IP city","chmalk Polish customer @1/Add @1 Add @2/ /",@,183@@@@4,I/VAT/ZBB,@@/IDC/lZ}AGS/INV/FS@S/@Zf|@1/TXT/||",'","" EEN B

Also note the following
¢ In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.7.6.2 150202222 format
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New Payment Order

TN
..:. Payment Order Information ={ = Cash Accounts Information
\_/

Selecte: Payment Method
3 E 5020022 - ISO 20022 Payments -
Only Installments Specified with Defauft Payment Meth

Payment Institute
BANK - Bank in Poland

Payment Date

]

> Next Cancel

Note split payment details in the output file for ISO20022 format (unstructured variant)
e <Prtry>tag
o “SPLT”
e <Ustrd> tag
o VAT amount after “/VAT/”
o Customer tax identity number after “/IDC/”
o Invoice series and number after “/INV/”
o Optional text after “/TXT/”
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- <CdtTrfTxInf=
- <Pmtid=
<Instrld=841/2021-08-02/1</Instrid>
<EndToEndld=841/2021-08-02 /1 </EndT oEndld=
=/Pmtld=
- <PmtTplInf=>
<InstrPrty =N ORM-</InstrPriy >
- <Swvclvl=
=Cd=NUGP=/Cd>
< Svclvlz
- <CtgyPurp:=
mem
< ogyrag
</PmtTpInf=>
- <Amt>
<InstdAmt Ccy="PLN">1230</InstdAmt=>
<fAmt=
- =Cdtr=
<Nm=>CHMALK-PL</Nm>
- <PstlAdr=
<Ctry=PL</Ctry>
</ PstlAdr=
=/Cdtr=
- <CdtrAcct=
- <Id>
- <0thr=
=Id=123465</1d>
- =SchmeNm:=
<Cd=>BBAN</Cd=>
=/SchmeNmz=
</0thr=
</ Id=>
<f/CdtrAcct>
- =Rmtinf=
mm
<RI,
</ CdtTrfTxInf>
</PmtInf=
</CstmrCdtTrfInitn>
</Document =

Also note the following
¢ In the standard version, unstructured 1ISO20022 format creates common payment instruction
for multiple invoices from the same customer.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.

9.8 Details of Solution for Invoices in the Foreign Currency

9.8.1 ENTER SUPPLIER INVOICE

Follow the IFS Cloud standard process to enter supplier invoice.

Make sure to enter invoice in the foreign currency. Also make sure to use payment terms with “First
Installment only Tax” specified in the Tax Distribution field.

9.8.2 CREATE SUPPLIER PAYMENT PROPOSAL
Follow the IFS Cloud standard process to create and acknowledge supplier payment proposal.

9.8.3 CREATE SUPPLIER PAYMENT ORDER
Follow the IFS Cloud standard process to create supplier payment order.
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9.8.3.1 Changed Selection Logic

When invoices are loaded into payment order, currencies specified in the Currencies field in the
Create Payment Order dialog box affect selection of invoices into payment order.

X New Payment Order

.:- Payment Order Information =  J= Cash Accounts Information

BANK - Bank in Poland M I

=) -

b Next Cancel

In the standard system it is currency of the invoice that is considered in this process. This logic has
been adjusted so that tax installment of the foreign currency invoice can be paid in the accounting
currency.

The changed logic is the following:

e The Currencies field in the Create Payment Order dialog box indicates currency of the
payment.

¢ If the Use Acc Curr for Tax Installment field in the basic data is not selected, invoices will
be selected to the order as long as value of the Currencies field matches invoice currency.
Same logic as in the standard system.

¢ Ifinvoice included in the proposal has the Tax Distribution field set to value other than “First
Installment only Tax”, it is selected to the order as long as value of the Currencies field
matches invoice currency. Same logic as in the standard system.

¢ Ifinvoice included in the proposal has the Tax Distribution field set to “First Installment only
Tax”, net installments (Installment ID <> 1) are selected to the order as long as value in the
Currencies field matches invoice currency. Same logic as in the standard system.

o If the Use Acc Curr for Tax Installment check box is selected and invoice included in the
proposal has the Tax Distribution field set to “First Installment only Tax”, existing logic is
changed for tax installment (Installment ID = 1)

o Regardless currency of the invoice, installment is selected to the order only if
accounting currency (PLN) is included in the selection specified in the Currencies
field.

See example scenarios:
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All Installments
excluded

All Installments

excluded

Instaliment No 1 included

Use Acc Curr for
Tax Installment No
Invoice: USD >
Currencies: PLN g
Yes
First Installment Mo
only Tax
Yes
Use Acc Curr for
Tax Installment No
Invoice: USD .
Currencies: % -
Yes
First Installment No
only Tax
Yes

Use Acc Curr for

Tax Installment
Invoice: USD

.
i

Currencies: USD

No

No

Yes

First Instaliment
only Tax ’
‘ Yes

9.8.3.2 Create Supplier Payment Order — Cash Accounts

and paid in PLN

Installiment No 2 excluded

All Installments included
and paid in USD

All Installments included
and paid in USD

Instaliment No 1 included
and paid in PLN

Instaliment No 2 included
and paid in USD

All Installments included
and paid in USD

All Instaliments included
and paid in USD

Installment No 1 excluded

Instaliment No 2 included
and paid in USD

Country Solution POLAND 157



\\\\',,
=" IFS

When payment order is created, cash accounts to be used for payment can be specified with respect
to currency.

X New Payment Order

(" V= payment Order information =.=- Cash Accounts Information

Payment Method

5020022 BANK

In the standard system currencies displayed in the Currency column in the Cash Accounts dialog
box correspond to currencies of the invoices included to the payment order. This logic has been
adjusted to consider scenario when tax installment of the foreign currency invoice is paid in the
accounting currency. As a result, the displayed currencies correspond to payment currencies.

Example 1
e Only foreign currency invoices are included in the payment order.

e “First Installment only Tax” is selected in the Tax Distribution field in the Payment Terms
page for the payment term used in the involved invoices.
¢ Only first installments are included in the payment order.
According to the standard logic, only foreign currencies are displayed in the Cash Accounts dialog
box.
When the Use Acc Curr for Tax Installments check box is selected, only accounting currency is
displayed in the Cash Accounts dialog box.

Example 2
e Only foreign currency invoices are included in the payment order.

o “First Installment only Tax” is selected in the Tax Distribution field in the Payment Terms
page for the payment term used in the involved invoices.
e First and other installments are included in the payment order.
According to the standard logic, only foreign currencies are displayed in the Cash Accounts dialog
box.
When the Use Acc Curr for Tax Installments check box is selected, foreign currencies and
accounting currency are displayed in the Cash Accounts dialog box.

9.8.3.3 PRBREPLN format
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x New Payment Order

TN
.:- Payment Order Information = = Cash Acco
S

Selected Proposals Payment Method

5 =|| | BREPLN - BRE domestic format in PLN -
Only Installments Specified with Default Payment Method
Payment Institute Currencies
BRE - BRE Bank in Poland > | |PLN =
Payment Date Cash Account
& -
b Next Cancel

Note split payment details in the output file for PLBREPLN format
e VAT amount after “/VAT/”

Supplier tax identity number after “/IDC/”

Invoice number after “/INV/”

Optional text after “/TXT/”

“563” instruction (instead of standard “51”)

Also note that total amount of the payment instruction as well as VAT amount are expressed in the
accounting currency.

| BREPLN.DAT - Notepad - O X
File Edit Format View Help

)lish Co.LTD/Add Add2/ZIP city","CH-SUPPLIER1/Add @1 Add €2/7IP City/",@,183@8@@4,|/VAT/238@,@8/IDC/123456X1/INV/’@E/@2|—@1/TXT/| |'I,"",""I"53"I""

Also note the following

¢ In the standard version, PLBREPLN format creates single payment instruction for each
payment proposal item.
¢ In case of split payment instruction this logic is changed so that single payment instruction is

created per invoice.
9.8.3.4 15020022 format

X New Payment Order

N
.:- Payment Order Information ={ = Cash Accounts information
\_

Selected Proposals

4

nly Instaliments Specified with Default Payment Method

Payment Institute

BANK - Bank in Poland - | |%

Payment Date Cash Accourt

b Next Cancel
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Note split payment details in the output file for ISO20022 format (unstructured variant)
o <Prtry>tag
o “SPLT”
e <Ustrd>tag
o VAT amount after “/VAT/”
o Supplier tax identity number after “/IDC/”
o Invoice number after “/INV/”

o Optional text after “/TXT/”
Note currency and amounts details in the output file for ISO20022 format (unstructured variant)

e <InstdAmt> tag

o Currency “PLN” and amount in the accounting currency
e <Ustrd>tag

o VAT amount in the accounting currency

- <CdtTrfTxInf>
- <Pmtld>
<Instrid>=152/2021-05-15/ 1</Instrid=>
<EndToEndld>=152/2021-05-15/1</EndToEndld=>
</Pmtid=
- <PmtTpInf=
<InstrPriy >NORM </InstrPriy >
- <Sveclvl=
<Cd>NURG</Cd=>
</Svelvl=
- <CtgyPurp>

<Priry>SPLT</Priry=
< R

</ PmtTpInf=
= =AINC
<Instdamt Ccy="PLN">2300.00</InstdAmt=>

P—

- <Cdtr>
<Nm=PL Supplier 01</Nm=>
- <Pstladr>
<Ctry=PL</Ctry>
</PstlAdr=
</ Cdtr=
- <CdtrAcct>
- <Id>
- <Othr>
<I1d>=123456</1d>
- <SchmeNm=
<Cd=BBAN</Cd=>
</SchmeNmz=
<fOthr=
«</ld=>
</ CdtrAcct=>
- <RgltryRptg >
<DbtCdtRptgInd>DEBT</DbtCdtRptglnd=>
- <Dtls>
<Cd /=
<Inf /=
«/Dtls=
</RgltryRptg >
- <Rmtinf=>
Ustra=/VAT/2300,00/IDC/123456/INV/05/10-04 /TXT, Ustrd=
d LT f

Also note the following
¢ In the standard version, unstructured 1ISO20022 format creates common payment instruction
for multiple invoices from the same supplier.
¢ In case of split payment instruction this logic is changed so that single payment instruction is
created per invoice.
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9.8.4 VIEW PAYMENT ORDER ITEMS
New Tax Installment in Acc Curr and new Invoice Currency columns are added in the Payment
Order Items page:
e The Tax Installment in Acc Curr indicator is selected when tax installment of the foreign
currency invoice is paid in the accounting currency.
e When the Tax Installment in Acc Curr is selected:

O
O
O

® > Financials > Accounts Payable >

Invoice currency is displayed in the Invoice Currency column.

Payment currency is displayed in the Currency column.

Payment amount in the invoice currency is displayed in the Pay Amount in Inv Curr
column.

Payment amount in the payment currency as well as in the accounting currency is
displayed in the Pay Amount in Acc Curr column.

Payment amount in the accounting currency is calculated using tax currency rate from
the invoice.

upplier Payment Proposal > Supplier Payment Orders » Supplier Payment Order Details &3 Company [ Chmalk Polish Company.

Supplier Payment Order Details 1s2-1s020022-2ank » 1011

I CHMALKPL  Upad

i CHMALKPL  Unad

I —— 24 05/06-04 L 2 @ PL SUPPLIER 01 - PL Supplier 01 1000.00 USD 400000 (9

owledgad

[» =~ [v]
Payment ¢  Da Pay yment Institute
152 1S BANK - Bank in Poland
User
€M) CHmALK
Order Items
Print Order =1
Payment One- Tax
In Advan) Series Instaliment Time Pay Amountin Currency  Pay Amountin | Instaliment
i | Company Status Advance  Invaicy D Inv/Prepaym Ne. D Identity Suppli InvCurr | Currency Rate AccCurr InAcc Curr | Invoice Currency
i | CHMALKPL | Unacknowledged u m Fz 05/10-04 1 @ PL SUPPLIER 01 - PL Supplier 01 @ 23000 | PLN 230000 0 usb
—
t | CHMALKPL  Unacknowledged u u 74 05/10-04 2 a PL SUPPLIER 01 - PL Supplier 01 1000.00 | USD 4000.00 m
i CHMALKPL  Upacknewledged @ u FZ 05/10-01 2 @ PL SUPPLIER 01 - PL Supplier 01 1000.00 | USD 4000.00 @
IOCHVALKPL  unacnowkezes () (D)

-]
o
Fz 05/07-01 2 @ PL SUPPLIER 01 - PL Supplier 01 0 1000.00 | USD 400000 (@
o
o

FZ 05/06-03 2 @ PL SUPPLIER 01 - PL Supplier 01 1000.00 | USD 400000 (9

9.8.5 VIEW ACKNOWLEDGE SUPPLIER PAYMENT ORDER

When tax installment of the foreign currency invoice is paid in the accounting currency, payment
amount in the accounting currency related to this installment affects total amounts in the
Acknowledge Supplier Payment Orders page for a line with accounting currency in the Currency

column.

ayable > Supplie

Company [ Chmalk Polish Company-

Acknowledge Supplier Payment Orders

Update Payment Status B~

Grouping Criteria : Payment Order ID ~ @ Reset Clear (Q Serttings

Payment
Daz

&
@

5/15/2021

5/15/2021

72112021

8/1/2021

8/1/2021

8/1/2021

8172021

8/1/2021

Bank Payment Feein
Payment Transaction Amount  CashAmountin  Amountininy  PayAmountin | Feein Payment Accounting | Cash flcforFee | Cash Account

padhent Orcer  Instute Payment Method Code Currency | Cash Account Cashamount  Incluging Fees Acc Curr Curr Acccurr currency Currency | inAccffurr Currency Rate

15; BANK 15020022 & PLN BANK-PLN 2300.00 2300.00 2300.00 2300.00 2300.00 0.00 0.00

15; BANK 15020022 & uso BANK-PLN 5000.00 20000.00 20000.00 5000.00 20000.00 0.00 0.00

597 BANK 15020022 & usD BANK-PLN 1000.00 4000.00 400000 1000.00 4000.00 0.00 000

797 BRE BREPLN & PLN BRE-PLN 1230.00 1230.00 1230.00 1230.00 1230.00 0.00 0.00

798 BANK 15020022 & PLN BANK-PLN 1230.00 123000 1230.00 123000 1230.00 0.00 000

801 BRE BREPLN & PLN BRE-PLN 2300.00 2300.00 2300.00 2300.00 230000 0.00 000

804 BANK 15020022 & PLN BANK-PLN 2300.00 2300.00 2300.00 2300.00 2300.00 0.00 0.00

804 BANK 15020022 & usD BANK-PLN 1000.00 4000.00 4000.00 1000.00 4000.00 0.00 000
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9.8.6 VIEW ACKNOWLEDGE PAYMENT DETAILS
New Tax Installment in Acc Curr and new Invoice Currency columns are added in the
Acknowledge Payment Details page:
e The Tax Installment in Acc Curr indicator is selected when tax installment of the foreign
currency invoice is paid in the accounting currency.
e When the Tax Installment in Acc Curr is selected:

(@)
O
O

Payment Order Details

5/15/2021 BANK BANK-PLN

e 3 untin | Pay Amountin Inst
ed Invoice  SeriesID Inv/Prepaym No D igenthy I Cure AccCurr InAce Curr | Invoice Currency

Invoice currency is displayed in the Invoice Currency column.

Payment currency is displayed in the Currency field in the page header.

Payment amount in the invoice currency is displayed in the Pay Amount in Inv Curr
column.

Payment amount in the payment currency as well as in the accounting currency is
displayed in the Pay Amount in Acc Curr column.

Payment amount in the accounting currency is calculated using tax currency rate from
the invoice.

Payment Order Details 2 ompany [ Chmalk Polish Company.

[~ ] fz 05/10-04 1 @ PLSUPPLIER 01 - PL Supplier 01 230,00 20000 8 usD

9.8.7 ACKNOWLEDGE SUPPLIER PAYMENT IN MIXED PAYMENT

Follow the IFS Cloud standard process to enter mixed payment with acknowledge supplier payment
order transaction. When acknowledge supplier payment transaction is saved, invoices are
automatically matched with the lump sum transaction.

e Transactions with the Tax Installment in Acc Curr field selected (in the Acknowledge
Payment Details page) are considered when matching lump sum transactions in the
accounting currency.

e Payment amount in the invoice currency is fetched from the Pay Amount in Inv Curr field
from the Acknowledge Payment Details page.

¢ Payment amount in the payment currency and payment amount in the accounting currency
are fetched from the Pay Amount in Acc Curr field from the Acknowledge Payment
Details page.

e Tax currency rate from the invoice is fetched into the Currency Rate field.
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® > Financials > Cash Baok > Mixed Payment & Compary [ Chmalk Polish Company.

Search

Payment Status ¥  StatementNo ¥  PaymentDate ¥  More ¥ ' Favorites  Clear Q i semings

Group  Q Sewings

B NotApproved
Mixed Payment BANK-PLN-3-5/15/2021 ¥ -
» & Ve W& New Transaction Approve Print Mixed Payment Notes Check Collection Level Q
Transaction Balances
Cash Account Statement No Remaining Amount Debit
BANK-PLN 3 2300.00
Credit Debit Amount in Acc Curr Credit Amount in Acc Curr
0.00 2300.00
Transaction Details
s Open supplier Bills  Open Issued Checks  Open Planned Non-Supplier Payments  Copy Canceled Customer Check =
Total Pay Amountin  Debi
Lo sum Lump Sum Trans Amountin Acc Debit Amountin | Crecic Amount Paralle
st Tranglumber  Payment Transaction Type Date Currency CurrencyRate TaxCurrRate  Order 1D Amount  DebitAmount]  Credit Amourt Curr Acc Curr in Acc Curr Currency
1 Acknowledge Supplier Payment Order 5/15/2021 PLN 1 1152 -2300.00 2300.00 -2300.00 2300.00 -460.00
Atzachments @ ~
. Fait Transace [ Dot Polish Company. |

View/Edit Transactions 1 ~ o

Matched Transactions Details

9.8.8 APPROVE MIXED PAYMENT

Follow the IFS Cloud standard process to approve mixed payment.

Postings are created and transactions are removed from the Supplier Payment Orders and
Acknowledge Supplier Payment Orders pages.

9.8.9 CANCEL MIXED PAYMENT

In case of mistakes in payment registration, follow the IFS Cloud standard process to cancel mixed
payment.

Postings are reversed and transactions are recreated in the Supplier Payment Orders and
Acknowledge Supplier Payment Orders pages, including new Tax Installment in Acc Curr check
box and new Invoice Currency column.

9.8.10 LOAD INTO MIXED PAYMENT/CREATE MIXED PAYMENT FROM EXTERNAL PAYMENT
Follow the IFS Cloud standard process to load bank statement transactions from CAMT file into the
Mixed Payment page, that is:
¢ Place the file under respective IN folder. The file is loaded automatically, and details are
displayed in the External Payments and External Payment Details pages.
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Select Match & Check All Item command.

Select Load Into Mixed Payment or Create Mixed Payment command.

Transaction of type “Acknowledge Supplier Payment” is created on the Mixed
Payment/Transactions tab.

When transaction with the Tax Installment in Acc Curr field selected (in the Acknowledge Payment
Details page) is loaded into the Mixed Payment/Transactions tab, currency, currency rate and
amounts are handled in the same way as described in the “Acknowledge Supplier Payment Order
in the Mixed Payment” chapter.

9.9 Delimitations

Split Payment for invoices in the accounting currency is only available in supplier payment
order flow and customer repayment order flow.

Split Payment for invoices in the foreign currency is only available in supplier payment order
flow.

1ISO20022 format is only supported in the unstructured variant, based on information from
ING bank.

Split payment is not supported for invoice with payment reference or remittance.

Payment order with split payment for foreign currency invoices can only be acknowledged
from the mixed payment.

Rounding to nearest is always used after recalculating tax amount from the foreign currency
to the accounting currency with a use of tax currency rate.

Additional delimitations may apply; all relevant flows should be tested to ensure completeness.

Country Solution POLAND 164



\\\1/

10 Access Control for Inventory Transactions and
Reservations

10.1 Overview of Legal Requirements

In Poland, warehouse manager or other personnel must be appointed by management as acting
authority for material located in warehouses. This is a legal requirement. Due to this requirement
only, authorized personnel may change quantity and/or value of material in warehouses. Warehouse
access authorization is required to prevent any inventory transactions or reservations to be executed
by unauthorized personnel.

10.2 Solution

In IFS Cloud standard version IFS Cloud users are connected to sites and this connection
determines the possibility to reserve inventory parts or conduct operations which are resulting in
inventory transactions.

For IFS Polish Localization an additional level of authority is added where IFS Cloud users are
connected to warehouses and given the authority to perform inventory transactions and make
reservations.

Making Reservation Allowed

e N
i :

" \\ User's Inventory
' Source of S, Inventory Access reservation

4 . i

1 Demand ’ reservation Rights Completed
: S OK?

————————— /

Reservation
Not
Completed

Perform Transaction Allowed

e — N
: N

N Inventor
. gource (;)f ;» Inventory Transactic))/n
1 Deman i P
" // Transaction Completed
1
————————— 4

Transaction
Not Completed
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Basic Data: A basic data page is added where the authority is set up per user over warehouses in
a site. This page is Warehouse Access.

Inventory transactions: Controls are added when a user is saving inventory operations (e.g.
receipt, scrap, pick, move, transfer between warehouses, revaluation etc.):
e |f access has been granted the user can register the operation.
e |f access has not been defined or not granted an error message is displayed and the user
cannot proceed.

Reservations: Controls are added when a user is reserving inventory parts (e.g., customer order,
work order, shop order, material requisition):
e |[f access has been granted the user can reserve the quantity.
e |f access has not been defined or not granted an error message is displayed and the user
cannot proceed.

10.3 Prerequisites
The company must be set-up to use Polish localization.

Warehouse Access

Use the Warehouse Access page to give users access to make reservations or/and transactions.
Users can be added to this page and the access can be controlled over inventory reservation and
transaction as required. To control an inventory transaction, enable/disable the option in the column
“‘Making Stock Reservation Allowed”. To control an inventory reservation, enable/disable the
option in the column, “Making Stock Reservation Allowed”.

Search  Advanced

User: LALWLK ~ @ Warehouse ¥ Performing Inventory Transaction Allowed ¥  More ¥  © Favorites  Clear Q Settings

Warehouse Access

= ¥ B 7 =l
Making Stock Reservation  Performing Inventory Transaction
v P User Site Warehouse Allowed Allowed
@ LALWLK - Lalitha Wijebandara LPSS1 - Polish Supply Site-1 WH-01 - WH-01 Yes m
@ LALWLK - Lalitha Wijebandara LPDS1 - Polish Demand Site-1 - WH-01 - WH-01 @
@ LALWLK - Lalitha Wijebandara LWPS1 - LW Poland Site - 1 WH-01 - WH-01 m
@ LALWLK - Lalitha Wijebandara LWPS1 - LW Poland Site - 1 WH-02 - WH-02 m

To save a record in Warehouse Access page a user must have at least one option enabled out of
the 2 controls, reservation, and transaction. A record with a user whose both “Making Stock
Reservations Allowed” and “Performing Inventory Transactions Allowed” disabled, is
considered as an invalid record which cannot be saved.
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10.3.1 INVENTORY RESERVATION CONTROL
Controls are added when a user is reserving inventory parts (e.g., Customer Order, Work Order,
Shop Order, Material Requisition, Pick by Choice:

e |[f access has been granted the user can reserve the quantity
e |[f access has not been defined or not granted an error message is displayed and the user cannot
proceed.

H S H Released
Material Requisition 200067-1wes1 - Released - Lwic ~
& 2 | / m B B~ Plan Stop Pre Posting Document Text )
Order No Site Internal Customer Due Darte Created
200067 = LWPS1 LWIC - LW Int Cus >  7/29/2021 712912021
Created By Total Amt/Base Internal Destination Document Text
@ik 20.00 - O
MNotes
B
Lines
= ¥V B v 7 w B 2 v Reserve Reserve Manually Connect to Activity H | v
Delivery
{l] : Release No Part Due Qty UoM Dughare __ created . CrearadRwo . Dara
: |1 LW A2450 - Air Filter - I... 2 | PCS 7 LALWLK does not have access to make *
stock reservations in the warehouses
Arerrre of Site LWPS1

10.3.2 INVENTORY TRANSACTION CONTROL

Controls are added when a user is saving inventory operations (e.g., Receipt, Scrap, Pick, Move,
Move Reserved Materials, Transfer between Warehouses, Revaluation, Attach to Handling Unit,
Unattached from Handling Units, Pack According to Pack Instructions, Pack According to Handling
Unit Capacity, etc...):

e If access has been granted the user can register the operation
e If access has not been defined or not granted an error message is displayed and the user
cannot proceed
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Receive Inventory Part wwazaso- airFilter - internal - Lwps1-* ¥ 10f3

Y R ~ Create New Part Revision v
Part Site Configuration Id Uoh Catch UoM
LW A2450 - Air Filter - Internal = LWPS51 * PCS
Unit Cost Print Barcode Note
10.00 B
= Y LA 1 B B~ Print Barcode Labels Print Serviceability Tag v
Quantity Catch Quantity On Hand Catch
Ed Received On Hand Qry Received Qty Expiration date Location No Handling Unit ID  Handling |
h @ 10 158 202376 | 0
w 113 LALWLK does not have access to x

perform inventory transactions in
Warehouse WH-01 of Site LWPS1

Attachments

When moving parts directly into the new inventory, you should have access to both warehouses, on
each site. If access is not authorized, you will receive an error message.

When moving into transit at first (i.e., the goods are under transportation) you can put the material
into transit, but you can move them from transit into the target location only if you have an access to
that target warehouse. If access is not authorized, you will receive an error message.

Note:
e You may grant a user an access to a warehouse but not connect him to the site. In this case
the user cannot perform any transactions or/and reservations.
¢ If the user does not have warehouse access defined or the access is set to “No”, the user
cannot perform Inventory transactions or/and reservations.
¢ |f the company’s parameter is not enabled, the effect is that no access control will occur.

10.4 Automatic Reservation

With the automatic reservation, the system decides under IFS Cloud standard logic from which
locations and in what order inventory parts are reserved. During automatic reservation the Cloud will
only reserve material from locations from/to which the user has access according to the Access
Rights enabled in the Warehouse Access Page.

10.5 Exceptions in Access Rights

For changing inventory part locations between two sites, the user must be authorized to perform
transactions in warehouses of both sites. During the transportation of Parts to another site, two
transactions are generated: INVM-OUT (direction -) and INVM-TRIN (direction 0). The second
transaction, INVM-TRIN, refers to a target location. But, if the user is not granted access to the
Warehouse in destination Site the Part cannot be moved to a destination location, so that
transactions cannot be completed.
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10.6 Delimitations
No known.

Country Solution POLAND 169



\\\\\!r/,
ZIFS
11 Tax Reliability Control on Suppliers

11.1 Overview Legal Requirement

The amendment of the polish VAT act, in force since 1%t of September 2019, introduced regulations
on the electronic database of taxpayers registered for VAT purposes in Poland (known as 'white list',
or 'e-register'). This new database allows to verify the current status of the taxpayers (suppliers),
whether the supplier is an active VAT payer, deregistered, restored or exempted. Additionally, there
will be information regarding the bank accounts numbers of the suppliers. For instance, if a company
has to make payments exceeding 15000PLN, company have to pay only to the suppliers’ bank
accounts disclosed in the white list. If company fail to do so, following sanctions will be applied,

e For VAT: responsible for payment of output VAT (if not settled by the supplier (up to the VAT
amount disclosed on the invoice)).

e For income taxes (corporate and personal): the expenditure will not be treated as tax
deductible costs.

To avoid sanctions the company will have to notify the tax authority about making a payment to an
undisclosed on the list bank account within three days from the transfer date or make payment using
split payment.

11.2 Solution Overview

Functionality is added to define if suppliers are considered unreliable and if bank accounts are valid
for payments. There are also added controls and warning messages raised in the following
scenarios:

e Control of supplier reliability is performed in following scenarios:
o Purchase order entry
o Manual supplier invoice entry
o Creating supplier payment proposal
o Acknowledging tax proposal
e Control of bank account validity is performed in the following scenarios:
o Authorizing invoice for payment
o Creating supplier payment proposals

Process Overview

Register Purchase

Define Supplier Define Supplier Bank Order, Supplier Invoices,

Payment Proposal, Tax
Proposal

Reliability Status Account Validity
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11.3 Prerequisites

e The company must be set up to use Poland localization, see the Company Setup chapter,
and the “Tax Reliability Control on Suppliers” parameter must be enabled.

11.4 Define the reliability status on the Supplier

After checking the tax authority’s database, the user can manually update the supplier basic data
via Application Base Setup/Enterprise/Supplier/Supplier/Address tab and Document Tax
Information sub tab.

The following columns are added:

o Supplier Tax Reliability Status. Enter the status for the supplier. Values are “Not set”,
“Reliable” and “Unreliable”.

e Supplier's Tax Reliability Declaration Date. This is the date the tax authorities have
classified the supplier’s reliability. The information is provided via the tax authority’s web site
and entered manually.

o Supplier’s Tax Reliability Status Last Modified. This is the date when the reliability data
was last updated, it's entered manually.

Address reios- rieips nwaok unReLBLE ~  10f1

€« #F B

FIELDS FIELDS NIWADK UNRELIABLE

Address ID: 01 ¥

=] &

GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION QRelalall Bl a@rb4L00e BT e Il PURCHASE ADDRESS INFORMATION

i= I 1] - & m i 8o Valldate Tax 1D Number Edit Tax Reliability Information
. Valldated
; . B C:"’\:aﬂ:r Tax ID _;-':E Tax ID Number Date
~ [2 :  NIWAPOLAND PL 4534334534353
Attachme DEIEE
Add to Favorites

Validate Tax ID Number

I Edit Tax Reliability Informaticn I
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Tax Reliability Information

= W [~ &
Tax Tax
Reliability Reliabiliy
Tax Reliability Declaration  Status Last
Tax ID Number Status Date Modified
4634643535 Unreliable 72372021 72372021

11.5 Define the bank account validity on the Supplier

Supplier reliability status and bank account validation recognized as independent functionalities.
Therefore, irrespective of the Supplier Reliability Status, electronic payment address’s Account
Validation checkbox can be updated to define the bank account validity on the supplier.

This is defined as supplier basic data via the Application Base Setup/ Enterprise/ Supplier/
Supplier/ Payment tab and sub tab Payment Method. Open the context menu and select
Electronic Payment Addresses to open the Bank Address page. A new, Account Validated
check box and Account Validated Date fields are added where the user may define if the account
is valid or not with the account validated date.

Paymenl: FIELDS - FIELDS NIWADK UNRELIABLE ¥ 1 of 1
€« F B

FIELDS FIELDS NIWADK UNRELIABLE

Company: NIWAPOLAND - NIWADK POLISH COMPANY A/S ¥

efault Template » MNoAdvice =

~ Payee -
Payment Method
= i ud t w8~ Electronic Payment Addresses et Default
i Payment Methad
¢ SUPBOE- supplier Bill Of Exchange

:  BREPLN - Poland bank
Delete

Add to Favorites

Electronic Payment Addresses

set Default
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BREPLN Payment Addresses - FIELDS

I

Bank
Blocked Qaccount  Bank Account
Payment Method Address ID Cescription ACCounT Default  foruse [Qvalidated  Validated Date

w SWIFT Cooe/BIC

|@ EREPLN 1 Polish Krakrow branch 342333345324324 Yes

11.6 Validation and Warning when entering a purchase order
When creating a new purchase order, the reliability of the supplier is validated.

If the value on the supplier is “Unreliable” a warning message is displayed.

@ This supplier is classified unreliable as tax payer.
Recipients of supplies will be liable for any tax not paid by
suppliers, who are identified as unreliable. Do you want to

continue?

o J

The supplier's document address as defined in the purchase order header will be used to perform
the validation.

PART LINES  NO PARTLINES RENTAL PARTLINES [ReiivZAvILIEN CHARGES AUTHORIZATION

General
Currency Buyer Coordinator Supplier Contact
PLN - o*-IFS Applications ~ [ cHsuLK - champika Subasighe -
Project Release Date Revision No Supplier's Order No
v  7/28/2021 0
Purchase Code Total Weight Total Volume Language Code
> 0 0 en - English -
Schedule Order Document Text Mote

[ o] [ o B

Delivery Address Document Address
Delivery Address Reference Single Occurren Document Address
@ 10 - Ewa Sokolova - © 10 - Ewa Sokolova -
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11.7 Validation and Warning when entering a manual supplier invoice

When creating a manual supplier invoice, the reliability of the supplier is validated. If the value on
the supplier record is set to “Unreliable” a warning message is displayed when saving the invoice.

r is classified unreliable as tax paEyer.

Recipients of supplies will be liable for any tax not paid by
suppliers, who are identfied as unrefiable. Do you want to
continue?

The chosen supplier invoice address set for the invoice will be used to perform the validation. This
may be changed in Manual Supplier Invoice page and the General Invoice Information dialog box
accessed under the General Info... context menu option. The reliability of the selected address is
displayed in the Tax Reliability Status field.

X More Information

1 2 6/30/2021

Reliable

oK Cancel

11.8 Validation and Warning when acknowledging a Tax Proposal

When acknowledging a tax proposal, the reliability of the supplier is validated. If the value on the
supplier record is set to “Unreliable” a warning message is displayed.

(D Tax proposal includes transactions related to suppliers
whao are identified as 'tax-unreliable’. Do you want 1o

continue?
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To show the tax reliability status in the tax proposal, Tax Reliability Status column is added to Tax
Proposal Details page. This column is automatically updated with the changes in the supplier basic
data.

S Acknowledged
Tax Proposal Details >-mix + 101 -
| B v~ Q
Tax Proposal Creation Date User ID
2-mix 7/28/2021 eALA\N
Tax Report Tax Template
MIX - All tax codes 5103 - Generic Tax Template
m PARAMETER 4 2
Y OB v B v
Tax Base
Tax Amountin Amountin Tax
Reporting Reporting Tax ID Tax Number pf  Reliability
v Pt Currengy Rate Currency Currency = Correction Reference  Trans Code Tax Book ID Subgroup Tax Code Status
1 -60.0000 -240.0000 m P10 8 Unreliable
1 60.0000 240.0000 m P2 L] Unreliable
1 60.0000 240.0000 m P9 T8 Unreliable
1 -20.0000 -80.0000 m P10 T8 Unreliable
1 -20.0000 -80.0000 m P10 L] Unreliable
1 -20.0000 -80.0000 m P10 T8 Unreliable
1 -20.0000 -80.0000 m P10 L] Unreliable
1 -20.0000 -80.0000 (09 P10 8 Unreliable

11.9 Validation and warning when authorizing invoice for payment

A validation is done to control whether the bank account on the payment method is valid. If the
chosen bank account is not valid for the supplier or connected payee for the supplier, a warning
message is displayed. The warning is generated at time of authorizing the invoice installment for the
payment.

(D The chosen payment method's bank account has not
been validated by tax authorities. Do you want to

continue?

This authorization can be done manually or automatically. This is set up as basic data on the supplier
in the Supplier/Invoice tab and General subtab, this is IFS Cloud standard functionality.
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Invoice rewos- rewos nwaok unkeusaie = 1er1

«# B

FIELDS FIELDS NIWADK UNRELIABLE
Company: NIWAFOLAND - NIWADK POLISH COMPANY A/S ¥

a ’ Notes | Default Cost Code String

External v 0-External v P

- 1 oozt N FIELDS - FIELDS NIWADK UNRELIABLE

The following options are available:

¢ “No”. The validation of the account is done when the Authorize check box is manually
selected in the Supplier Invoice Installment Plan and Discount page.

e “At Final Posting”. The validation of the account is done when final postings are created.

o “When Posted” The validation of the account is done when the first postings are created for
the invoice.

On company level, on the Company/Invoice tab. it's possible to control if invoice authorization
should be done in a separate function/page, this is IFS Cloud standard functionality. If the Supplier
Invoice Authorization Only by Separate Function check box is selected the authorization can
only be done from the Authorize Invoices for Payment page. The validation of the account is
performed when the Authorized check box is selected.

INVOICE nwaPoLAND - NIWADK POLISH COMPANY A/s ¥ 1of 25+

& & B v o

Associat Creat=d B
NIWAPOLAND NIWADK POLISH COMPANY A/S ALAIN
GENERAL DEFAULT INVOICE TYPES PO MATCHING “
I ® Upgrade Invoices with Posting Proposals
Posting Parameters
ng at Invoice E w Preliminary and Final Supp me Date d Fina Use Post
pted Invoice Vou Differe: Accepred Invoice R Diffe Curres
Miscellaneous Parameters
Planned Payment Date Calculation Base Unique Supplier Invoice No Pe; Incoming Invoice Currency Rate Base Outgoing Invoice Currency Rate Base
Pay. Term Base Date v Supplier ¥ Voucher Date ~ Invoice Date -
Supplier Invoice Authorization Only by Separate Function I Cash Discount Based on Gross Amount Set Invoice Date to Current Date When Printing Outgoing Print Advance Payments Information on Customer Invoice
ue Payment R e &
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Search agances @) Show only current results
Status *  InstallmentID *  Authorizer ¥ More * O Favorites  Clear Q
Authorize Invoices for Payment
= LA Authorize Modify Remittance Information
Series | Invoice Insta...
'r‘l/“ # | Supplier Authorized JAuthorizer D Murnber o
HEN: 4 @ MARF m * - IFS Applications | SI NIWAO4 1
& @ BEWL m * - IFS Applications Sl NIWAQ4 1
& @ BEWL m * - |FS Applications Sl WWW 1
& @ BELR, m * - IFS Applications S NIWA1S 1
P @ MARF m * - IFS Applications Sl NIWA31 1
& @ MARF m * - IFS Applications S NIWA30 1
& @ MARF m * - |FS Applications Sl NIWASD 1
& @ MARF m - IFS Applications Sl NIWA102 1

: Settings

Amount
10,000.0000 PLF
1,000.0000 PLN
1,000.0000 PLN

700.0000 PLN
1,000.0000 PLN
500.0000 PLN
100.0000 PLN

100.0000 PLN

Due Date

712642021

7i27/2021

7/30/2021

7/30/2021

8/5/2021

8/6/2021

8/21/2021

B8/24/2021

On On Hold Reason
1]

. | Status

Created

Created

Created

Created

Created

Created

Created

o
a

Created

11.10 Validation and Warning when creating a Payment Proposal

When creating a new supplier payment proposal, a validation is done to control the reliability status
of the supplier and a control is done to check that the account connected to the payment method is

valid.

If the supplier or payee is unreliable and/or the account is not valid a warning message is displayed.
For the account to be validated, it's required that the invoices are registered with a Payment Method

and Payment Address ID.

The validation is performed in the following scenarios:

o When creating the proposal under the Create Proposal context menu option in the Accounts
Payable/Supplier Payment Proposal/Supplier Payment Proposals page

¢ When connecting invoices manually in the Supplier Payment Proposal Details page in the

Details tab.

Read IFS Cloud Documentation for more information on how to use these functions.
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.— General Information —O— Cash Account and Payment Method Information —O— Fittering and Addii

Start Option

®
(@ start now

(") Run in background
~

() Schedule

Date Selection

Date 7/29/2021

() substitution Variables

Company and Supplier Selection
Company

NIWAPOLAND

Based On

@Suppher %
(O supplier Group

Cance!

ed On First Possible Pay Date

New Supplier Payment Proposal

Until Plan Pay

7/29/2021

Date

Schedule

_g\\\lr/,
= Z
7N

IFS

Schedule Options

Once the proposal is created you can go to the detail page and view connected invoices. There are
five new columns added, Tax Reliability Status, Declaration Date, Last Modified, Account
Validated Date and Account Validated, to indicate the supplier’s status. Based on this information
decision can be made whether to pay or not before acknowledging the payment.

Supplier Payment Proposal Details s ~ 1o

<

PATMENT METHOD PLAN | PARAMETERS

3 + | # | ernteropossl | Recalcuiate Neming Possibily

11.11 Delimitations

©

Recalculate Offset Possibilty

i

osting | Cash Account

Payee
O@ ==
@ v o
oo

15020022

Payment Memoa | Adoress

Created

1 Unrelladle | 7/22/2021 7

ol Unrellable | 7/23/2021 71

e There is no online, nor offline connection developed to integrate IFS Cloud with the tax

authorities’ database.

e This functionality is only available in purchase order entry, manual supplier invoice entry,
supplier invoice authorization for payment, payment proposal and tax proposal.

Additional delimitations may apply; all relevant flows should be tested to ensure completeness.
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12 Polish E-Invoice

12.1 Overview Legal Requirement

KSeF, Krajowy System e-Faktur (National System of e-Invoices), is a platform intended for issuing
and receiving invoices by electronic means. Using of KSeF platform is facultative. In 2026, issuing
of B2B invoices via KSeF platform will become mandatory for domestic, EU as well as non-EU sales.
For B2C invoices, it will be optional. For large tax payers, issuing invoices via KSeF platform will be
mandatory from February 2026. For other tax payers, it will be mandatory from April 2026. For micro
businesses, it will be mandatory from 2027.

In order to make it possible to issue invoices via KSeF platform, Tax Authorities publish official
schema of E-invoice (FA(3) as for 2026) and enable APl which allows to send the XML message
and receive response. Accepted invoices are available in KSeF platform for companies having Polish
tax identity and they are archived for 10 years. KSeF platform does not include any function to inform
buyers that new invoice is available. In order to check whether any new invoices have been issued,
buyers must integrate with KSeF platform or login to one of the applications prepared by the Tax
Authorities.

In case of enabling invoices issued via KSeF platform outside KSeF, number assigned by KSeF and
QR code must be included. QR code secures the content of the invoice and makes it possible to
reach invoice in KSeF platform.

12.2 Solution Overview

The solution is based on standard E-invoice process which is using a 3rd party service provider to
handle the communication of invoice information. The solution has been developed in cooperation
with the IFS partner Pagero but other local or global service providers can be utilized. The service
provider is needed to transform the IFS style invoice file to required format and to transform the
response file to an IFS style format. The service provider is also needed to transform received
invoice file in the official format to IFS style invoice file. Read more about the IFS elnvoice solution
in IFS cloud documentation.

The following is added/changed to support this requirement:

e New E-invoice Poland is added to the Format drop-down in the Message Setup section in
the E-invoice Processing Type page.

o New STD-PL E-invoice processing type is added.

e |FS Cloud standard functionality which allows to create XML in IFS Style is enhanced with
additional information for Polish E-invoice.

e When printing invoices, E-Invoice Reference Number and QR Code are included in the
report data.

In this document

e Polish E-invoice XML in IFS Style refers to IFS Style E-invoice XML enhanced with Polish
specific attributes. This file is generated from IFS Cloud and can be sent to service provider
for conversion.

e Polish E-invoice XML in KSeF Style refers to Polish specific legally required XML format
(FA(2) as for 2024) which can be sent by service provider to KSeF platform, as a result of
conversion of Polish E-invoice XML in IFS Style.

¢ E-Invoice Reference Number refers to standard field that can be used to maintain number
assigned by KSeF platform.
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12.3 Process Overview
12.3.1 PROCESS OVERVIEW - BASIC DATA

Define Basic Data

=)

Send Polish
E-invoice in IFS
Style to Service

Provider
(IFS)

Receive Response
Message in KSeF
Style from KSeF
Platform

(Service Provider)

Print/Post Invoice

Receive Polish
E-invoice in IFS
Style from IFS

(Service Provider)

Convert Response
Message to IFS
Style

(Service Provider)

Update General
Ledger

(IFS)

12.3.2 PROCESS OVERVIEW - CUSTOMER INVOICES

Convert Polish
E-invoice to KSeF
Style

(Service Provider)

Send Response
Message in IFS
Style to IFS

(Service Provider)

Fetch Tax Ledger
Info

(IFS)

12.3.3 PROCESS OVERVIEW - SUPPLIER INVOICES

Load E-Invoice
in IFS Style

(IFS)

Update General
Ledger

(IFS)

View External
Supplier Invoice

(IFS)

Fetch Tax Ledger
Info

(IFS)

Create Manual
Supplier Invoice

(IFS)

View Tax
Transactions

(IFS)

Send Polish
E-Invoice in KSeF
Style to KSeF
Platform

(Service Provider)

Receive Response
Message in IFS
Style from Service
Provider

(IFS)

View Tax
Transactions

(IFS)

Post Manual
Supplier Invoice

(IFS)
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12.4 Prerequisites

e The company must be set-up to use Polish localization, see the Company Set up chapter.
“Polish E-Invoice” parameter must be enabled.

o To support reporting of split payment invoices, the “Standard Audit File-Tax for Poland (JPK)”
functionality is also used. “Standard Audit File-Tax for Poland (JPK)” parameter is mandatory
and enabled by default.

o It is recommended to create the company using Standard Polish Template (STD-PL).

12.5 Basic Data

12.5.1 BASIC DATAADDED DURING INSTALLATION
The following new data is added for Poland during the installation:

e In the E-invoice Processing Type page, new value E-invoice Poland is added in the
Format drop-down.

¢ New STD-PL e-invoice processing type with the E-invoice Process enabled, Process after
Response enabled, and E-invoice Poland selected in the Format drop-down is added.

12.5.2 DEFINE BASIC DATA

12.5.2.1 Modify Process Type

Using IFS Cloud standard functionality, select user from the Approval User drop-down in the
E-Invoice Processing Type page for STD-PL process type.

E-invoice Processing Type

@search(14) Advanced

Process Type: KSTD% ¥ ( Description ¥  E-invoice Process *  More ¥ © Favorites Clear e cenrche
STD—PL—StandardTEmplatEv’DrInvui(EPmcessingType'Pu\am:l > 120f14

+ 8 7 0 4~

STD-PL Standard Template for Invoice Processing Type - Poland

E-invoice P

v} [ v= 1o I3

Message Setup

12.5.2.2 Define Company

Using IFS Cloud standard functionality, enter company tax identity in the Tax Liability Countries
section in the Company/Tax Control/Invoice tab for country “POLAND”. If company has been
registered for EU sales, enter EU tax identity with PL prefix. Company tax identity can be specified
with dashes (for example PL123-456-78-90) or without dashes (for example PL1234567890).
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Tax Control waseroLanp - polish company ~

K # 40~

Company

MABE-POLAND

GENERAL INVOICE SUPPLY CHAIN  EXTERNAL TAX SYSTEM
Vd
General Information
Amount Method Tax Rounding Level
Gross Amount Entry -  Total Level -
Tax Amount Limit, Outgoing Invoice Lines Use Tax Invoice
a» »
Post Preliminary Tax Withholding
Tax Liability Countries
Yy + 7
Tax ID
Validated
v Country Tax ID Type Tax ID Number Date
POLAND NIP PL1234567890

Name

Polish Company

Association No

Invoice Fee Tax Code

Correspondence, Invoice Net Amount - Tax Withholdi_..

»

Tax Registration Text Branch

(@]
Created By
MABEPL
L.
Tax Correspondence, Invoice Line - Manual Postings
-
Supplement Tax Withholding
a»
{:‘:} v B~ 24~ B v
Valid From Valid Until
3/17/2023 12/31/2049

Using IFS Cloud standard functionality, in the Company/Invoice/General tab, select STD-PL in the
Process Type drop-down and enable Set Invoice Date to Current Date When Printing Outgoing

Invoices.

INvoice wase-roLaND - Polish Company ¥ 10f1

K # L

Company

MABE-POLAND

GENERAL DEFAULT INVOICE TYPES

7

Posting Parameters

Create Posting at Invoice Entry

Accepted Invoice Voucher Difference in Accoun...

Miscellaneous Parameters

Planned Payment Date Calculation Base

Pay. Term Base Date -

PO MATCHING

Process Type

STD-PL - Standard Template for Invoice.. W

Print Advance Payments Information on Custo...

@O

Name

Polish Company

DOCUMENT MANAGEMENT

Same No on Preliminary and Final Supplier Inv_.
-

Accepted Invoice Rounding Difference in Invoic...

Unique Supplier Invoice No Per
Supplier -
Supplier Invoice Authorization Only by Separat ...

»

Unique Payment Reference Validation

a»

12.5.2.3 Define Tax Codes and Tax Categories 1

Using IFS Cloud standard functionality, define separate tax code used in order to follow invoices
which are a subject to the mandatory split payment mechanism.

Association No

Same Date on Preliminary and Final Supplier In__.

»

Rounding Line

Not Used

Incoming Invoice Currency Rate Base

Invoice Date

Cash Discount Based on Gross Amount

«©

Q
Created By
MABEPL
L
Use Posting Proposal
‘
-
Qurtgoing Invoice Currency Rate Base
w  Invoice Date -

Set Invoice Date to Current Date When Printing__

@«
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Tax Codes

Y 4+ £ & v By 2av @Bv

Tax Code Description Tax Type Tax (%) Deductible (%) Valid From Valid To

MPP Mandatory Split Payment Tax 23 100 1/1/2023 12/31/2049

Using IFS Cloud standard functionality, select Tripartite EU Trade in the Tax Reporting Category
drop-down for tax codes intended for scenarios in which company is second party in EU tripartite
trade.

Tax Codes

Y = £ & v B v

Tax Code Description Tax Type Tax (%) Deductible (%) Valid From

0§ Tripartite EU Trade

Tax Reporting Category

WDTWTT EU Sales - triangulation Tax 100 1/1/2017

Polish E-invoice XML in KSeF Style requires

¢ classification of tax transactions
¢ indicating invoices with reverse charge
¢ indicating exception base.

Polish E-invoice XML in IFS Style is enhanced with additional tags with this information.

Using IFS Cloud standard functionality, make sure that all categories listed below are available in
the Tax Category 1 page all tax codes used in customer invoicing are connected to relevant tax
category 1 in the Tax Codes page. When Polish E-invoice XML in IFS Style is created, the
<PLTaxCategory1> tag includes this information in the <InvoiceRow> section, the
<VatSpecificationDetails> section and, in case of prepayment based invoices, <PLOrderRow>
section. During conversion to Polish E-invoice XML in KSeF Style, this information should affect the
P_12 tag (tax percentage, ‘zw’, ‘o0’ or ‘np’), the P_18 tag (reverse charge indicator) and total
amounts reported in tags with patterns P_13_% (tax base amounts), P_14_% (tax amounts) and
P_14_%W (tax amounts in PLN).

Tax Category 1 | KSeF tag to | KSeF P_12 | KSeF P_18 Comment
report tax | (Tax Rate) | (Reverse
base Charge)
1-Yes, 2-No
P 13 1 P 13 1 Tax Code | 2 Domestic,
Percentage basic percentage
(23% or
22%)
P 13 2 P 13 2 Tax Code | 2 Domestic,
Percentage first reduced
(8% or 7%) percentage
P 13 3 P 13 3 Tax Code | 2 Domestic,
Percentage second reduced
(5% or 3%) percentage
P 13 6 1 P 13 6 1 0 KR 2 Domestic 0%
P 13 6 2 P 13 6 2 0 WDT 2 EU Sales of Goods
P 13 6 3 P 13 6 3 0 EX 2 Export
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Tax Category 1 | KSeF tag to | KSeF P_12 | KSeF P_18 Comment
report tax | (Tax Rate) | (Reverse
base Charge)
1-Yes, 2-No
P 13 7/P_19A | P_13 7 zZW 2 Tax Free
P_13 7/P_19B
P_13 7/P_19C
P 13 8 P 13 8 np | 1 Other than EU
Sales of Services
P_13 9 P_13 9 np Il 1 EU Sales of
Services
P_13_10 P_13 10 00 1 Domestic Reverse
Charge
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@® > Accounting Rules > Tax » Tax Categories £

Tax Categories

v awa el A BN TAX CATEGORY 2

Y + 7

- Category ID Description
H P_13_1 P_13_1 =Tax Base, P_14_1/P_14_1W =Tax Amount, P_12=23 or 22, P_18=2
i P_13.10 P_13_10 =Tax Base, P_12 = 0o, P_18 = 1 (Domestic Reverse Charge)
H P13 2 P 13 2=Tax Base, P_ 14 2/P 14 2W =Tax Amount,P.12=8o0r 7, P 18=2
H P13 3 P 13 3=TaxBase, P 13 1/P_ 13 1W=Tax Amount,P.12=50r3,P_ 18=2
i P_13.6.1 P_13_6_1 =Tax Base, P_12=0KR, P_18 = 2 (Domestic 0%)
i P_13.622 P_13_6_2 = Tax Base, P_12=0WDT, P_18 = 2 (EU Sales of Goods 0%)
i P_13.6_3 P_13_6_3 = Tax Base, P_12 =0 EX, P_18 = 2 (Export 0%)

: P_13_7/P_19A P_13_7=Tax Base,P_12=zw, P_18 = 2, Tax Code Text in P_19A

: P_13_7/P_19B P_13_7=Tax Base,P_12=zw, P_18 = 2, Tax Code Text in P_19B

H P_13_7/P_19C P_13_7 =Tax Base,P_12=zw, P_18 = 2, Tax Code Text in P_19C

: P13 8 P_13_8 =Tax Base,P_12=np |, P_18 = 1 (Other than EU Sales of Services 0%)

H P13 9 P_13_9=Tax Base,P_12=np I, P_18 = 1 (EU Sales of Services 0%)
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Tax Codes
Y + 7 S v B~v 24~ @A~
TaxCode ¥  Description ¥  TaxType ¥ Tax(%) ¥ TaxCategory1:% ¥ X  More ¥ © Favorites Apply Clear Saved Filters v
Tax Code Description Tax (%) [ Tax Category 1 Tax Reporting Category Deductible (%) Tax Type valid From
0 VAT 0%, domestic, sales and purchase O P_13.6_1-P_13.6_1=Tax Base, P_. None 100 Tax 17172017
OF Export of goods 0% 0] P_13.6_3-P_13.6_3 = Tax Base, P_. None 100 Tax 1172017
23 VAT 23%, domestic, sales and deductible purchase 23 § P_13.1-P_13_1=Tax Base, P_14_1 None 100 Tax 112017
5 VAT 5%, domestic, sales and deductible purchase 5 P_13.3-P_13_3 =Tax Base, P_13_1.. None 100 Tax 1/1/2017
8 VAT 8%, domestic, sales and deductible purchase 8 | P_13_2-P_13_2=Tax Base, P_14_2. None 100 Tax 1/1/2017
MPP Mandatory Split Payment 23 @ P_13.1-P_13_1 =Tax Base, P_14_1 None 100  Tax 1/1/2023
WDTO EU Sales - 0% ol P_13.6_2-P_13.6_2 = Tax Base, P_. None 100 Tax 1172017
WDTWTT EU Sales - triangulation OQ P13 8-P_13_8=TaxBase P_12= Tripartite EU Trade 100 Tax 17172017
ZAGU Non domestic services with deductible tax (not included in Art100) 0l P_13.8-P_13_8=Tax Base, P_12= None 100 Tax 1172017
ZAGU-UE Non domestic services with deductible tax (included in Art 100) O @ P_13.9-P_13_9 =Tax Base, P_12= EU Services 100 Tax 1/1/2017
ZAGUB Non domestic services with non deductible tax (not included in Art 1 O P_13.8-P_13_8=Tax Base, P_12=.. § None 100 Tax 1172017
ZAGUB-UE Non domestic services with non deductible tax (included in Art 100) Of P_13.9-P_13_9=Tax Base,P_12= EU Services 100 Tax 1/1/2017
w Domestic and import of goods (sales and purchase) exempted 0§ P_13_7/P_19A-P_13_7 = Tax Base, .. None 100  Tax 17172017

In case of exemption, select tax category depending on the reference you would like to include:

o Select “P_13_7/P_19A” category if exemption base refers to Polish VAT Law.
e Select “P_13_7/P_19B” category if exemption base refers to EU Directive.
o Select “P_13_7/P_19A” category if exemption base refers to other rules.

Using IFS Cloud standard functionality, click Tax Texts per Tax Code in the Tax Codes page and
enter details referring to exemption base in the Tax Code Text field.

Tax Texts per Tax Code

Y + 7
v Tax Code Tax Code Text Valid From Valid Te
~
ZW - Domestic and import of goods (sales and purchase) exempted Tax Free Text (connected to P_19A) 7/3/2023 12/31/2049

Polish E-invoice XML in KSeF Style requires sending company basic tax identity for domestic sales
and export sales (tax id without PL prefix) and company EU tax identity for EU sales (tax id with PL
prefix).

Handling of <SellerOrganizationTaxCode> tag in the Polish E-invoice XML in IFS Style is adjusted,
depending on the attributes of the selected tax code.

¢ In case of invoices issued in connection to EU sales of goods, select P_13_6_2 in the Tax
Category 1 drop-down.

¢ In case of invoices issued in connection to EU sales of services, select EU Services in the
Tax Reporting Category drop-down and select P_13_9 in the Tax Category 1 drop-down.

¢ In case of invoices issued by second party in the EU tripartite trade, select Tripartite EU
Trade in the Tax Reporting Category drop-down and select P_13_8 in the Tax Category 1
drop-down.

When sending invoices with such tax code included, “PL” prefix remains in company tax identity.
Otherwise “PL” prefix is removed from company tax id number.

Country Solution POLAND 186



\\\

=" IFS

12.5.2.4 Define Invoice Information per Currency

Using IFS Cloud standard functionality, in the Invoice Information per Currency page, select All
Invoice Recipients in the Print Tax in Alternative Currency drop-down and select Accounting
Currency in the Alternative Tax Currency drop-down for all foreign currencies.

Invoice Information per Currency

Y + 7 v Bv v =Ev
Print Euro
Invoice Fee Invoice Fee  Equivalents
> Currency Code Rounding Factor Amount  Threshold Amount on Invoice  Print Tax in Alternative Currency Alternative Tax Currency

BRL 0 m All Invoice Recipients Accoul nting Curren:y
cAD 0 o All Invoice Recipients Accounting Currency
CHF 0 m All Invoice Recipients Accoul ”[\ng (urren(y
DKK 0 o All Invoice Recipients Accounting Currency

UR 0 m All Invoice Recipients Accoul ”[\ng (urren(y
GBP 0 o All Invoice Recipients Accounting Currency
HUF 0 m All Invoice Reclp\eﬂ[s Accoul ﬂ[\ng (ur’r’er\:y

Y 0 m All Invoice Recipients Accoul nting Curren:y

IXN 0 o All Invoice Recipients Accounting Currency
MXV 0 m All Invoice Recipients Accoul nting Curren:y
NOK 0 o All Invoice Recipients Accounting Currency
PLN 0 m Never Accoul ”[\ng (urren(y
SEK 0 o All Invoice Recipients Accounting Currency
UAH 0 m All Invoice Recipients Accoul ”[\ng (urren(y
usp 0 o All Invoice Recipients Accounting Currency

12.5.2.5 Define Audit Format for Poland
Go to Accounting Rules/Audit Interface/Basic Data/Audit Formats page. Search for the Poland
SAF-T audit format or add a new record for Poland SAF-T as follows:
e Country as “Poland”
o Report Type as “SAF-T".
12.5.2.6 Enter Audit File Basic Data
Click Audit File Basic Data to open the Audit File Basic Data page.

Audit Formats

Yy + @ ~» @ 4«

Audit File Basic Data J§ Audit File Tax Information = Audit File Log S v [Bv 24v BV

Thousands Negative  Leading
m Country Report Type Decimal Symbol Seperator Format Zeroes Time Format Date Format File Type File Template ID Default
: POLAND SAF-T . (point) , (comma) -9 09 13:59 YY-MM-DD JPK_V7M2 JPK_V7M2_TEMPLATE Yes

Using IFS Cloud standard functionality add a header record in the Audit File Basic Data page.

The new tab SAF-T Poland Setup includes ten sections. For Polish E-Invoice functionality, the Tax
Codes for Specific Procedures section is applicable.

Enter tax code used in order to follow invoices which are a subject to the mandatory split payment
mechanism in the (V7M) MPP/(FA) P_18A field.
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Audit File Basic Data

Z
HEADER STANDARD AUDIT CODE MAPPING LU g JelWN 1 RS 30T]
Z 1

General Info

Misc Parameters

Voucher/Delivery Types for Document Types (JPK_V7M)
Delivery Types for Specific Procedures (JPK_FA)

Delivery Type for Delivery Goods and Services

Delivery Types/Customer Groups for Specific Procedures

Tax Codes for Specific Procedures

(V7M) MPP/ (FA) P_18A

23

Invoice Type Mappings

SAF-T PL Inventory Transaction Report Types

Inventory Transaction Report Type Mappings

12.5.2.7 Define Customer

Using IFS Cloud standard functionality, enter customer tax identity in the

S\
SVIFS

Customer/Address/Document Tax Information tab. In case of Polish tax identity, value can be
specified with dashes (for example 123-456-78-90) or without dashes (for example 1234567890).
In case of EU customer, enter customer tax identity including country prefix.

Add F@SS wWB-cusT-PL-PL - Polish Customer in Palish Company ¥ 50f7

& &2 4~
Customer Name Association No
MB-CUST-PL-PL Polish Customer in Polish Company

Address ID: A1-CUST-PL ™

Q + @ 7 m

End Customer

Customer's Own Address |D Customer Name End Customer

GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION [slslail NSy mrv@lligel i b lel i SALES ADDRESS INFORMATION

Y + 7
v | . Company Supply Country  Delivery Country Tax ID Type Tax ID Number
N H MABE-POLAND * * NIP 1234567890
Attachments

Address Identity

41“.3}\, B~ 24~ :=:

Using IFS Cloud standard functionality, enable Print Tax Code Text in the

Customer/Invoice/General tab.

Using IFS Cloud standard functionality, in the Customer/Invoice/General tab

o Leave the Process Type drop-down empty if invoice should be issued via KSeF for the

customer.
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Select process type (with e-Invoice Process disabled) from the Process Type drop-down

to switch off Send E-invoice for scenarios when invoice should not be issued via KSeF

(B2C).

|rIVOIce MB-CUST-PL-PL - Polish Customer in Polish Company ¥ 50f7

« & L0

Customer Name

MB-CUST-PL-PL Polish Customer in Polish Company

Company: MABE-POLAND - Polish Company ¥

Assaciation No

Notes

Q + # il Notes  IPD Tax Information

GENERAL PROPERTIES ~ MESSAGE SETUP

Customer Type Default Currency Rate Type Currency

External - w» PLN

No of Invoice Copies Numeration Group Payment Terms

1 w  0-Due Immediately

National Bank Code Inactive Date Inactive Reason
-

Process Type Invoice Fee Print Tax Code Text
-

Attachments

Q
4«
Customer Group
¥  0- Domestic Associated Unit v
Tax Code
- -
-
Exclude Invoice Image
s

It is also possible to modify the process type at the invoice level (Instant Invoice/Customer Order
Invoice/Project Invoice) when it is connected to the Company or Customer. In such cases, the
system will automatically fetch the process type associated with the Company or Customer. Priority
is given to the customer-level process type. This functionality enables the exclusion of non-liable
invoices from being sent to Tax Authorities by selecting a process type that is not enabled for “E-
invoice Process” at the invoice level.

Process Type yment
UF-GEN-1| -

Transrer Status

Tax Currency Rate

Signature

SASGLK

Nature of Business

More Information
Payer

anguage
€5 CUSTOMER SW - CUSTOMER 5. English

Our Reference Customer Reference

Order Date Customer's FO Number

Ref Inuoice Series 10 Refinvoice No.

® > Sales » Invoicing > Cusio

merimvoice £

Customer Invoice

@search ()

» CUSTOMER SW - CUSTOMER SW - 213357 - CUSTORDDEB - V12368 ¥ 20f3

CUSTORDDEB - Customer Order Invoice, Debit UF-GEN-1- UF GEN 1

#O £ L v share~  Cancellweice  Posting ~  Installiment Planand Discounts  Notes
Customer No Customer Address Name Serles ID Invoice No Company
€S)CUSTOMER swW CUSTOMER SW PR 213357 SWG - WG
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate
uso 27400.00 20000.00 740000 1
LINES ceneral RECLY
Indicatars
o Type Process Type Price adjustment

Printed Date

woice Address Invoice Date

v 22002025

© swap

Notes

Preliminary
]

Invoice Creaced Order Created

21202025 21202025

Advance/prepayment invoice

Comecton Exist

Use Price Inc Tax

Correction Invoice
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® > Project Management > In » Projectimvoice

Project Invoice

@ search (2)

» PJ-20010002 ¥

Customer

CUSTOMER SW
Invoice No
20010002
Amounts
Currency Gross Amount
15D 227009

LINES m PREPOSTING  ACCOUNTING

Inveice Information
Invoice Date *

21702025

Invbice Number Reference

& F W L v Nowes InwiceText  Printout

Customer Installment Plan

Customer Name

CUSTOMER SW

Invoice Period Start

21172025

imaice Type
B PRINV
currency Rate

1

Net Amount

1657.00

Project

invoice Period End

B 2172005

Tax Amount

61309

invaice Series

L]

Notes

UF.GEN-1 - UF GEN 1

ceries Reference

Our Reference

customer Ref

Company  SWG

Preliminary

Invoice Text

12.5.2.8 Define Supplier
Using IFS Cloud standard functionality, enter supplier tax identity in the

Supplier/Address/Document Tax Information tab. In case of EU supplier, enter supplier tax
identity including country prefix.

@ > Application Base Setup > Enterprise >

Add F@SS WMB-sUPP-PL-PL - Polish Supplier in Polish Company ¥ 1of 1

» @ A -

Supplier
MB-SUPP-PL-PL

Address ID: A1-SUPP-PL ¥

Q + @ 7 m

Supplier's Own Address ID

Supplier > Supplier > Address &

o

Name

Polish Supplier in Polish Company

Supplier Name

Association No

Supplier Branch

GENERAL ADDRESS INFORMATION ~ DELIVERY TAX INFORMATION [Wslelai[ VI @V V@ NIZe LUV ENE[s 'l  PURCHASE ADDRESS INFORMATION ~ OUTBOUND ADDRESS INFORMATION

Company

N7 i MABE-POLAND

Yy + &8 7 @ 4

Validate Tax ID Number

Tax ID Type

NIP

Tax ID Number

Tax ID
Validated
Date

1234567890
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Using IFS Cloud standard functionality, enter new record in the Supplier/Invoice/Message Defaults

tab and select “E-INVOICE” in the Media Code field.

® > Financials > Supplier Invoice > Supplier > Invoice &

|nVOIce MB-SUPP-PL-PL - Polish Supplier in Polish Company ¥ 1of1

(] e o-

Supplier Name Association No

MB-SUPP-PL-PL Polish Supplier in Polish Company

Company: MABE-POLAND - Polish Company ¥

QU / [ Notes Default Cost Code String

GENERAL PROPERTIES ~ TAX INFORMATION PO MATCHING [ENISSVNE el IR A

-

Y + 7 Hv By v =
Automatic
Media Code Approval  Default Load Type Approval User
E-INVOICE o] MB) MABEPL

12.6 Customer Invoices

12.6.1 SEND POLISH E-INVOICE IN IFS STYLE TO SERVICE PROVIDER
Using IFS Cloud standard functionality, enter/create customer invoice.

In the Instant Invoice page or the Project Invoice page, click Send E-invoice. In the Customer

Invoice page click Share and next click Send E-invoice.

Customer INVOICe@ ws-cust-pL-pL- Polish Customer in Polish Company - 204405 - CUSTORDDEB - P10785 ¥ 5 of 10

«K @2 7 4 D Cancel Invoice  Posting v~ Installment Plan and Discounts  Notes

Print Work Copy

Send E-invoice
Customer No Cu Series ID Invoice No Company Site nvoice Created Order Created

IPEY MB-CUST-PL-PL Polish Customer in Pol ws 204405 MABE-POLAND - Polish... MBPL 4/13/2023 4/13/2023
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate
usbD 1,230.0000 1,000.0000 230.0000 4 4
LINES GENERAL HISTORY 4
Indicators
Invoice Type Invoice Address Price Adjustment Advance/Prepayment Invoice Use Price Incl Tax
CUSTORDDEB - Customer Order Invoice, Debit © A1-CUST-PL - m m m
Invoice Date Printed Date Preliminary Invoice No N Correction Bxist Correction Invoice
4/13/2023 204405 m m m
Our Reference Customer Reference Customer Reference Name Coracon REscorD Corretio T Reason
IFS Applications R -
Branch Customer Branch Jinsui Status
- Non Jinsui
Payment v | Delivery

In the E-Invoice Process Monitoring page, verify status of the invoice. As a result of enabling
Process After Response in the E-Invoice Processing Type page, invoice series and invoice
number are assigned but Document Status remains Preliminary.

If any error was identified when creating E-invoice, status is Failed and error is displayed in the Error
field.

Otherwise, status is Pending and XML file is available in the outgoing folder of IFS Connect.

Preliminary
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E-Invoice Process Monitoring

Y

- dentity Series ID Document No

MB-CUST-PL-PL ZK 200700050 Preliminary

Document Status

Sent Time Status E-invoice Reference Number

9/5/23, 4:38 PM

12.6.1.1 Polish E-invoice XML in IFS Style

2,
Z+IFS

S By uv B

E-invoice Reference Date Document Type Attachmen_. Error

Customer Invoice m B

Polish E-invoice XML in IFS Style is based on the standard IFS Style E-invoice XML and includes a
number of adjustments. In the file header Version is set to “2.0-PL” instead of standard “2.0”. New
tags are added and reported values are changed from standard version.

New tags.

New tag in Related/affected tags in Comment

Polish E-invoice XML Polish E-invoice XML

in IFS Style in KSeF Style

InvoiceDetails/ Fa/ VAT (normal invoice)

PLInvoiceTypeCode RodzajFaktury KOR (correction invoice for VAT)
ZAL (debit prepayment based
invoice)
KOR_ZAL (credit invoice for ZAL)
ROZ (final invoice after prepayment
based invoice)
KOR_ROZ (correction invoice for
ROZ).

InvoiceDetails/ Fa/ Additional information included for

PLKSeFOriginalnvoiceDate DaneFaKorygowanej/ correction invoices.

& DataWystFaKorygowanej E-invoice Reference Date, E-invoice

InvoiceDetails/ & Reference Number and Invoice Date

PLKSeFOriginalnvoiceNumber Fa/ of the original invoice.

& DaneFaKorygowanej/

InvoiceDetails/ NrKSeFFaKorygowanej

PLOriginalnvoiceDate

InvoiceDetails/ Fa/ Additional information included for

PLPreviousPrepaymentBasedInvoice/
PLPreviousPrepaymentBasedInvoiceNumber

&

InvoiceDetails/
PLPreviousPrepaymentBasedInvoice/
PLKSeFPreviousPrepaymentBasedInvoiceNumber

FakturaZaliczkowa/
NrFaZaliczkowej

&

Fa/
FakturaZaliczkowa/
NrKSeFFaZaliczkowej

final invoice with prepayment-based
invoice connected and for next
prepayment-based invoice for the
same customer order.

Invoice Series&Number and E-
invoice Reference Number of
previous prepayment based

invoices.
InvoiceDetails/ Fa/ Y if at least one tax code from
PLSplitPaymentindicator Adnotacje/ invoice line is specified in the (V7M)
P 18A MPP / (FA) P_18A field in the Tax
- Codes for Specific Procedures
section on the Audit File Basic
Data/SAF-T Poland Setup tab.
Otherwise N.
InvoiceRow/ Fa/ Tax Category 1 selected for the tax
PLTaxCategory1 FaWiersze/ code in the Tax Codes page.
FaWiersz/
P_12 See Define Tax Code chapter for
& details.
Fa/
Adnotacje/
P_18
&
Fa/
Adnotacje/
Zwolnienie/

P_19 and P_19A and P_19B and
P_19C
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New tag in Related/affected tags in Comment
Polish E-invoice XML Polish E-invoice XML
in IFS Style in KSeF Style
InvoiceRow/ Fa/ Tax Reporting Category selected
PLTaxReportingCategory Adnotacje/ for the tax code in the Tax Codes
P_23 page.
See Define Tax Code chapter for
details.
InvoiceRow/ Fa/ Price after discount.
PLRowUnitDiscountedPriceAmount FaWiersze/ If column Total Line Discount is 0%
FaWiersz/ (or has no value), whole tag is not
(just for consistency with standard structure P_9A be created and stadard price tag can
InvoiceRow/ be used in mapping.
AmountCurrencyldentifier attribute from
PLRowUnitDiscountedPriceAmount tag
&
InvoiceRow/
UnitPriceUnitCode attribute from
PLRowUnitDiscountedPriceAmount tag)
InvoiceRow/ Fa/ Indicator of line before correction.
PLBeforeCorrectionindicator FaWiersze/ Y for lines before correction on the
FaWiersz/ correction invoice.
StanPrzed Otherwise N.
Information on lines with Y indicator
should be reserved during
conversion.
InvoiceRow/ Indicator of instant invoice text line.
PLInvoiceTextLinelndicator Lines with this indicator should not be
reported in <FaWiersz>.
InvoiceRow/ Indicator of all lines of prepayment
PLPrepaymentBasedInvoiceRowIndicator based invoices and lines of final
invoices which represent matching
with previous prepayment based
invoices.
Lines with this indicator should not
be reported in <FaWiersz>.
VatSpecificationDetails/ Fa/ Tax Category 1 selected for the tax

PLTaxCategory1

P_13 %, P_14_% and P_14_%W
&

Fa/

Adnotacje/

P_18

&

Fa/

Adnotacje/

Zwolnienie/

P_19 and P_19A and P_19B and
P_19C

code in the Tax Codes page.

See Define Tax Code chapter for
details.
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New tag in Related/affected tags in Comment

Polish E-invoice XML Polish E-invoice XML

in IFS Style in KSeF Style

PLOrderRow/ Fa/ New block with order details in case
PLArticleName Zamowienie of prepayment based invoices.
& The structure of tags follows the
PLOrderRow/ same principle as for InvoiceRow tag.

QuantityUnitCode attribute from
PLDeliveredQuantity tag

&

PLOrderRow/
PLDeliveredQuantity

&

PLOrderRow/
PLUnitPriceAmount

&

PLOrderRow/
PLRowVatRatePercent

&

PLOrderRow/
PLTaxCategory1

&

PLOrderRow/
PLRowVatAmount

&

PLOrderRow/
PLRowVatExcludedAmount

(just for consistency with standard structure
PLOrderRow/
AmountCurrencyldentifier attribute from
PLUnitPriceAmount tag

&

PLOrderRow/

UnitPriceUnitCode attribute from
PLUnitPriceAmount tag

&

PLOrderRow/
AmountCurrencyldentifier attribute from
PLRowVatAmount tag

&

PLOrderRow/
AmountCurrencyldentifier attribute from
PLRowVatExcludedAmount tag)

Changed tags.

Existing tag in
E-invoice XML
in IFS Style

Comment

VatSpecificationDetails/

According to IFS Cloud standard functionality, when rows are created in this
block, one row is created per tax percentage, in particular, all tax codes with
0% will end up as one line.

Rules for creating this block are changed so that rows are created separately
for each Tax Category 1.

SellerPartyDetails/
SellerOrganizationTaxCode

Handling of PL prefix of company tax identity is changed.
See Define Tax Code chapter for details.

All characters other than letters and digits are removed from company tax
identity.

BuyerPartyDetails/
BuyerOrganizationTaxCode

All characters other than letters and digits are removed from customer tax
identity if country from document address is PL.
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12.6.2 ACTIVITIES AT SERVICE PROVIDER

The following steps are handled by Service Provider

Receiving Polish E-Invoice in IFS Style from IFS

Conversion of Polish E-invoice to KSeF Style

Sending Polish E-Invoice in KSeF Style to KSeF Platform
Receiving Response Message in KSeF Style from KSeF Platform
Conversion of Response Message to IFS Style

Sending Polish E-Invoice in KSeF Style to IFS

12.6.3 RECEIVE RESPONSE MESSAGE IN IFS STYLE FROM SERVICE PROVIDER

Response message in IFS Style is placed in incoming folder of IFS Connect. From this folder it is
automatically uploaded to IFS Cloud.

12.6.3.1 Response Status - Accepted
In case of response Accepted, in the E-Invoice Process Monitoring page.

e Status is set to Accepted.

e E-Invoice Reference Number is set based on value of the
<EINVOICE_REFERENCE_NUMBER> tag from the response message.

o E-Invoice Reference Date is set based on value of the <EINVOICE_REFERENCE_DATE>
tag from the response message.

E-Invoice Process Monitoring

Y S v 2uv @Y

dentity Series ID Document No Document Status Sent Time Status E-invoice Reference Number E-invoice Reference Date Document Type Attachmen...  Error

i MB-CUST-PL-PL i3 200700050 Preliminary 9/5/23, 4:38 PM Accepted |  9999999999-20230830-08F1EOACCIEE-43  9/5/23, 12:00 AM Customer Invoice B

When accepted invoice is later referred:

e as original invoice in case of correction invoice
e as previous prepayment based invoice in case of next prepayment based invoice or final
invoice

number from the E-Invoice Reference Number field and, in case of correction invoice, date from
the E-Invoice Reference Date field of the accepted invoice are included in the later invoice.

12.6.3.2 Response Status - Rejected
In case response status is Rejected, in the E-Invoice Process Monitoring page:

e Status is set to Rejected.

e Response Error is set based on value of the
<RESPONSE_ERROR> tag from the response message.

o Response Error Code is set based on value of the
<REPONSE_ERROR_CODE> tag from the response message.

Adjust basic data to correct the reason of the rejection.

As a result of enabling Process After Response in the E-Invoice Processing Type page
Document Status is Preliminary and rejected invoice can also be adjusted in Instant Invoice page,
Customer Invoice page or Project Invoice page respectively.

When reason for rejecting the invoice is fixed, click Resend E-invoice in the E-Invoice Process
Monitoring page.
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12.6.4 PRINT/POST INVOICE

If Automatically Process Accepted Invoice is enabled in the E-Invoice Processing Type page,
invoice is automatically posted (Document Status set to Posted Auth in the E-Invoice Process
Monitoring page) when Status is set to Accepted.

If Automatically Process Accepted Invoice is disabled in the E-Invoice Processing Type page,
invoice should be posted manually.

¢ Inthe Print Invoice page, select the invoice and click Print.
¢ In the Instant Invoice page, select the invoice and click Print Invoice.

e In the Customer Invoice page, select the invoice and click Share and next click Print
Invoice.

¢ Inthe Project Invoice page, select the invoice and click Release Invoice.

3 Preliminan
Customer INVOoiCe we-custrL-pL- Polish Customer in Polish Company - 200700050 - CUSTORDDEB - P10785 ¥ 20f5 8

« 2 Q v Share Posting ~  Installment Plan and Discounts Notes Q
1
Print Invoice
I

Print Work Copy

Customer No Cus ~  Series|D nvoice No Company Site Invoice Created Order Created

PG MB-CUST-PL-PL Polish Customer in Poli_. 7K 200700050 MABE-POLAND - Polish..  MBPL 4/13/2023 4/13/2023
Amounts
Currency Gross Amt Net Amt Tax Amt Currency Rate Tax Currency Rate
usD 1,230.0000 1,000.0000 230.0000 4 4
LINES HISTORY 4 »
“ | Indicators ~
Payment Vv | Delivery v
References v | Invoice Text v
E-invoice Information

E-invoice Reference Number E-invoice Reference Date Response Error Code

Accepted 9999999999-20230830-08F1 EDACCIEE-43 9/5/23, 12:00 AM
Response Error Errol
Attachments ~

When printing the invoice, new data is added to the standard report data.
o New <IRN> tag includes value from the e-Invoice Reference Number field, fetched from
response message.

o New <QR_DATA> tag includes data for QR code, fetched from response message.
<IRN>1111111111-20260430-087BE268DAB3-E5</IRN>

<QR_DATA> https://ksef-test.mf.gov.pl/client-app/invoice/1111111111/01-02-2026/UtQp9Gpc51y-
u3xApZjligkpZ01js-J8KAISPW8WzIE</QR_DATA>
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https://ksef-test.mf.gov.pl/web/verify/1111111111-20250604-BF2A052B1B50-EA/Xgsbvnd%2BqeOwiw9w80gOG8X5xZz8lHkUW2jc%2FIpiDsc%3D%3c/QR_DATA
https://ksef-test.mf.gov.pl/web/verify/1111111111-20250604-BF2A052B1B50-EA/Xgsbvnd%2BqeOwiw9w80gOG8X5xZz8lHkUW2jc%2FIpiDsc%3D%3c/QR_DATA
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The following invoice reports include additional data

Report Title Layout ID/ Comment
File

Instant Invoice INSTANT_INVOICE_REP Instant Invoice and
Instantinvoice.rdf Correction Instant Invoice

Invoice Printout PROJECT_INVOICE_REP Project Invoice
Projectinvoice.rdf Debit, Credit and Correction

Invoice CUSTOMER_ORDER_IVC_REP Customer Order Invoice
CustomerOrderlvc.rdf Debit, credit and Correction

Collective Invoice CUSTOMER_ORDER_COLL_IVC_REP Customer Order Collective Invoice
CustomerOrderColllvc.rdf Debit, Credit and Correction

Prepayment Based Invoice CUST_ORDER_PREPAYM_INVOICE_REP | Prepayment Based Invoice
CustOrderPrepayminvoice.rdf Debit and Credit

Advance Invoice CUSTOMER_ORDER_ADV_IVC_REP Advance Invoice
CustomerOrderAdvlvc.rdf Debit and Credit

Rebate Credit Invoice REBATE_CREDIT_IVC_REP Rebate Credit Invoice
RebateCreditlvc.rdf

Note

¢ Advance Invoice is covered for consistency with other countries for which this functionality is
enabled.

o In the Polish company template STD-PL, REBATE_CREDIT_IVC_REP layout id is not
connected to rebate credit invoice type by default.

12.6.5 UPDATE GENERAL LEDGER
Using IFS Cloud standard functionality, update vouchers to General Ledger.

12.6.6 FETCH TAX LEDGER INFO
Using IFS Cloud standard functionality, update tax transactions with additional information.

12.6.7 VIEW TAX TRANSACTIONS

Using IFS Cloud standard functionality, view tax transactions.
In the Tax Transactions page, value is fetched to the E-invoice Reference Number field.

® > Financials > TaxLedger > Tax Transactions & Company Polish Company

Tax Transactions

Y Z Q- Validate Tax ID Number ~ Voucher Details ~ Modify Tax Transactions  Include Tax Proposal ltem  Calculate Income Amount &y B v |

Fetched  E-invoice Reference Numbet Identity Party Type nvoice Type SeriesID nvoice No Tax Code

E I5285537316»20240111-8DEODOCEAA76-38 I P& MB-CUST-PL-PL - Polish Customer in Polish Company Customer FP FP 200700039

12.7 Supplier Invoices

12.7.1 LOAD E-INVOICE IN IFS STYLE

Using IFS Cloud standard functionality, load XML file.

E-invoice XML in IFS Style is placed in incoming folder of IFS Connect. From this folder it is
automatically uploaded to IFS Cloud.

IFS Cloud standard functionality uses tax identity values of selling and buying party from incoming
file to identify the relevant company and supplier. Enhancements have been introduced to better
handle cases where tax identities include the "PL" prefix, specifically for companies with the “Polish
E-Invoice” parameter enabled.

12.7.1.1 Identification of Company
IFS Cloud standard functionality
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o The system searches the database using the company tax identity from the file.

o If no match or multiple matches are found, the system proceeds with other attribute-based
searches.

Enhanced functionality for PL prefix when company has “Polish E-Invoice” parameter enabled

o The system first searches the database using the company tax identity from the file.
o If multiple matches are found using the company tax identity, the system proceeds with other
attribute-based searches.
¢ |f no match is found
o The system removes the "PL" prefix from both the file and database tax identities.
o It performs an additional search limited to companies with the “Polish E-Invoice”
parameter enabled.
o If still no match or multiple matches are found, the system proceeds with other
attribute-based searches.

Example
Company Tax ID | Company Tax ID | Polish E-Invoice enabled Match Outcome
File Database
1234567890 PL1234567890 No No match
1234567890 PL1234567890 Yes Match
PL1234567890 1234567890 No No match
PL1234567890 1234567890 Yes Match

12.7.1.2 Identification of Supplier
Once the company is identified, the system proceeds to identify supplier.

IFS Cloud standard functionality

o The system searches the database using the supplier tax identity from the file.

¢ |f no match or multiple matches are found, the system proceeds with other attribute-based
searches.

Enhanced functionality for PL prefix when company has “Polish E-Invoice” parameter enabled

e The system first searches the database using the supplier tax identity from the file.
¢ If no match or multiple matches are found, and
o The company has “Polish E-Invoice” parameter enabled and
o The supplier tax identity from the file starts with “PL”
o Then the system removes the "PL" prefix from the supplier tax identity in the file and
performs an additional search.
o If still no match or multiple matches are found, the system proceeds with other
attribute-based searches.
¢ Otherwise, the system proceeds with other attribute-based searches.
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Example

Supplier Tax ID
File

Supplier Tax
Database

ID

Polish E-Invoice enabled

Match Outcome

PL1234567890

1234567890

No

No match

PL1234567890

1234567890

Yes

Match

12.7.2 VIEW EXTERNAL SUPPLIER INVOICE
If the number assigned to the invoice by Tax Authorities was included in the
<EinvoiceReferenceNumber> tag in the <InvoiceDetails> section, value will be fetched into
E-invoice Reference Number field in the External Supplier Invoices page. Value can be added
or changed if required for the uploaded invoice.

@ > Financials > supplier Invoice > Extemal Invoice > Extemal Supplier ivoices

External Supplier Invoices

Y /Z @ 4 nvoice Line Information  Advance Invoice Information  Installment Information = Recalculate Payment Term Info  Create Invoices  View Local File  View Error Log  Notes
Invoice Load
Load 1D E-nvoice Reference Number invoice No Supplier invoice Type status Load Error Invoice status Transaction Date Involce Date Delivery Date

I 5285537316-20240111-8DEODOCEAA76-10 I ZK200700001-3

PS) MB-SUPP-PL-PL-P.. ZZ Checked 1/31/2024 1/11/2024 1/11/2024
12.7.3 CREATE MANUAL SUPPLIER INVOICE
Using IFS Cloud standard functionality, create supplier invoice from external supplier invoice.
External Supplier Invoices
Y 7 @ 4 nvoice Line Information = Advance Invoice Information | Instaliment Information  Recalculate Payment Term Info View Local File  View ErrorLog  Notes
’ 150 5285537316-20240111-8DEODOCEAAT76-10 ZK200700001-3 PS) MB-SUPP-PL-PL-P.. ZZ Checked 1/31/2024 1/11/2024 1/11/2024
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Using IFS Cloud standard functionality, in the Manual Supplier Invoice page click the More
Information command. In the More Information dialog, value in the E-invoice Reference Number
field can be changed for invoice in Preliminary status.

X More Information
Reference Series Reference Invoice No Invoice Recipient
MABEPL - Maria Beresewicz -
Supplier Invoice Address Delivery Address Use Project Address for Tax
A1-5UPP-PL w | A1-COMP-DEL m
Reference Supplier Preliminary Code National Bank Code
- -
Nature of Business Creator Reference
E-INVOICE
Tax Currency Rate Parallel Currency ...  Delivery Date Tax Invoice Series ...  Tax Invoice No Tax Invoice Date
5 1/11/2024
Transfer Status Customs Declaration Date
Correction Reason ID Correction Reason
-
Branch Supplier Branch
-
E-invoice Reference Number
ISZSSSETBWG-ZDZJOW 11-8DEODOCEAATE-10 I

oK Cancel

Using IFS Cloud standard functionality, invoice can also be entered using the New Manual Supplier
Invoice assistant. In the More Information section, enter number assigned by Tax Authorities in
the E-invoice Reference Number field.

® 5 Fnancisk > Sugplierlnusice > Mew Manusl Suppiier Ivaice

New Manual Supplier Invoice

'_ Header Information —(  y— Lina Information — Posting Information

oucher Date Accounting Vear Accounting Perio User Group Voucher Type Voucher No
MABE POLAND 30112024 & | 2024 3 ac - -
PO Reference Receipt R b Contract Ref A i Project D P
= = = ~ | fB8) wB-sUPP.PLPL - Polish Supplier in Polish Company -
Invoice Type Series D mioice No currency Currency Rate Invoice Date Arrival Date Pay Term Base Date
Fz - - | |TEST - 3112024 & | | 312024 & | 31/2024 =]
Payment Terms DueDate Plan Pay Date Payment Reference matic Paymen Autharization Authorizer ID
0 ~ | |3r1r2020 37142024 =] v || -
Advance Invoice Gross Amaunt Net Amount Tax Amount
Supplier Invoic Delivery Use
. [ ) [ e .|
Ref el P Cod National Bank Code Natwre of B
y Parallel & R Delivery D T N ms Deck
1 s 37172024
Corrction Reason ID Correction Reason Branch Supplier Branch E-invoice Reference Number
- - Iszsssm-s 20240111-BDEDDOCEAATE10 1
Pre Postings v
D Next Finisn  Cancel

12.7.4 POST MANUAL SUPPLIER INVOICE

Using IFS Cloud standard functionality, post supplier invoice. If Date of Final Posting is selected in
the Supplier Invoices drop-down in the Tax Liability Date Control page, post invoice finally.
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12.7.5 UPDATE GENERAL LEDGER
Using IFS Cloud standard functionality, update vouchers to General Ledger.

12.7.6 FETCH TAX LEDGER INFO
Using IFS Cloud standard functionality, update tax transactions with additional information.

12.7.7 VIEW TAX TRANSACTIONS

Using IFS Cloud standard functionality, view tax transactions.
In the Tax Transactions page, value is fetched to the E-invoice Reference Number field.

® > Financials > TaxLedger > TaxTransactions

Tax Transactions

Y /  Calculate Income Amount

Fetcned  E-Invoice Reference Number Identity Party Type Invoice Type Serles ID invoice No Invoice Date Tax ID Number

H I5285537316720240111—SDEODGCEAA76—10 I B8 MB-SUPP-PL-PL - Polish Supplier in Polish Company Supplier z 7z ZK200700001-3 1/11/2024 1234567890

12.8 Delimitations for Customer Invoices
This is an initial solution for Polish E-Invoice.

When creating Polish E-invoice XML in IFS Style

e Only basic information is supported.

¢ Non-mandatory elements/tags are not supported.
e Rebate invoice is not supported.

¢ Invoices with price including tax are not supported.

Information for some of the KSeF tags is not included in Polish e-Invoice. In particular the following
is not available.

KSeF Description

Element/Tag

Podmiot3 Information identifying a third party entity/entities referred to in the invoice

PodmiotUpowazniony Information identifying an authorized entity referred to in the invoice

Stopka Other information included in the invoice such as, among other things, the invoice’s footer and the

KRS and REGON numbers

P_13 4 Amounts related to flat rate applicable to taxi services

P_14_4

P_14_4W

P_13 5 Amounts related to invoice documenting transactions realized by a taxable person identified in the
P_14 5 territory of the country as EU OSS

P_13_11 Amount related to invoice with margin based scheme

P_16 Annotation “cash-basis settlement method”

P_17 Annotation “self-billing”

P_22 Intra-community supply of new means of transport

P_PMarzy Margin based scheme details

NrFaKorygowany Correct number of the invoice corrected in cases where the correction is made to amend the invoice’s

number
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Podmiot1K Element containing the data of Podmiot1 put on the invoice corrected
Podmiot2K Element containing the data of Podmiot2 put on the invoice corrected
P_15ZK

KursWalutyZK

ZaliczkaCzesciowa

Zwrot akcyzy Additional information necessary for farmers claiming refund of excise duty included in the price of
fuel oil

When additional information is fetched to tax transactions for posted invoices, value in the Status
field from the E-invoice Process Monitoring page is not validated. In case of using processing type
with Process After Response disabled, information can be fetched for not accepted status. When
invoice is accepted after the fetch process, E-invoice Reference Number is missing for the tax
transaction.

12.9 Delimitations for Supplier Invoices
No known..
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13 Appendix

13.1 Polish e-Invoice functionality schemas and examples
See Technical Documentation for more information about e-Invoice schema.
Under Solution Manager User Guide/Integration/IFS Cloud Business Components
e |FS Connect for Sending e-Invoices — Polish e-Invoice schema (IFS Style) and generic e-

Invoice response schema
e |FS Connect for Receiving IFS e-Invoices — receiving e-Invoice example (IFS Style).

13.2 JPK_KR_PD XML FILE TAG MAPPING

The below attached files describe the legal requirement and the mapping of IFS data to xml tags
along with the attribute values forS_12 1,S 12 2and S_12_3 tags.

] -

Broszura_informacyjn JPK KR PD XSD file Schemat JPK_KR_PD{ JPK_KR_PD_xml_tag_
a_dotyczaca_struktury. (version 1-1) 1.pdf 1)_v1-1xsd mapping.xlsx
[, [, [,
3 3 3
S_12_1_attribute_valu S_12_2_attribute_valu S_12_3_attribute_valu
es.xlsx es.xlsx es.xlsx

13.3 JPK_ST_KR XML FILE TAG MAPPING

\N

XE
IFS%20MAPPING%20
OF%20JPK_ST_KR.xlsx
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